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Introduction

Welcom e to Pacific Tim esheet , the prem ier web tim esheet. Pacific Tim esheet allows your
employees to track their tim e and attendance from  a web browser, tim e clock or cell phone.
Pacific Tim esheet is available as an online service, or can be hosted on your own server.

Click here for a list of supported browsers and platform S.

Note: This help docum ent is context-sensitive. When you select a page in Pacific
Tim esheet and click the Help link at the top of that page, the appropriate help topic will
load.

Click here for a PDF version of this docum entation.
Related Topics

X Setup Quick Start
X System Requirem ents
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Browser R equirements

Pacific Tim esheet is a web-based application and supports the following web browsers:

Supported Browsers

Apple Safari

Google Chrom e
Microsoft Internet Explorer
Mozilla Firefox

4.0 or later
3.0 or later
7.0 or later
3.0 or later

Note: This application tries to m

However, there are som
window. You therefore m
circum stances.

Server Requirements

inim ize the use of popup windows as m uch as possible.

e areas of the application that by necessity require a popup
ay need to unblock popups for this application under certain

If you are hosting the software yourself, here are the server requirem ents:

Supported Hardware

Computer and processor

Mem ory
Disk space

PC or Mac intosh with Intel Pentium
processor

2 GB of RAM

250 MB of available hard disk space for the program files.
Additional space is needed to store tim esheets and other
employee data (see below).

4-com patible2 G Hz

Supported Operating Systems

Microsoft Windows
Linux

Apple Macintosh

Server 2003, Server 2008, Vista, 7

SUSE, RedHat or any other Linux distribution capable of
running Java 1.5 or later.

OS X, any version ¢ apable of running Java 1.5 or later.

Supported Databases
Microsoft SQL Server

MySQL
Oracle

SQL Server 2005, 2008 with Mixed Mode Authentication
(Windows Authentication and SQL Server Authentication)
enabled.

Version 5.0.22 or later.
Oracle 9i or later.

In general, hard disk space is related to the num

ber of tim esheets written annually. A

tim esheet typically requires about 150K of storage. Based on this value the following table

will help you determ

ine the am ount of hard disk usage you can expect annually:

Hard Disk Usage

Timesheets Per Year
500

Hard Disk Allocation Per Year
75 MB
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5,000 750 MB
10,000 1.5GB
20,000 3GB

You can optionally integrate with access devices to record em

The following devices are supported:

ployee tim e and attendance.

Manufacturer Model

ACTAtek X PIN

www.actatek .com X Smart Card
X Fingerprint
X Combination

p7
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Setup Quick Start

If you are an adm inistrator settingup  Pacific Tim esheet for the firsttim e you will want to
read this page to fam iliarize yourself with som e basic concepts, and learn how to get
up-and-running quickly. Please note that you can always get detailed inform ation for each
page of the application by clicking the context-sensitive H elp link in the upper-right corner.

Step 1. Configure System Settings

The first steps you should take to set up your system are to configure the following global or
system -wide settings:

X Setthe defaulttim e zone for yourem ployees onthe System > General page.

X Specify your work break down structure (WB S)onthe System > Work Breakdown
Structure page. For exam ple, one business m ight track tim e against custom ers, projects
and tasks. Another business m ight track tim e against clients and jobs.

X Configure tim esheet periods appropriate for your payroll or other reporting cycles from
the System > Tim e Periods page.

Note that you can change the above settings at any tim e, but doing so afterem  ployees start
entering tim e might be disruptive.

You m ay optionally want to do the following before rolling the system out to your
employees:

X Setyour list of com  pany holidays from the System > Holidays page.
X Change the wording or term  inology used for som e labels from the System > Term inology

page.

X Upload your ¢ ompany logo and m ake other branding changes from the System >
Branding page.

X Configure bill and pay rates from the System > Bill Rates and System > Pay Rates
pages.

Step 2. Configure Timesheet Templates

The System > Tem plates page is where you configure the data fields that are displayed on
tim esheets. You can ¢ reate any num ber of differenttim  esheet tem plates for different needs.
Two sam ple tim esheet tem plates are provided:

1. The "Attendanc e Tim esheet"tem plate is for attendance-oriented tim e entry, and
captures daily in/out tim es and pay codes (e.g. Regular Tim e, Over Tim e, etc.).
2. The "Project Tim esheet" tem plate is for project or job-oriented tim e entry, and captures

hours against custom ers, projects and tasks.

You can use and m odify these tem plates, or create any num  ber of new ones to suit your
needs. When adding em  ployees (described below), you will specify the tim esheet tem plate
as part of their profile.

Step 3. Configure Employee Policies

Employee policies allow you to ¢ ontrol a variety of tim  esheet options, such as rounding
rules, leave acc ruals and over tim e calculations. You should review the " Standard Policy"
settings on the  System > Policies page, then m ake changes or create new policies as
desired. You can have any hum ber of differentem  ployee policies, such as separate policies
for exem ptand hourly em ployees. When adding em  ployees (described below), you will
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specify the policy as part of their profile.

Step 4. Configure Pay Codes

The System > Pay Codes page lists the available pay codes. Pay codes are custom izable
values that you can use to track different types of work and leave hours. Work pay codes
can include regular tim e, over tim e, etc. Leave pay codes can include sick, vacation, etc.

Work pay codes are often used for tracking overtim e. With Pacific Tim esheet you have two
choices about how overtim e is handled:

1. You can have your em ployees select whether their hours are regular tim e, overtim e, etc.
on their tim esheet via a pulldownm  enu. To do this you add the Pay Code field to your
tim esheet tem plate(s).

2. You can have overtim e be com puted autom atically by enabling overtim e rules for the

em ployee policy. If you do this you will generally want to rem ove the Pay Code field
from the tim esheet tem plate, as you don't want the em ployee to enter their overtim e
values. You will still be able to report on overtim e hours even if there is no Pay Code

field on the tim esheet.

Leave pay codes, such as sick and vacation, can have an associated balance. Any hours an
employee enters on their tim esheet for these pay codes will autom atically have an
equivalent am ount deducted from  their balance. R ules for whether balances are allowed to
go negative, as well as autom atic accruals, are configured by editing the balance rules on

the appropriate em  ployee policies.

Step 5. Add Projects/T asks

Depending upon your work breakdown structure, you m ay need to visitthe  Tasks page and
create lists of custom ers, projects, tasks, jobs, etc.

Note that you can also im  port tasks, etc . inbulk from an external system viaim port files.
The Im porting/Exporting _ help topic has m ore details.

Step 6. Add Employees

The Employees page is where you add and edit your list of em ployees. Make sure the
appropriate policy and tim  esheet tem plate is selected for eachem  ployee.

You will also want to select the appropriate perm ission level for each em ployee, forexam ple
"Employee" or "Manager". Perm ission levels control what access to the tim esheet system

the em ployee will have, as well as giving fine-grained control over som e aspects of tim e
entry. You can m odify the perm issions from the System > Security page, as well as create
entirely new perm ission levels.

Note that you can also im  portem ployees in bulk from  an external system  viaim port files.
The Im porting/Exporting _ help topic has m ore details.

Employee groups can be created from the Employees > Group page. Em ployee groups can
represent a variety of different logical entities, such as cost centers, perm ission groups and
construction crews.

Step 7. Miscellaneous

Here are a few other topics worth being aware of:

X A variety of reports are available, and can be custom ized for your requirem  ents. Pacific
Timesheet allows you to publish your ¢ ustom reports and m ake them available to any

P9


/timesheet/paycode/paycode-list.do
/timesheet/task/task-list.do
/timesheet/user/user-list.do
/timesheet/system/security-show.do
/timesheet/user/group-list.do

© 2000-2021, Pacific Timesheet

suitable perm ission level. For instance, you can m ake a custom ized billing report
available only tom anagers, or an hours sum  mary report available toem  ployees.

X Youmay wantto m odify the audit level if you have stringent auditing requirem ents,
such as D CAA. You can do this from  the System > General page.
X Most objects can be custom  ized to add additional data fields. For instance, you m ight

want to add an em  ployee photograph to the em ployee object, or a location pick list to
the tim esheet tem plate. Choose the "Manage Custom Fields" menu option in the pop-up
options m enu in the upper-right corner of m ost lists of objects.

Please let us know if we ¢ an help you by contacting your sales representative or visiting our
support site at  https://www.pacifictim esheet.com /. Thank you for using  Pacific Tim esheet !
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Home

The Hom e page is where you m  anage your em ployee account and preferences. It also
provides a "dashboard" where you can quickly view your balances, leave requests, com
announcem ents and other inform  ation.

The Calendar shows rec ent and upcom ing holidays and leave requests.

Related Topics

Change Password
My Account
Preferences
Leave R equests

Holidays
Announc ements

X X X X X X

pll
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Change Password

You can ¢ hange your password at any tim e from this page. For security reasons you will
need to provide your old password.

Note: Passwords are case-sensitive, and can never be the sam e as your loginnam e. There
may be other ¢ onstraints, suc h as beingam inimum num ber of characters in length,
depending upon how your applic ation adm inistrator has configured the password security

settings.
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My Account

The My Ac count page lets you view and change your em

ployee profile. Your em  ployee profile

has the following properties:

Property
Login Name

First Nam e
Last Nam e
ID

Status

Job Title

Reporting G roup

Emalil
Phone
Mobile
Fax

Description

Your login nam e, whic h c an only be changed by an em
manager or adm inistrator.

ployee

Your first nam e, up to 80 characters.
Your last nam e. This field is required and can be up to 80 characters.

Your em ployee ID, whic h can only be changed by an em
manager or adm inistrator.

ployee

Your account status, either Active, Inactive or Locked. Accounts can
becom e locked after too m  any unsuccessful login attem  pts. This can
only be changed by an em  ployee m anager or adm inistrator.

Your job title, which can only be changed by an em
adm inistrator.

ployee m anager or

Your prim ary or reporting group. This property m ay be renam ed by
your application adm inistrator to som ething m ore appropriate for your
organization, such as D ivision, Cost Center or Charge Code. This can
only be changed by an em  ployee m anager or adm inistrator.

Your em ail address, up to 80 characters.

Your phone num ber, up to 40 characters.

Your m obile phone num ber, up to 40 characters.
Your fax num ber, up to 40 characters.
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Preferences

The Preferences page lets you view and change your application preferences. This includes
the following properties:

Property Description

Timesheet Mem ory ' Allows you to spec ify whether rows and hours are carried forward
from the previous tim esheet when a newtim esheet is created.
Options inc lude:

None New tim esheets will have no rows or hours carried
forward from the previous tim e period.

Rows New tim esheets will have the sam e rows as the
tim esheet for the previous period, but all hours
fields will be blank. This is the default value for
employees.

Rows and Hours | New tim esheets will have the sam e rows and hours
as the tim esheet for the previous period. Only work
hours are carried forward - leave (or paid tim e off)
rows will carry forward, but not the hours.

Note that you can hide this option from em ployees
by turning off the " Can copy previous tim  esheet
hours" tim esheet perm ission for the em ployee's
perm ission level. See the  Permission Levels topic
for m ore inform ation.

Hours Form at The choice of how you enter hours on your tim esheet, either decim al
form at (for exam ple 3.5) or hours:m  inutes (for exam ple 3:30).

Tab D irection The direction the selection m  oves when you type the tab key on your
tim esheet, either vertical or horizontal.

Remember Last The num ber of m ost recently used clients, projects, etc. to rem ember
(25 m ax). To erase the list of m ost recently used item s click the
Clear List  button.

Locale Your locale determ ines the following:

X The language displayed, e.g. English, French, Chinese, etc.

X The form atting of dates and num  bers. If you choose a locale that
has AM/PM as part of itstim e form at, you have the option of
overriding that by choosing the 24 hour tim e form at (som etim es
called m ilitary tim e).

X The list of com pany holidays for the selected location

Time Zone Your tim e zone.
Search R esults The num ber of rows to return per page of results, such as when
searc hing forem ployees, tim esheets, etc.
Default Tab The tab to select upon logging into the application.
Export Form at The file form at for exporting tim  esheet data, em ployee lists, etc.
X CSVisatextform atcom patible with m ost system s (including
Microsoft Excel), and is the default value for em ployees.

X MS Excel is the Mic rosoft Excel form at, a binary form  at generally
only ¢ om patible with Microsoft Excel.
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Announcements

Announc ements are m essages displayed to every em  ployee who logs into the application.
You can use this feature to alert your em ployees of special events, such as m aintenance
down tim e, orto com pany policies such as whentim  esheets are due.

Note: Text form atting is standard HTML. If your browser supports it, you will see a

WYSIWYG editor when editing the announcem ent text. You can click the"  Source" button
on the editor tool bar to view and edit the HTML source. The m axim um length of the HTML
is lim ited to 4000 charac ters (2000 characters if using Oracle for the database), and if you

exc eed this am ount the text will be truncated.
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My Timesheet

The My Tim esheet page is where you enter hours into your tim esheet. B y default you will be
taken to the tim  esheet for the current tim e period. You can change the tim e period by
clicking the Tim e Period link or ¢  licking the next/previous buttons beside the Tim e Period
link. Tim e periods are determ ined by your applic ation adm inistrator, and usually correspond
to payroll or other com  pany tim e periods.

Atim esheet has a status, which can be Open , Submitted , Approved or Rejected . The
Open status m eans you can enter hours and m ake other edits to your tim esheet. When you
have finished filling out your tim esheet you should click the Subm it button, which changes

your tim esheet status to Subm itted. Subm itted tim esheets cannot be edited.

Subm itted tim esheets can be reviewed and approved by an em ployee m anager. If the
manager finds a problem  with the tim esheet they m ight reject it, which will revert the
tim esheet bac k to its Open status, allowing you to correct any problem

If your tim esheet status is Open you can delete it and start over with a new one by clicking
the Delete button.

Timesheet Views

You can view your tim e entriesusinga Day View , Week View , Summary View or
Printable View . You can switch between views at any tim e, and changing your view will

save any changes you have m  ade to your tim esheet autom atically. The D ay View allows you
to view and enter tim e on a day-by-day basis. The Week View allows you to view and enter

tim e on a weekly basis (this view is not available if you are entering start tim es with your
tim e entries). The Sum  mary View is a read-only view that lists all of the tim e entries for the
entire tim e period. The Printable View will generate a PD F version of the Sum mary View,
whic h is suitable for printing and signing by your m anager.

Timesheet Row s

There are two types of tim e entries you can add to your tim esheet: Work and Leave (hote
that the term inology for these two types m ight have been changed by your application

adm inistrator). Work tim e entries are added by clicking the Add Work  button. Work tim e
entries generally require entering a Task or other description of the work done.

Leave tim e entries are added by clicking the Add Leave button. Leave tim e entries
generally require you select the type of leave, for exam ple Vacation.

You can delete one orm  orerows at atim e by checking the desired rows on your tim esheet
and then clicking the  Delete Row  button.

If you are entering start tim es then rows will be ordered from earliest to latest. If you are
not entering starttim  es then you can order the rows as you like by checking the desired
rows and then clicking the Move Up or Move Down buttons.

Choosing Tasks

Your tim esheet m ay be configured for you to choose a Task , Project or other additional
properties for each tim e entry. The exact set of properties you need to choose will depend

on how your applic ation adm inistrator has set up the work breakdown structure (WBS) for
your organization. Choosing a Task, Project, etc. will pop up the Task browser, which allows

you to choose any level of the WBS.

You m ay narrow down the list of tasks shown in the browser by entering a query and
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clicking the Searc h button. You can refine your query using the "*' character. For instance,

to return all tasks starting with the letter 't' enter the query 't*. To find all tasks ending

with the letter 't' enter *t'. Searching for *t*' is the sam e as just searching for 't' - it will
return any task with the letter 't'in it.

Timesheet N  otes

The Notes field at the bottom of the tim esheet allows you to enter notes or com ments
about the tim esheet. Thisis ¢ ommonly used to inform  your m anager or approver about
anything special regarding your tim esheet. The m axim um size of a note is 4000 characters.

Other Timesheet Commands

There is a popup m enu of additional Tim  esheet com mands in the upper-right corner of the
tim esheet. These ¢ ommands include:

Copy Previous T imesheet  will copy the rows and hours entered on the previous
tim esheet. This ¢  ommand will only be available if the current tim esheet has not been
subm itted and has no hours, to avoid inadvertently overwriting your tim esheet.

Copy Previous R ows will copy the rows (but not the hours) from the previous tim  esheet.
This ¢ ommand will only be available if the current tim esheet has not been subm itted and
has no hours, to avoid inadvertently overwriting your tim esheet.

Copy Previous Day will copy the tim e entries for the previous day to the current day. This

com mand will only be available when in the Day View and if the current tim esheet has not
been subm itted and the day has no hours. If you choose this com mand for a Monday it will
move bac k to Friday to look for previous tim e entries if none are found on the weekend.

Delete Timesheet will delete the ¢ urrenttim esheet. This com mand is only available if the
current tim esheet has not been subm itted.
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My Expense Sheets

The My Expenses — Expense Sheets page is where you enter expense item s into your
Expense Sheets. To navigate to expense sheets subm itted within defined date ranges by
selecting atim e period in the Tim e Period pick list, or clicking the next/previous buttons
when on the details page of any expense sheet. You can also select a start and finish date
when searching for expense sheets.

An Expense Sheet has a status, which can be Open , Submitted , Approved or Rejected
The Open status m eans you ¢ an enter expense item s and m ake other edits to your Expense
Sheets. When you have finished filling out your Expense Sheets you should click the Subm it
button, whic h ¢ hanges your Expense Sheets status to Subm itted. Subm itted Expense

Sheets cannot be edited.

Subm itted Expense Sheets ¢ an be reviewed and approved by an em ployee m anager. If the
manager finds a problem  with an Expense Sheet they m ight reject it, which will revert the
Expense Sheet back to its Open status, allowing you to correct any problem

If your Expense Sheet status is Open you can delete it and start over with a new one by
clicking the Delete button.

Expense Sheet View S

You can view your expense entries in an expense sheet which lists each expense in the

expense sheet vertically. There is also a Printable View that can be found using the tools
button which can be suitable for printing and signing by your m anager if a hardcopy
expense sheet is required.

Expense SheetR  ows

Expense entries are added by clicking the Add Expense  button. You m ight be required to
enter certain required fields such as client or project within the expense entry.

You can delete one orm orerows atatim e by checking the desired rows on your Expense

Sheets and then clicking the m inus or Delete Row  button found on the far right of each

expense entry row.  You can also reorder expense entries by clicking the handles on the far left of each
row and dragging it into a different position on the expense sheet

Choosing Tasks

Your Expense Sheets m ay be configured for you to choose a Task , Project or other
additional properties for each tim e entry. The exact set of properties you need to choose will
depend on how your application adm inistrator has set up the work breakdown structure
(WBS) for your organization. Choosing a Task, Project, etc. will pop up the Task browser,

whic h allows you to choose any level of the WB S.

You m ay narrow down the list of tasks shown in the browser by entering a query and

clicking the Searc h button. You can refine your query using the "*' character. For instance,

to return all tasks starting with the letter 't' enter the query 't*. To find all tasks ending

with the letter 't' enter *t'. Searching for *t*' is the sam e as just searching for 't' - it will
return any task with the letter 't" in it.

Expense Sheet Summary Fields
Expense Sheet: Employee N ame

Each expense sheet will have a link to the em ployee ’'s mini-profile that contains key setup
inform ation about thatem  ployee.
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Sheet Description

The Sheet Description field, a required field, is entered at the top of the Expense Sheet,

allows you to provide a useful desc ription for the expense sheet that will distinguish it from

other expense sheets.

Total R eimbursement

The Total R eimbursement field is a required field when m ultic urrency is enabled. B elow
the Total Reim bursem ent heading is a total reim bursem ent value. This value is link with the
form at of CURRENCY value. For exam ple, $1,500.00 in Canadian Dollars will appear as
CAD1,500.00. You can select a different reim bursem ent currency by clicking on this link and
selecting a different currency from the currency pick list. This list of currencies is m anaged
by your system adm inistrator. If areim  bursem ent c urrency, that you need, ism issing,
contac t your system adm inistrator for help.

Notes

The Notes field is where you com  plete a detailed note for approvers regarding the expense
sheet.

ID

The ID field is a read-only system -generated unique expense sheet ID used to track your
expense sheet from  creation through to final approval.

Sheet Status

The Sheet Status  shows the current state of the expense sheet. If the expense is

unsubm itted, an unlocked ic  on will appear next to Unsubm itted. When the expense is
subm itted there will be locked ic on next to Subm itted. As m anagers with different approval
levels approve the expense sheet, check m arks will appear to the right of the lock icon.
Expense Sheet Row Fields

Row Number (#)

The Row Number  colum n indicates the row num  ber for each entry. Approvers can refer
specific ally to these row num  bers when rejecting expense sheets.

Date
The Date field, a required field, refers to the date during which the expense was incurred.
Sheet

The Sheet field, a required field, refers to the date during which the expense was incurred.

Expense

The Expense field, which is a required field, is a pick list where you select the expense type

for the expense entry. The expense lookup dialog allows you to search by typing in a search

box which will autom  atic ally return m atching expense types by nam e, ID or description.
Expense types willbe m  emorized in your expense field pick list for future use.
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Description

The Description  field is to provide a detailed description of the expense entry.

Quantity

The Quantity field is m eant for expense types, such as m iles, that require a quantity value.

For m iles expense type, a set unit am ount will calculate the total am ount as follows:

Quantity X Unit Am  ount=Am ount. Where the quantity is em pty, the system  willassum e a
quantity of 1.0, and will allow you to enter and save the full am ountinthe Am ount field.
Unit Amount

The Unit Amount  field is m eant for expense types, such as m iles, that require a unit

amount value thatis m  ultiplied tim es a quantity value. The unit am ount is set in the
expense type profile under unit am ount.

Expense Item Currency

The Expense Item Currency field is selec ted from a pick list of currency values. The
expense item currenc Yy value will be used to convert the expense item am ount to the
reim bursem ent currency am ount.

Amount

The Amount field is the am ount of the expense entry. The am ount is entered in the
expense currency.

Receipt Image

The Receipt Image allows you to attach an im age of the receipt for the expense entry.
Reimbursable

The reimbursable field is a check box that flags the expense entry as reim bursable.
Payment Method

The Payment Method field is a pick list of paym  ent m ethod values such as
“Out-of-Pocket,” Visa or Am erican Express.

ID

The ID field is a read-only system -generated unique expense entry ID used to track your
expense entry.

Reimburse Amount

The Reimburse Amount field shows the system  -calculated reim bursem ent am ount for this
expense entry. You can override this am ount by selecting the Override check box.

Exchange R ate

The Exchange R ate field shows the system  -calculated exchange rate for this expense
entry. You ¢ an override thisam ount by selecting the Override check box.

Billable
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The Billable field is check box that flags an expense entry as billable.

Other Expense Sheet Commands

There is a popup m enu of additional Expense Sheets com mands in the upper-right corner of
the Expense Sheets. These com  mands include:

Copy Previous Expense Sheets will copy the rows and expense item s entered on the
previous Expense Sheets. This com mand will only be available if the current Expense Sheets
has not been subm itted and has no expense item s, to avoid inadvertently overwriting your
Expense Sheets.

Copy Previous R ows will copy the rows (but not the expense item s) from the previous
Expense Sheets. This com mand will only be available if the current Expense Sheets has not
been subm itted and has no expense item s, to avoid inadvertently overwriting your Expense
Sheets.

Copy Previous Day will copy the tim e entries for the previous day to the current day. This
com mand will only be available when in the Day View and if the current Expense Sheets has

not been subm itted and the day has no expense item s. If you choose this com  mand for a
Monday it willm  ove bac k to Friday to look for previous tim e entries if none are found on the
weekend.

Delete Expense Sheets will delete the ¢ urrent Expense Sheets. Thiscom  mand is only
available if the current Expense Sheets has not been subm itted.
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My Assets

The "My Assets" page allows you to record non-labor types of data such as m aterials,
equipm ent and other types of assets you use as part of your project or job work. As Pacific
Timesheet allows asset tracking to be configured in m any different ways (for exam ple you
may be rec ording m aterials, equipm ent and expenses) the specifics of the " My Assets" page
will depend upon your organization's configuration of Pacific Tim esheet .

Note that the types of assets that can be entered on the " My Assets" page is controlled in

part by the tim  esheet tem plate that is assigned to you by your application adm inistrator.
For instanc e, your system may be configured for both Materials and Equipm ent, but if your
tim esheet tem plate only has Materials enabled then the "My Assets" page would instead be

"My Materials", and you would only be able to enter the m aterials you used.
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Crew Timesheet

Crew tim esheets allow the daily entry of tim e for groups (crews) of em  ployees. Crew
tim esheets are a convenient and efficient way to enter tim e for crews of em ployees that do
not record their own tim e, such as field workers on construction sites.

Note: You can change the term inology for 'Crew' to suit your organization's needs. The
Term inology topic has m ore inform ation.

Crew tim esheets are accessed from  the " Crew Tim esheet" tab. To access this tab crew

tim esheets they m ust first be enabled from the System > General > System Options page.
In addition, youm ust be atim esheet m anager or approver for at least one group, and have

the 'Can View Crew Tim  esheet' option enabled in your em ployee perm ission level.

Configuring Crew Timesheets

The fields that appear on the crew tim esheet (e.g. Hours, Project, Task, etc.) com e from the
tim esheet tem plate of the em ployee that appears first in the crew. To add em ployees to the
crew sim ply clic k the "Add Em ployee" link at the bottom of the list of em ployees, then

choose the appropriate em  ployee(s) to add. You can also add em ployees to the crew by

going to the Em ployees > Groups page and configuring the list of em ployees for each crew
(group).

If you are an adm inistrator (that is, you can edit tim esheettem plates on the System >
Tem plates page), then you will be able to alter they layout of the crew tim esheet. To do

this, click the "More" m  enu button (the triangle icon in the upper-right corner of the crew
tim esheet) on the Crew Tim  esheet page, then click the "Tim esheet Options" link. You will
have access to the following layout settings:

Property Description

Day Fields Choose which fields from  the tim esheet tem plate should appear at the
top of the crew tim  esheet. D ay fields values apply to every row and
colum n of the crew tim  esheet for the selected date.

Colum n Fields Choose which fields from  the tim esheet tem plate should appear above
each colum n where the hours are entered. Colum n field values apply
to every row in the colum n.

Row Fields Any rem aining fields that are not selected as day or colum n fields are
considered row fields, and will show up on each row for each
employee.

Show Em ployee ID | Check this option if you want to display the Em ployee ID colum n next

to the Em ployee colum ninthe layout. N ote that even if not checked,
the user can always view an em ployee's ID and other properties by
clicking the em ployee's nam e inthe crewtim esheet.

Employee G rouping ' Use this option to group certain types of em ployees at the top of the
list of em ployees on the crew tim  esheet. For instance, youm  ight want
employees with the Perm  ission Level of 'Manager' to always be at the
top of the list. Another exam ple is to group em ployees with the Policy
'Full Tim €' at the top of the list, so that 'Part Tim €'em ployees sort
below them (note that these policy nam es are not built into the
product and are just exam  ples).
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Blank Rows If you have one orm  ore asset types enabled for this crew tim esheet
tem plate then you can specify whether a blank row is shown for each
employee in the crew if no data has been entered. For instance, a
Materials tab m ight not associate entries with em ployees and would
not want a blank row for each em ployee. However, an Equipm  ent tab
might want a row for each em ployee in the crew as equipm  ent usage
would be associated with a crew m ember.

Tab D irection You can choose whether the tab key will take you to the next colum n
(horizontal) or to the next row (vertical).

Remember Last This option will determ  ine how m any previously selected projects,
tasks, etc. will be rem  embered for easy access.

Crew Parent Field If you have a lot of crews you m ay want to organize them into
different categories or types. For instance, you m ight create a group
custom field nam ed "Region" and spec ify a geographic region for each
crew. Specify the "Region" field in this exam ple for the crew parent
field in orderto m  ake browsing for crews m  ore convenient.

Crew Approval Kiosk

You can access a special " kiosk" version of the Pacific Tim  esheet web interface that provides
a stream lined or sim plified ¢ rew tim esheet approval page. From the Crew Tim esheet click
the "m ore" m enu (the triangle in the upper-right corner of the page) and select the "Crew

Approval Kiosk" option. The Crew Approval Kiosk gives you a " read-only" report of the crew
tim esheet data in either weekly or daily form at, and allows you to subm it, approve or reject
the data, depending upon your perm issions.

You can provide your clients with the link to this page (e.qg.

http://som eco.pac ifictim esheet.com #fim esheet/kiosk/crew-approval.do) to allow them to
review and approve tim  esheet data. You will need to provide them with a Pacific Tim esheet
employee acc ount so that they can log in. This account should have very lim ited

perm issions, e.g. only the ability to approve tim esheets, and notim esheet tem plate. Your
application specialist can assist you with setting up such client access accounts.
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Managing Timesheets

Employees can be given perm  ission to m anage other em ployee'stim esheets. Atim esheet
manager can view, edit and even delete tim esheets, depending upon their perm ission level.
Any em ployee whose Permission Level allows tim esheet m anagem ent (for exam ple

Adm inistrator or Manager) can m anage tim esheets and will see the Timesheets  tab. If you
do not see the Tim  esheets tab then you have not been given a Perm ission Level with

tim esheet m anagem ent perm issions. You ¢ an check an em ployee's Perm ission Level from
the Employees tab.

If the em ployee's perm ission level allows only lim  ited tim esheet m anagem ent then the

employee will need to be added to the perm ission list for one orm  ore em ployee groups.
This ¢ an be done by clicking the Groups link under the Em  ployees tab, then clicking one of
the groups in the list. In the Permissions  section for the group click the Edit button and
add the em ployee to the perm ission list with the appropriate perm ission level. The  Groups

topic has m ore inform ation.

Note: You can use tim  esheet m anagem ent perm issions to create " tim e keepers"
employees with the ability to enter tim e for other em ployees. This avoids the need to log

in as another user in order to fill out their tim esheet. Ifim plem enting tim e keepers it is
recom mended that you ¢ reate a new Perm ission Level with only the m inim um required
tim esheet perm issions such as m anage, edit and create. The Permission Levels topic has
more inform ation.

Timesheet Lookup

To listem ployee tim esheets click the Timesheets tab, enter an appropriate Start date,
then click the  Search button. You can optionally enter a Finish date and Status in order to
narrow down the list of returned tim esheets.

If you do not find any tim esheets then you m ay have only lim ited tim esheet m anagem ent
perm issions. As m entioned above, youm  ay need to be added to the perm ission list for one
or m ore em ployee groups.

Clickinga Time Period link in the list will load that em ployee's tim esheet. D epending upon
your perm ission level, you m ay be able to edit or even delete this tim esheet.

Exporting Timesheets

If your perm ission level allows it you can export the list of tim esheets by clicking the popup
menu in the upper right of the list and then clicking the Export List  link. This will export
the tim esheet status inform  ation as displayed in the list to your local com puter, in

com ma-separated value (CSV) form at. This file can then be opened in Microsoft Excel or

other applications that support the CSV form at. You can optionally change this to Microsoft
Excel's native form at (XLS) by ¢ licking the Preferences link on the Hom e tab.

Clicking the Export Timesheet Data link will download the tim e entries for each tim  esheet
in the list as a file that you can save on your local com puter. This is useful for exporting

tim e entries to external system s such as Payroll processing applications. You can optionally

mark tim e entries as being exported, so that you can avoid re-exporting the sam e data.
Once atim esheet has been m arked as exported it cannot be unsubm itted (unlocked) for
re-editing. You will need to m ake corrections to the tim  esheet by clickingthe " Add

Correc tion" button. This is a safeguard to avoid m odifying previously exported tim e entries.
Note that adm inistrators (those with the "Can Manage All" tim esheet perm ission) can

bypass this restric  tion and still unsubm it a previously exported tim esheet, if the need

arises.
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Note that only subm itted (locked) tim  esheets can be m arked as exported.

Another option for getting access to tim esheetdataistoruna  Timesheet Details report.
This report can be ¢ ustom ized to only output the fields you require, and can be downloaded
inanum ber of form ats, inc luding Microsoft Excel. The  Reports topic has m ore inform ation.

Importing Timesheets
If your perm ission level allows it you can im port tim esheet data by clicking the popup m enu

in the upper right of the list and then clicking the Import Timesheet Data link. The
Im porting/Exporting _ topic has m ore inform ation.

Printing Timesheets

The 'Print Tim esheet' option in the popup m enu in the upper right corner of the tim esheet
list allows you to download a PDF hard copy of all of the tim esheets in the list. This is useful
if you need to print out m ultiple tim esheets for signing, for instance. N ote that, rather than
printing the entire list, you can print selected tim esheets by clicking the checkbox on each
row before selecting the 'Print Tim esheets' option.

You can also print individual tim esheets by clicking the tim e period link in the tim  esheet list,

then c licking the 'Print' view button in the upper-right corner of the tim esheet. This will
download a PD F version of the tim  esheet suitable for printing.
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Time Entry Corrections

Administrators and m anagers with the ability to edit tim esheets m ay add corrective or
adjustm enttim e entriesto atim esheet that has been previously subm itted or approved.
Once atim esheet has been subm itted (locked) an" Add Correction" button will appear on

the tim esheet. This allows you to m ake a change to thetim  esheet without unsubm itting it
first. This is necessary in instances where you only want to resend correction tim e entries
(either with negative or positive hours) to your payroll or billing system S.

To m ake a correction, locate the subm itted or approved tim  esheet, switch to either the D ay,
Week or Sum mary view, then ¢ lick the "Add Correction” button. You will be presented with a
dialog in which you can enter properties for the corrective tim e entry, such as the pay code,
project, task and hours. If you want to m ake a change to an existing tim e entry, select the

tim e entry row before clicking the "Add Correction" button, and all of the fields will be

pre-filled.

You can enter negative hours in a correction tim e entry in order to subtract hours from a
previous entry. For instanc e, in order to subtract 2 hours from a previous tim e entry, you
would selec tthe previous tim e entry, click the "Add Correction" button, then enter -2 in the

hours field. When you click OK you will see the new negative tim e entry onthetim esheet.

After adding ¢ orrec tiontim e entriesto atim esheet, any export flags for the tim esheet will
be c leared. In this way you will be able to re-export the tim esheet and send the correction
tim e entries to your payroll system . Adding atim e entry correction to a tim esheet will not
affect other tim e entries on thattim  esheet, m aking it easy to export only the corrections to
your payroll or billing system S.
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Approvals
Pacific Tim esheet has several flexible options for approving your em ployee'stim e.In

addition to allowing m  ultiple approval levels, you ¢ an approve em ployee tim e in several
different form ats.

Note: Leave requests are approved from the Leave Requests tab. See the Leave R equests

topic for m ore inform ation.

Timesheet Approval

Timesheet approval isthe m  ost com monly used type of approval, and is especially useful for
payroll and hum an resources applications. With tim esheet approval you can review and
approve em ployee tim e for entire tim e periods. You can also review and approve (or reject)
individual line item s or entries within a period. R efer to the Approving Tim esheets topic for
more inform ation.

Project Time Approval

Project tim e approval allows project m  anagers to review and approve (or reject) em ployee
tim e recorded for specific projects. R efer to the  Approving Project Tim e topic for m ore
inform ation.

Crew Time Approval

Crew tim e approval allows job supervisors and m anagers to review and approve (or reject)
tim e entered for crews of workers. R efer to the Approving Crew Tim e topic for m ore
inform ation.
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Approving Timesheets

Subm itted tim esheets can be electronically signed by an em ployee's approver. Anem  ployee
can have a Primary Approver and a Backup Approver . Approvers are assigned to an
employee from the Employee D etails page. Note that to be an approver the em ployee m ust
have a Permission Level such as Adm inistrator or Manager with the " approve" tim esheet
perm ission checked. If you do not see the Approval tab then your perm ission level does not
have the "approve" tim  esheet perm ission checked.

A backup approver has the sam e perm issions as a prim ary approver, but will not be sent
any approval-related em  ail notices. The Naotices topic has m ore inform ation.

Timesheet Lookup

To listem ployee tim esheets click the Approval tab, enter an appropriate Start date, then
click the Search button. You can optionally enter a Finish date and Status in orderto
narrow down the list of returned tim esheets. If you do not find any tim esheets nom atter
what searc h criteria you use then you m ay not be assigned to any em  ployees as an
approver.

Administrators (or anyone with "Can Approve All" tim esheet perm ission) can view and
approve all tim esheets. Managers with lim  ited perm issions ("Can Approve Lim ited"

tim esheet perm ission) will have a restricted list where they can only see tim esheets for 1)
employees that they are a prim ary or backup approver for, or 2) em ployees in groups they
are assigned to with a perm ission level that allows tim  esheet approval.

Timesheet Approval/R ejection

Timesheets in the list that are subm itted (pending approval) can be approved by checking
the checkbox inthe  Approved column. Then clickthe Save button to save the approval
change.

You can approve individual tim e entries (line item  s) by clicking the  Time Period  link in the
tim esheet list. This allows you to view the tim esheet details and approve each row

individually. When all tim e entries are approved then the entire tim esheet is considered
approved.

When viewing the individual tim e entries you have the option of rejecting any of them ,and
thereby rejecting the tim esheet. Torejectatim e entry checkthe Rejected c¢heckbox for
the appropriate tim e entry, entera Reject R eason atthe bottom  of the page, then click

the OK button to save the changes. A rejected tim esheet is un-subm itted and sent back to
the em ployee for correction.

Approval Options

You can ¢ ustom ize which tim e entry fields are displayed in the tim esheet details page by
clicking the popup m  enu in the upper-right corner and choosing Options . The Timesheet
Approval Options page lets you ¢ ustom ize which tim esheet fields are displayed in the

tim esheet approval page. For a detailed description of the various tim esheet fields refer to

the Templates topic.

Approval Levels

Your system can be ¢ onfigured to have m  ulitple approval levels (including zero levels, for
organizations that don't need tim esheet approval). This is covered m ore fully in the
Approval Levels topic.
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Crew Time Approval

An alternative to approving tim esheetsisto use the  Crew Tim e Approval page. Thisism ore
appropriate for ¢ onstruction and field service applications where you are doing daily tim e
approval.

Exporting Timesheets

If your perm ission level allows it you can export the list of tim esheets by clicking the popup
menu in the upper right of the list and then clicking the Export List  link. This will export
the tim esheet status inform  ation as displayed in the list to your local com puter, in

com ma-separated value (CSV) form at. This file can then be opened in Microsoft Excel or

other applications that support the CSV form at. You can optionally change this to Microsoft
Excel's native form at (XLS) by ¢ licking the Preferences link on the Hom e tab.

Clicking the Export Timesheet Data link will download the tim e entries for each tim  esheet
in the list as a file that you can save on your local com puter. This is useful for exporting

tim e entries to external system s such as Payroll processing applications. You can optionally

mark tim e entries as being exported, so that you can avoid re-exporting the sam e data.
Once atim esheet has been m arked as exported it cannot be unsubm itted (unlocked) for
re-editing. You will need to m ake corrections to the tim  esheet by clicking the ™  Add

Correc tion" button. This is a safeguard to avoid m odifying previously exported tim e entries.
Note that adm inistrators (those with the "Can Manage All" tim esheet perm ission) can

bypass this restric  tion and still unsubm it a previously exported tim esheet, if the need

arises.

Note that only subm itted (locked) tim  esheets can be m arked as exported.

Another option for getting access to tim esheetdataistoruna  Timesheet Details report.
This report can be ¢ ustom ized to only output the fields you require, and can be downloaded
inanum ber of form ats, inc luding Microsoft Excel. The  Reports topic has m ore inform ation.

Importing Timesheets
If your perm ission level allows it you can im port tim esheet data by clicking the popup m enu

in the upper right of the list and then clicking the Import Timesheet Data link. The
Im porting/Exporting __ topic has m ore inform ation.

Printing Timesheets

The 'Print Tim esheet' option in the popup m enu in the upper right corner of the tim esheet
list allows you to download a PDF hard copy of all of the tim esheets in the list. This is useful
if you need to print out m ultiple tim  esheets for signing, for instance. N ote that, rather than
printing the entire list, you can print selected tim esheets by clicking the checkbox on each
row before selecting the 'Print Tim esheets' option.

You can also print individual tim esheets by clicking the tim e period link inthe tim  esheet list,

then c licking the 'Print' view button in the upper-right corner of the tim esheet. This will
download a PD F version of the tim  esheet suitable for printing.
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Approving Project Time

Project tim e approval allows project m anagers to review and approve em ployee tim e by
project rather than by tim esheet. You can set up perm  issions such that project approvers
only see projects they are allowed to approve.

Enabling Project Time Approval

You enable projecttim e approval from the System > Approval Levels page . On each
approval level ¢ heck the "Projec t" checkbox if that level is applicable for project approval in
your organization. If at least one "Project" checkbox is checked then you will be able to

access the Approvals > Project Time Approvals page

Enabling project tim e approval will not autom  atic ally grantem ployees perm ission to approve
projects. You still need to go to the System > Security page and m odify or add perm ission
levels to enable the "Can approve" project perm ission. You can specify either”  Can approve
all" or "Can approve lim  ited" project perm ission. Any project approver with the "Can approve
limited" project perm ission will need to be assigned perm ission to each appropriate project.

This is done by going to the Tasks > Projects > Permissions page and adding the
employee to each appropriate project.

Project Time A pproval Process

Click the Approvalstab . If you have "Can approve" perm ission on both Tim esheets and
Projects you will see two links in the area below the Approvals tab: " Tim esheet Approvals™
and "Project Tim e Approvals". Clic k the "Projec t Tim e Approvals" link. If you only have "Can
approve" perm ission for Projec ts (that is, you don't have the " Can approve" perm ission for
tim esheets) then you will be taken directly to the Project Tim e Approvals page when clicking
the Approvals tab.

The Project Time Approvals page will list sum mary projecttim e data, organized by
project and em ployee. This gives you a dashboard overview of project tim e. You can narrow
or filter the projec  ttim e shown by adjusting the following project lookup options:

Property Description
Time Period The tim e period for reviewing and approving project tim e data.
Generally you will choose a prior tim esheet period, e.g. "Previous

Week" if using weekly tim  esheet periods. For convenience, the last
value selec ted will be recalled the next tim e this page is accessed.

Tim e Entry Status The approval status filter for the data being reviewed. Possible
values are:
X Any: No filtering applied.
X Open: Only show unsubm itted projecttim e.
X Pending Approval: Only show subm itted project tim e that is not
approved.
X Approved: Only show project tim e that is approved.
X Rejec ted: Only show project tim e that is rejected.

Project If a project is selected then the data will be lim ited to the specified
project.
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Employee Enter an em ployee nam e, ID orloginto lim itthe projecttim etoa
specific em ployee. The searc hwilldo a partialm atch, e.g. "ob"  will
matc h both "Robert" and "Bob". You can use the wildcard " *' for a
more specific matc h. For exam ple, to find anem ployees whose
nam e ends with "bert" you would enter "*bert". To find an em ployee
whose nam e starts with "an" you would enter "an*"

Employee Type You can select one orm  ore em ployee types to lim it the data to just
those em ployees of the selected type.

Tim e Entry Notes You can lim it or search for data that contains a specific com ment in
the tim e entry notes field.

Reporting G roup You can lim it the data to a specific reporting group. N ote that
"reporting group" is a term inology item , and could have been
renam ed (e.g. "Cost Center" or "Departm ent").

To review and approve (or reject) the displayed project tim e click the Details button on the

right side of eac  h row. This will bring you to the Project Approval Details page . On the

details page you will see the individual tim e entries for the specified project and em ployee.

To approve the entries you select one or m ore rows and click the  Approve button (or the

Reject button if rejecting the entries). When you have finished your review you can click

the Next/Previous buttons in the upper-right corner of the list to navigate to the next details

page. This m akes it easy to quickly step through each set of project tim e entries (you don't
need to go bac ktothe sum mary screen for each em ployee).

You can undo an approval or rejection by clicking the "More" popup menu to the right of
the Approve and Reject buttons. Sim ply select the appropriate entries from the list, then
select "Undo Approve" or"  Undo R eject” .

When reviewing the project tim e you m ay want to see different entry fields (e.g. Pay

Amount, or Overtim e). Adm inistrators can define which tim e entry fields are displayed on

the Project Approval D  etails page. See the  Project Time Approval Options below form ore
inform ation.

Since project approvals ¢ an be done for any arbitrary tim e period (daily, weekly, etc.), it is
important to understand when a tim esheet is considered entirely project approved. When all

of an em ployee's projecttim e inatim esheet period is project approved, then the entire

tim esheet will be considered project approved, even if that tim esheet has non-projecttim e
(e.g. vacation or sic  k leave). Autom atically m arking the tim esheet as project approved is
useful when you have m ultiple approval levels: a payroll or HR approver can quickly see

that atim esheet has been project approved when they are looking at tim esheets on the

Tim esheet Approvals page.

Project Time A pproval Options

If you are logged in as an adm inistrator (that is, your perm issions allow youtom anage
system settings and you can see the System tab), you will see an  Options item in the
"More" popup menu to the right of the Approve and Reject buttons on the Project
Approval Details page. Selecting the Options item will load the  Project Time Approvals
Options page. You can change the following options:

Property Description
Tim e Entry Details The list of tim e entry fields that are displayed on the project tim e
approval details page. You can add additional fields (for exam ple, Biill

Amount), or rem ove fields that are not relevant.
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Crew Approval

The Crew Approval page allows you or your clients to review and approve entries on a
weekly or daily basis. The Crew Approval page is accessed as a stand-alone (or kiosk) web

page:
http://hostnam  e/timesheet/kiosk/home.do

Where the "http://hostnam e" portion should be replaced with the appropriate value for
your Pacific Tim esheet installation, for exam  ple "https://m  yco.pacifictim esheet.com "
Once you log into this page you will be able to view and approve/reject entries on a weekly

or daily basis forem ployee groups or crews. To be able to do this you m ust have the
following ¢ onfiguration:

X Your em ployee profile's perm ission level m ust allow you to approve. You can check your
perm ission level from the Em ployees page, and the perm  ission level can be checked
from the System > Security page. You can be set to "Approve All" or " Approve Lim ited".
X If your approval perm  ission is "Approve Lim ited” you m ust next be assigned to one or
more em ployee groups. For every group you are assigned to that you want to be able to

approve m ake sure the perm ission level is appropriate. For exam ple, if your perm ission
level is "Manager" you m  ust be assigned to one orm  ore groups with the perm ission level
of "Manager".
Note: The system adm inistrator m ay want to log into the kiosk and configure som e of the
Crew Approval options first. The online help link in the kiosk provides further inform ation.
_0_
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Leave R equests

Leave requests facilitate the scheduling of em ployee tim e off. New leave requests are

subm itted from the Hom e page by clicking the New Request link. D epending upon your
polic y settings, your leave requests will autom atically show up on your tim  esheet for the
requested days when the request is approved. Note that the term "Leave" may have been
renam ed by an adm inistrator to "Tim e Off" or som e otherterm inology. The Term inology
topic has m ore inform ation.

Leave requests have the following properties:

Property Description

Request Type The type of leave request, for exam ple 'Vacation'. The request type is
a pay c ode, and ifyouaream  anager you can configure these from
the System > Pay Codes page.

Start D ate The first day of the leave.
End D ate The last day of the leave.
Partial D ay If you are not taking a full day you can check this option to allow you

to enter the starttim e and finishtim e. Note that you m  ay not see
this option if you are not allowed to take partial days of leave for the
selected request type. This is controlled by the Tim e Entry R ules
minim um/m axim um leave hours setting - see the Time Entry Rules
topic for m ore inform ation.

Requested Leave The num ber of leave days/hours to be taken. This will default to the
num ber of days in the selected date range, excluding any weekend
days or holidays.

Description A description of this leave request, up to 255 characters. You m ight
use this to provide additional inform ation to your approver, such as a
phone num ber where you can be reached in an em ergency, etc.

Once you have subm itted a leave request you can m onitor its approval status from the
Home page. If your adm inistrator has configured em  ail notifications you will be sent an
email when a request is approved or rejected.

Approving Leave R equests

Leave requests require at least one approval level be enabled. You can configure approval
levels from the System > General > Approval Levels page - the Approval Levels topic has

more inform ation. In addition, you need to be assigned as an approver to one or m ore
employees to be able to approve leave requests. The Managing Em ployees topic has m ore
inform ation.

To list Leave Requests click the Leave Requests tab. B y default you will see a list of all

future requests. You can narrow or refine the list using the search properties on the page.

To approve or reject leave requests sim ply click the appropriate checkbox in the list and

click the Save button. If notices are enabled the em ployees will autom atically receive an
email indicating whether their request was approved or rejected. Clicking the D ate hyperlink

in the list will show m  ore details about the request. You can also approve or reject the
request from the details page.

To configure em ail notices for leave requests go to the System > Notices page. The Notices
topic has m ore inform ation.
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Note: You can change the term inology for Leave to suit your organization's needs. The

Term inology topic has m

Leave Request Policy R

ore inform ation.

ules

Admiinistrators can configure polic  y rules for leave requests from the System > Policies >

Schedule R ules page. The

Leave Request Permissions

Schedule Rules topic has m ore inform ation.

There are several leave request perm issions (configured from  the System > Security page):

Permission

Can create m y leave
requests

Manage

Approve

Description

Employees with this perm  ission enabled (m eaning they have
this perm ission enabled for the perm ission level in their

em ployee profile) will be able to create new leave requests for

pay codes they are allowed to access (based on their pay code

'‘Can view' perm ission). They will also be able to delete leave
requests they created as long as they have not been m arked
as approved. To delete an approved leave request it m ust first
be unapproved by an approver.

Employees with this perm  ission (m eaning they have this

perm ission enabled for the perm  ission level in theirem  ployee
profile) can m anage all or alim ited subset of the em  ployee
leave requests. If set to lim ited then the em  ployee (or an
employee group they are in) m ust be assigned to individual
employee groups for whic  h you wish them to m anage leave
requests. Enabling this perm  ission for an em ployee m eans
they will have access to the 'Leave R equests' tab of the
application.

Note that Leave Requests do not have any sub-perm issions
for Manage, unlike m  any other objects in the system . The
‘Can m anage' perm ission effectively gives the user the ability

to view leave requests in a read-only form at on the Leave
Requests tab. You m ight use this perm ission if you want to
allow som e em ployees to see leave requests for planning
purposes, but prefer other em ployees approve/reject the
requests.

Employees with this perm  ission (m eaning they have this

perm ission enabled for the perm  ission level in theirem  ployee
profile) can approve all or a lim ited subset of the em  ployee
leave requests. If set to lim ited then the em ployee (or an
employee group they are in) m ust be assigned to individual
employee groups for whic  h you wish them  to approve leave
requests. Enabling this perm  ission for an em ployee m eans
they will have access to the 'Leave R equests' tab of the
application.
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Can create for approvees

Employees with this perm  ission enabled (m eaning they have
this perm ission enabled for the perm ission level in their

em ployee profile) will be able to create (and delete) leave

requests forem ployees. The listof em ployees they can do this
for depends on their 'Can approve' leave request perm ission,
as well as whether they are assigned as approvers to any
employees in theirem ployee profiles.

Note that this perm  ission requires the 'Can approve'
perm ission be enabled as a pre-requisite.

_o_
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Leave Request Options

The following leave request options can be set:

Property
Default Approval
Start D ate

Description
When listing requests for approval, look back this m any days by
default. This setting is available to adm inistrators only and will affect

all approvers.
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Managing Tasks

Norm ally tim e is recorded against a Work Breakdown Structure (WB S). A set of pre-defined
levels are provided: Project G roups, Projects, Task G roups and Tasks. Each level can be

renam ed as appropriate for your organization, for exam ple Project G roups m ay be m ore
appropriately called Clients, or Task G roups called Phases or Cost Centers. Also, not all

levels need to be used and can be disabled. The Work Breakdown Structure topic has m ore
inform ation.

Levels m ay or m ay not have a hierarchical relationship, for exam ple a Project m ay belong to
a Client, whereas a Cost Center could be used across all Projects.

Related Topics

Custom ers
Project G roups
Projects

Task G roups
Tasks

X X X X X
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Customers

Custom ers have the following properties:

Property Description

Name The custom er nam e, up to 80 characters. A value is required and
must be unique for all custom ers.

Description A description for the custom  er, up to 255 characters.

ID The custom erID , up to 80 characters. This value is not required, but
if a value is entered it m ust be unique for all custom ers. This is
com monly used for synchronizing with external system s, such as
billing or accounting.

Status The custom er status, either Active or Inactive. You cannot delete
custom ers that have been used on tim esheets. Setting the status to
inactive will prevent any further use of the custom er.

Notes Notes about this custom  er, up to 2000 characters.

Note: You can change the term inology for Task, Task G roup, Project, Project G roup and

Custom er to suit your organization's needs. The Term inology topic has m ore inform ation.
Permissions

Permissions allow you to restrict which custom ers em ployees can access on their
tim esheets. Em ployees witha Permission Level that gives them  only lim ited viewing

perm ission, for instanc e, will only be able to access custom ers for which they have been
added to the perm ission list.
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Project Groups

Project Groups have the following properties:

Property Description

Name The projec tgroup nam e, up to 80 characters. A value is required and
must be unique for all project groups.

Description A description for the project group, up to 255 characters.

ID The projec tgroup ID, up to 80 characters. This value is not required,
but if a value is entered it m ust be unique for all project groups. This
is commonly used for synchronizing with external system s, such as
billing or accounting.

Status The project group status, either Active or Inactive. You cannot delete
project groups that have been used on tim esheets. Setting the status

to inac tive will prevent any further use of the project group.
Notes Notes about this project group, up to 2000 characters.

Note: You can change the term inology for Task, Task G roup, Project, Project G roup and

Custom er to suit your organization's needs. The Term inology topic has m ore inform ation.
Permissions

Permissions allow you to restrict which project groups em ployees can access on their

tim esheets. Em ployees witha Permission Level that gives them  only lim ited viewing

perm ission, for instanc e, will only be able to access project groups for which they have been
added to the perm ission list.
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Projects
Projects are objects that can be associated with tim e and asset entries recorded by your
employees. As projects are full system objects they can be extended by adding custom

fields: see the Custom Fields help topic for m ore inform ation.

Note: You can change the term inology for the Project object to suit your organization's
needs. For instance youm  ay prefer" Job" instead of "Project” . The Term inology topic has

more inform ation.

Projects have the following properties:

Property
Name

Description

ID

Status

Planned Start D ate
Planned Finish D ate

Planned Work

Actual Start D ate

Actual Finish D ate

Description

The projec tnam e, up to 80 characters. A value is required and m ust
be unique for all projects.

A description for the project, up to 255 characters.

The projec tID , up to 80 characters. This value is not required, but if

avalue is entered itm  ust be unigue for all projects. This is com monly
used for synchronizing with external system s, such as billing or
accounting.

The project status, either Active or Inactive. You cannot delete
projects that have been used on tim esheets, but setting the status to
inactive will prevent any further use of the project.

The planned project start date.
The planned project finish or end date.

The planned total num  ber of days or hours to com  plete this project.

Administrators can configure the units (days or hours) from the
Projects > Project Options page: see the Project Options  help topic for
more inform ation.

The actual project star  t date.

Note that if a value is specified here it will be used by the Tim e Entry
Rule "Don't allow subm itting tim e for inactive Projects, Tasks etc.". If

this rule is enabled then em ployees will be prevented from recording
any tim e entries with dates prior to the Actual Start D ate. See the
Time Entry Rules help topic for m ore inform ation.

The actual project finish or end date.

Note that if a value is specified here it will be used by the Tim e Entry
Rule "Don't allow subm itting tim e for inactive Projects, Tasks etc." If

this rule is enabled then em ployees will be prevented from recording
any tim e entries with dates after the Actual Finish D ate. Seethe Time
Entry Rules help topic for m ore inform ation.

If you specify the Actual Finish D ate you can also have the project be
inactivated autom  atically a specified num  ber of days afterwards. See
the Project Options help topic for m ore inform ation.
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Actual Work The ac tual total num  ber of days or hours spent on this project. This
value is com puted by totalling ALL hours recorded against this project
on em ployee tim esheets, from the very earliest date. This value is
updated every 15 m inutes, but you can click the " Refresh" button to
update the value im  mediately.

Note that this value can be potentially tim e consum ing to com pute,
soitisonly com putedifa non-blank  Planned Work  value is
specified. You can, however, enter a zero for Planned Work if you
don't know the actual value, in order to get the Actual Work  to be
com puted.

Adm inistrators can configure the units (days or hours) from the

System > General > Project Options page: see the Project Options
help topic for m ore inform ation.

Notes Notes about this project, up to 2000 characters.

Project Permissions

Permissions allow you to restrict which projects em ployees can access on their tim  esheets.
Employees with a Permission Level that gives them  only lim ited viewing perm ission, for
instance, will only be able to access projects for which they have been added to the

perm ission list.

Project Dashboard

The Projec t D ashboard allows you to track the breakdown of Project hours by Task and Task
Group (e.g. "Phase"). In addition to reviewing hours spent on various project tasks, you can
com pare planned vs actual start and finish dates, as well as planned vs actual hours or days
worked. See the Project D ashboard help topic for m ore inform ation.
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Project Options

The Projec t Options page lets you configure global project settings, such as whether project
work is displayed in units of hours or days, etc.

Note: Project options are global settings that will affect all users. Only adm inistrators will
have access to the Project Options page.

Note: The term inology of projects, tasks and other objects can be changed via the System
> General > Term inology page.

The following project options can be configured:

Property Description
Default Work Units This setting determ  ines whether planned and actual work for
projects, etc. is entered/displayed in hours or days. D ata internally

is stored in hours, so when D ay is chosen for work units the value
will be com puted by dividing the hours by the default hours per

day, as configured on the System > General page.
Autom atic Inactivation | If enabled then projects and tasks will be autom atically inactivated
the specified num ber of days after their Actual Finish D ate value.

Inac tive projects and tasks will not be shown in pick lists on
employee tim esheets, etc.

The appropriate num  ber of days after the last day for inactivating

the item will depend on your requirem ents. Typically a value of 7
days is used in order to give em ployees enough tim e to add the
item to their tim esheet, especially if they save their tim esome
days after the actual date of the wor K.

Note that if no Actual Finish D ate value is specified then the project
or task cannot be inactivated autom atically.

Required Fields You can specify which fields are required when adding or editing
projects. By default the project nam e is required, but for your use
you m ay need additional fields m  arked as required, such as the
project ID .
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Project Dashboard

The Projec t D ashboard allows you to track the breakdown of Project hours by Task and Task
Group (or "Phase"). In addition to reviewing hours spent on various project tasks, you can
com pare planned vs actual start and finish dates, as well as planned vs actual hours or days
worked.

To c onfigure your dashboard ¢ lick the "Edit" button and add the appropriate tasks (and

phases) to the dashboard. You c an click the R efresh link to autom  atically build this list, too.
The Refresh link will add any tasks that have newly added hours, as well as update the

actual hours for all of tasks in the dashboard. The system will also autom atically update the
actual hours for dashboard item s every night - if you need to update the dashboard

immediately you can clic  k the R efresh link, too.

You can ¢ onfigure the planned start dates and planned work for each task in the dashboard

by c licking the Edit button, or by clicking the task nam e link in each row of the dashboard
and entering the appropriate values. Once you configure the planned values you will see

perc entage com plete and other statistics in the dashboard.

Note: Dashboard statistics such as Percent Com plete are updated nightly. Clicking the
"Refresh" link will update the statistics im mediately.
The following project dashboard colum ns can be displayed:

Column Description

Position The position of eac  h task in the list, starting from 1.

Task G roup The Task Group or Phase level of the work-breakdown-structure

(WBS), if enabled. Note that Task G roup can be renam ed when
configuring the WBS on the System > General page.

Task The Task level of the work-breakdown-structure (WB S), if enabled.
Note that Task can be renam  ed when configuring the WBS on the
System > General page.

Status The task status, such as "In Progress", etc. This list can be
configured by clicking the Edit button on any project dashboard,
then c licking the "Options" link in the lower-right corner.

Planned Start D ate The planned or estim  ated start date for the phase or task.
Planned Finish D ate The planned or estim  ated finish date for the phase or task.

Planned Work The planned or estim  ated work for the phase or task, in hours or
days. You c an specify whether the units are hours or days from
the Project Options page.

Actual Start D ate The actual start date for the phase or task.
Actual Finish D ate The ac tual finish date for the phase or task.
Actual Work The ac tual start work recorded for the phase or task. This value is

updated autom atically by the system  every night (or you can
update itim mediately from the dashboard by clicking the R efresh

link).
Percent Com plete This value is com puted by the system . If planned work is specified
and non-zero then the percent com plete will be:

100 * (actual work) / (planned work)
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Notes User-entered notes for this task entry in the dashboard.

To c onfigure whic h of these colum ns are displayed click the Options link on the Edit
Dashboard page to view the Project D ashboard Options page.

Project Dashboard Options

When editing the projec  t dashboard, you can click the Options link in the lower right corner

to go to the Project D  ashboard Options page. This page lets you configure global project
dashboard settings, such as the list of task states, etc.

Note: Project dashboard options are global settings that will affect all users. Only
adm inistrators will have access to the Project D ashboard Options page.

The following dashboard options can be configured:

Property Description

List Colum ns Choose which ¢ olum ns to display in the dashboard. You can specify
the order of the colum  ns by dragging and dropping the colum n
nam es.

Task States This setting lets you control the list of task states, such as " In
Progress", "Com pleted", etc. as suits your organizational needs.
Task states are used on the Project D ashboard to track the status
of the tasks needed to com  plete a project.

Importing/Exporting Dashboards

You can use the tools m  enu on the project dashboard to im port or export the dashboard
configuration. See the  Project Dashboard CSV Format topic for m ore inform ation.

Refreshing Dashboards

You can use the tools m  enu to 'refresh’ the actual hours recorded against each project
dashboard item . The system autom atically updates these values nightly, but you can use

the tools m enu refresh option to get the m ost recent value in cases where users are actively
entering data.
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Task Groups

Task G roups have the following properties:

Property Description

Name The task group nam e, up to 80 characters. A value is required and
must be unique for all task groups.

Description A description for the task group, up to 255 characters.

ID The task group ID, up to 80 characters. This value is not required,
but if a value is entered it m ust be unique for all task groups. This is
com monly used for synchronizing with external system s, such as
billing or accounting.

Status The task group status, either Active or Inactive. You cannot delete
task groups that have been used on tim esheets. Setting the status to

inactive will prevent any further use of the task group.
Notes Notes about this task group, up to 2000 characters.

Note: You can change the term inology for Task, Task G roup, Project, Project G roup and

Custom er to suit your organization's needs. The Term inology topic has m ore inform ation.
Permissions

Permissions allow you to restrict which task groups em ployees can access on their
tim esheets. Em ployees witha Permission Level that gives them  only lim ited viewing

perm ission, for instanc e, will only be able to access task groups for which they have been
added to the perm ission list.
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Tasks

Tasks have the following properties:

Property
Name

Description

ID

Status

Planned Start D ate
Planned Finish D ate
Planned Work

Actual Start D ate

Actual Finish D ate

Description

The task nam e, up to 80 characters. A value is required and m ust be
unique for all tasks.

A description for the task, up to 255 characters.

The task ID, up to 80 characters. This value is not required, but if a

value is entered itm  ust be unigue for all tasks. This is com monly
used for synchronizing with external system s, such as billing or
accounting.

The task status, either Active or Inactive. You cannot delete task S

that have been used ontim  esheets, but setting the status to inactive
will prevent any further use of the task.

The planned task start date.
The planned task finish or end date.
The planned total num  ber of days to com plete this task.

The ac tual task start date. This property is only available if projects
are disabled (see the  Work Breakdown Structure  topic form ore
inform ation).

Note that if a value is specified here it will be used by the Tim e Entry
Rule "Don't allow subm itting tim e for inactive Projects, Tasks etc.". If

this rule is enabled then em  ployees will be prevented from recording
any tim e entries with dates prior to the Actual Start D ate. See the
Time Entry Rules help topic for m ore inform ation.

The ac tual task finish or end date. This property is only available if
projects are disabled (see the Work Breakdown Structure  topic for
more inform ation).

Note that if a value is specified here it will be used by the Tim e Entry
Rule "Don't allow subm itting tim e for inactive Projects, Tasks etc." If

this rule is enabled then em ployees will be prevented from recording
any tim e entries with dates after the Actual Finish D ate. Seethe Time
Entry Rules help topic for m ore inform ation.

If you specify the Actual Finish D ate you can also have the task be
inactivated autom  atically a specified num  ber of days afterwards. See
the Project Options help topic for m ore inform ation.
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Actual Work The ac tual total num  ber of days or hours spent on this task. This
value is com puted by totalling all hours recorded against this task on
employee tim esheets. This value is updated every 15 m inutes.

Note that as this value can be potentially tim e consum ing to

com pute, itis only com  puted if a non-blank  Planned Work  value is
specified. You can, however, enter a zero for Planned Work  if you

don't know the actual value, in order to get the Actual Work  to be
com puted.

Administrators can configure the units (days or hours) from the
System > General > Project Options page: see the Project Options
help topic for m ore inform ation.

Billable Indicates whether this task is billable or not. Note that you can
change which type of object (Project, Task, etc.) has the billable flag.
The Rate Options topic has m ore inform ation.

Notes Notes about this task, up to 2000 characters.

Note: You can change the term inology for Task, Task G  roup, Project, Project G roup and
Custom er to suit your organization's needs. The Term inology topic has m ore inform ation.
Permissions

Permissions allow you to restrict which tasks em ployees can access on theirtim  esheets.
Employees with a  Permission Level that gives them  only lim ited viewing perm ission, for
instance, will only be able to access tasks for which they have been added to the perm ission
list.

_o_
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Asset Tracking

Pacific Tim esheet allows you to track assets and their usage. Assets are generally non-labor
item s you want to track on a regular basis, such as m aterials, equipm ent and other
resources you use as part of your projects or jobs.

Note: You can change the term inology 'Asset' to suit your organization's needs. The
Term inology topic has m ore inform ation.

Related Topics:

Assets

Asset Classes
Asset Types

Units of Measure
Asset Entries
Asset Entry Fields

X X X X X X
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Asset Entries

Asset entries track the actual usage of assets. Asset entries are records keeping track of

what quantities of assets were used over tim e. Forexam ple, youm ight have am aterial
asset entry of 10 gallons (the quantity) of diesel (the asset) used on Monday 3/28 (the
date). You can control the specific fields that are entered for each asset type from the Asset

Entry Fields page.

Note: You can change the term inology 'Asset’ to suit your organization's needs. The
Term inology topic has m ore inform ation.

Assets entries can have the following entry fields (depending upon how the entry fields are

configured: see the

Asset Entry Fields topic for m ore inform ation):

Property
Date

Entry ID

Asset

Quantity

Description

Unit Cost

Description

The date of the entry. This is the date the asset was used, for
instance. This field is required.

A uniqgue ID for identifying this entry. If the field is not entered

by the em ployee than a value is autom atically generated. You

can control the form  atting of this by editing the ID form at on the
Asset Types page. Seethe  Asset Types topic form ore

inform ation.

The asset associated with this entry. The selected asset wi I
determ ine:

X The unit of m easure for the quantity field, e.g. G allons or
Kilom eters.
X The num ber of digits to the right of the decim al point that

can be entered for the quantity field.

X The unit cost, which can be overridden if the Unit Cost or
Total Cost fields are allowed entry.

X The unit pric e, whic h can be overridden if the Unit Price or
Total Price fields are allowed entry.

To learn m ore about setting up assets refer to the Assets topic.

The am ount of the asset used for this entry, in whatever units

the asset's unit of m  easure indicates. N ote that negative values
are allowed asawaytom  ake corrections to entries that are

loc ked and therefore not editable.

A description for this entry, up to 255 characters. For larger text
input you can also use the Notes field.

The unit cost for the asset used by this entry. Cost is what you
pay for this asset, as opposed to price, which is what you charge
for this asset. The value will default to the unit price of the
selected asset, if specified.

Note that you can optionally allow this value to be overridden if
you m ake this field editable (see the Asset Entry Fields topic for
more inform ation).
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Cost

Unit Bill Am ount

Bill Am ount

Billable

Reimbursable

Notes

Employee

The total cost for this entry, com puted as the quantity tim es the
unit cost. Cost is what you pay for this asset, as opposed to bill
amount, which is what you charge for this asset.

Note that you can optionally allow this value to be overridden if

you m ake this field editable (see the Asset Entry Fields topic for
more inform ation). If this value is overridden then a new unit

cost will be com puted for the entry as the total cost divided by

the quantity.

The unit billam ount or rate for the asset used by this entry. B ill
amount is what you charge for this asset, as opposed to cost,

whic h is what you pay for this asset. The value will default to the

unit bill am ount of the selected asset.

Note that you can optionally allow this value to be overridden if
you m ake this field editable (see the Asset Entry Fields topic for
more inform ation).

Note that both Unit Bill Am ount and Bill Am ount will be
autom atically set to zero if the B illable checkbox is present and
not check ed.

The total billam ount for this entry, com  puted as the quantity
tim es the unit billam  ount. Billam ount is what you charge for
this asset, as opposed to cost, which is what you pay for thi S
asset.

Note that you can optionally allow this value to be overridden if

you m ake this field editable (see the Asset Entry Fields topic for
more inform ation). If this value is overridden then a new unit bill
amount will be ¢ omputed for the entry as the total bill am ount
divided by the quantity.

Note that both Unit Bill Am ount and Bill Am  ount will be
autom atically set to zero if the B illable checkbox is present and
not check ed.

A chec kbox field that indicates whether this asset entry is
billable or not. If the asset entry is not billable then the Unit Bill
Amount and Bill Am ount values will be autom  atically set to zero.

A chec kbox field that indicates whether the em ployee associated
with this asset entry should be reim bursed for the cost.

Notes for this entry, up to 4,000 characters (2,000 for Oracle
databases). Use this for longer inform ation about the entry, as
opposed to the description field, which has a lim it of 255
characters.

The em ployee to associate with this entry. By default it is set to
the em ployee who created the entry.

Note that you can optionally allow this value to be overridden if
you m ake this field editable (see the Asset Entry Fields topic for
more inform ation).
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Reporting G roup

Custom er/Project/Task

Custom Fields

The group to associate with this entry. B y default it is set to the
reporting group of the em ployee who created the entry.

Reporting G roup is aterm inology item and can be changed to
"Cost Center", "D epartm ent"," Crew", etc. The Term inology topic
has m ore inform ation.

Note that you can optionally allow this value to be overridden if
you m ake this field editable (see the Asset Entry Fields topic for
more inform ation).

You can enter a value for the work breakdown structure (WB S)
for this entry. Form  ore inform ation on see the  Work Breakdown

Structure _ topic.

Note that you can have the em ployee inputas m any or as few of
the WBS levels as you like by editing which fields are allowed for
entry (see the  Asset Entry Fields topic for m ore inform ation).

You can have any num  ber of custom fields that can be entered

by the em ployee. To add new custom fields select the Custom
Fields option on the More m  enu (see the Custom Fields topic for
more inform ation).
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Asset Entry Fields

You can custom ize the list of fields that are entered for each type of asset entry. This gives

you great flexibility in setting up entry tem plates that are different for each asset type, such

as equipm ent, m aterials or expenses. In addition to which fields are shown, you can also

specify the access level for individual fields. For instance, you can have som e fields, such as
price or cost fields, that are only editable by m anagers.

Note: You can add to the list of available entry fields by selecting the Custom Fields option
from the More m enu (see the Custom Fields for m ore inform ation). Once you have added
your custom fields you will need to go back to the Asset Entry Fields page to enabled

them .

Asset entry fields have the following properties:

Property Description

Enabled If ¢ hec ked the field is enabled and can be shown or edited.

Access The default acc ess level or perm ission for this field: hidden,
read-only or editable.

Access Exceptions Access exceptions allow you to override the default access for
specific em ployee perm ission levels. For instance, you m ay have
cost fields hidden from  all users by default, but allow m anagers

and adm inistrators to see and edit these fields.

Required If ¢ hec ked then a value for this field is required. Entries will not be
able to be saved or subm itted until a value is provided.

New G roup If ¢ hecked then this field denotes the start of a new group of
fields. This is a cosm etic setting to help group related fields
together: a dividing line will be inserted before this field to
separate it from  previous fields.

Detail If ¢ hec ked then this field will be considered a detail and not shown
in lists of entries. Instead you will need to drill into the listed entry
(or clic k the details button) to see the field. Check this setting for
fields that are only infrequently entered and to prevent entry lists
from becom ing too wide.

Special Field Properties

Som e fields have additional properties that can edited:

Field Description
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Entry ID This field is an auto-generated sequential num ber. Eachtim e an
entry is created the value will be increm ented. The default form  at
is as follows:

{0000000000}

This results in a 10 digit num ber padded with leading zeros.

For a num ber with no leading zeros the form atis:

{0}-> 176268

You can prepend or append characters to the form at, too, such as:
EQ{00000000}

Note that the Entry ID field can be m anually entered, too, by

setting the field access to editable. To turn off the generation of
the sequential num  ber enter the following form at:

{

Reordering Fields

You can specify the order in which the fields appear by clicking the Edit button on the Entry
Fields page, then clicking and dragging each row to m ove it where you like.
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Assets
Assets are the definitions or profiles of the m aterials, equipm ent, etc. you are tracking.
Assets ¢ an be broadly divided into user-defined types, such as equipm ent, m aterials or

expenses (see the Asset Types topic for m ore inform ation). Assets can be further divided
into user-defined classes, for exam ple equipm ent assets m ay be classified by Truck, Auto,
etc. (see the Asset Classes topic for m ore inform ation).

Assets define what you keep track of, whereas Asset Entries are used to track the actual

usage of these assets. For exam ple, youm ay have am aterial assetnam ed'Gravel, and an
asset entry that indicates how m uch gravel a crew used on a particular date. See the Asset
Entries topic for m ore inform ation.

Note: You can change the term inology 'Asset' to suit your organization's needs. The
Term inology topic has m ore inform ation.

Assets have the following properties:

Property
Name

Description

ID

Status

Class

Unit of Measure

Units Decim al Digits

Description

The asset nam e, up to 80 characters. A value is required and m ust
be unique for all assets (regardless of the asset type).

A description for the asset, up to 255 characters.

The asset ID, up to 80 characters. This value is not required, but if

a value is entered itm  ust be unique for all assets (regardless of the
asset type). Thisis ¢ ommonly used for synchronizing with external
system s, suc h as billing or accounting.

The asset status, either Active or Inactive. Setting the status to
inactive will prevent the recording of any further asset entries for

this asset. Note that you cannot delete assets that have asset
entries assoc iated with them , and in those cases you will instead
make the asset inactive to prevent its further use.

The asset class (optional). Asset classes are configured on the
Assets > Asset Class page (seethe  Asset Classes topic form more
inform ation).

The unit of m easure for this asset (optional). Units of m easure are
configured on the Assets > Units of Measure page (see the Units of
Measure topic form more inform ation).

The num ber of dec imal digits of precision for entering the quantity
value for asset entries. It will default to the "D efault D ecim al Digits"
property for the selected unit of m easure, but you can override this.
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Unit Am ount

Unit Bill Am ount

Notes

The unit am ount or cost of this asset, per unit of m easure. Am ount
is what you pay for this asset, as opposed to the bill am ount, which
is what you charge clients or custom ers for this asset. Unit Am  ount

is used to com pute the total am  ount based on the quantity entered
by the em ployee. The unitam ountis only useful if you have the
employee enter the quantity.

If m ulti-currency is enabled for the asset type then you can also
select the default currency for this asset.

Unit am ounts can be editable by em ployees, or fixed (for exam  ple,
you m ay have a Mileage item  that has a fixed rate of 0.55 per m ile
and you do not want the em ployee to change that rate).

You can also ¢ ontrol whether the unit am ount is editable (as well as
total am ount) by setting the entry field perm issions (see the Asset
Entry Fields topic for m ore inform ation).

The unit billam ount or rate for this asset, per unit of m easure. B il
amount is what you charge for this asset, as opposed to cost, which
is what you pay for this asset. Unit bill am ount is used to com  pute

the total billam  ount based on the quantity entered by the
employee. The unit billam  ount is only useful if you have the
employee enter the quantity.

Unit billam ount ¢ an be either a fixed value, or can be com puted.
The following options are available:

Fixed The unit price is always the value entered: it does
Amount not change based on the unit cost.
Markup The unit bill am ount is ¢ omputed from the unit cost

as a percent m arkup:
Unit Bill Am ount = Unit Cost * (1 + Markup)

For exam ple, if the m arkup is 50% and the unit

cost is $10.00, then the unit bill am ount will be
$15.00.
Margin The unit billam ount is ¢ omputed from the unit cost

to give you a percentm  argin:
Unit Bill Am ount = Unit Cost/ (1 - Margin)

For exam ple, if the m argin is 50% and the unit cost
is $10.00, then the unit bill am ount will be $20.00.
As you can see from  the equation, the m  argin can
never be 100% or greater.

Note that you can optionally allow entries to override this unit bill
amount if you allow the entry's Unit Bill Am ount or Total Bill
Amount fields to be editable (see the Asset Entry Fields _topic for
more inform ation).

Notes about this asset, up to 2000 characters.
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Asset Classes

Asset ¢ lasses allow you to organize your assets into logical groupings. For exam ple, given an
asset type of Equipm entyou m ight created classes suchas"  Truck"," Auto", etc. Once you
have defined your asset classes you can select them when editing asset properties (see the
Assets topic for m ore inform ation).

Asset ¢ lasses have the following properties:

Property Description

Name The asset class nam e, up to 80 characters. A value is required and
must be unique for all classes (regardless of the asset type).

Description A description for the asset class, up to 255 characters.

ID The asset class ID , up to 80 characters. This value is not required,
but if a value is entered it m ust be unique for all asset classes
(regardless of the asset type). This is com monly used for
synchronizing with external system s, such as billing or accounting.

Status The asset class status, either Active or Inactive. Setting the status

to inac tive will prevent its use when editing assets. Note that you
cannot delete an asset class if there are assets that use it, and in
those cases you will instead m  ake the asset class inactive to

prevent its further use.
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Asset Types

Asset types are designed to be used for very broad categories of assets, e.g. Material,

Equipm ent or Expenses. There is no hard lim it to the num  ber of asset types you can create,
but keep in m ind that each asset type can optionally have a tab on the tim esheet, so you
generally want to lim it the num ber to less than 10.

Asset types have the following properties:

Property
Name

Plural Nam e

Description

ID

Status

Description

The asset type nam e, up to 40 characters. A value is
required and m ust be unique.

The plural nam e of the asset type, up to 40 characters. A
value is required and m  ust be unique.

A description for the asset type, up to 255 characters.

The asset type ID , up to 80 characters. This value is not
required, but if a value is entered it m ust be unique for all
asset types. This is com  monly used for synchronizing with
external system s, suc h as billing or accounting.

The asset class status, either Active or Inactive. N ote that
you cannot delete an asset type if there are assets, cl asses,
etc. that use it. In those cases you will instead m ake the

asset type inactive to prevent its further use.

Asset types have the following advanced properties:

Property
Auto-generate Asset Entry ID

Description

If enabled then unique asset entry ID s will be autom  atically
generated whenever an entry is created. B y default the ID
form at will be a sequential num  ber padded out to 10 digits
with leading zeros. You can alter the ID form at to suit your
needs (for exam ple, to m ore easily integrate with external
system s). Exam ple form ats are:

{0}-> A sequential num ber with no leading zeros
(meaning the length will increase as the sequential num ber
increases). For exam ple 1234’

{00000000} -> A sequential num ber padded with leading
zeros to be a length of 8 digits. For exam ple '00001234'.

{ABC-0000000} -> A sequential num  ber padded with
leading zeros to be 7 digits in length, with the prefix 'AB C-.
For exam ple '"ABC-0001234".

Note that you should not m ake the num ber of zeros in the
form at too few or the sequential num ber will be truncated
and you will not have a unique 1D (ID s must be unique).
You should consideram  inimum of at least 7 zeros in the
form at.
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Asset Sheet Enabled

Auto-generate Asset Sheet ID

Multi-Currency Enabled

If enabled then asset entries will be collected or grouped
into asset sheets (for exam ple, Expense Sheets). When
em ployees want to record asset entries they will need to
edit or create an asset sheet first, and asset entries will be
added to the asset sheet. This is convenient for grouping
related entries into a logical unit, such as expenses incurred
on a business trip.

If enabled then unique asset sheet ID s will be autom  atically
generated whenever an entry sheet is created. The form at
is the sam e as described above for auto-generated asset

entry ID s.

If enabled then em  ployees can pick the local currency for
asset entry am ounts. When em ployees create entries the

amount they enter can be in Euros or Canadian D ollars,
even when the base currency for the system is US D ollars
(the base ¢ urrency is configured on the System > General
page).

The list of currenc ies an em ployee is allowed to choose from
is c onfigured on the System > General > System Options

page.

With m ulti-c urrency enabled the entered local am ounts will
be c onverted to the base currency internally, and will be

available for reporting or export/im port. For instance, in
addition to the Asset Entry.Am ount field you will find
additional fields: Asset Entry.Am ount-Local (the am ount as
entered by the em  ployee in the local currency) and Asset
Entry.Am ount-Currency (the local currency selected by the
employee).

Note that conversions between local currency am ounts and
the base ¢ urrency for the system  are handled autom atically
using ¢ urrency exc hange rates provided by reputable third

party sources based on official central bank data. Currency

exc hange rates can be optionally overridden at the

individual entry level if so desired.

If m ulti-currency is not enabled then all am ounts are
considered to be in the base currency.
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Units of Measure (UoM)

Units of m easure (UoM) define the type of quantity that is entered for assets. Once you

have defined your units of m

properties page (see the

easure you can selectthem  for your assets from  the asset

Assets topic for m ore inform ation).

Units of m easure have the following properties:

Property
Name

Abbreviation

Description

ID

Status

Default Dec imal Digits

Description

The unit of m easure nam e, up to 40 characters. A value is
required and m ust be unique.

The abbreviation for the unit of m easure, up to 10 characters. If
not specified it will be set to the nam e (up to the first 10
characters). The abbreviation is what is generally shown to end
users when entering data, running reports, etc.

A description for the unit of m easure, up to 255 characters.

The unit of m easure ID , up to 80 characters. This value is not
required, but if a value is entered it m ust be unique for all units
of m easure. This is ¢ ommonly used for synchronizing with
external system s, suc h as billing or accounting.

The unit of m easure status, either Active or Inactive. Note that

you cannot delete a unit of m easure if there are assets or asset
entries that use it. In those cases you will instead m ake the unit
of m easure inactive to prevent its further use.

The default num ber of dec imal digits (digits to the right of the
decim al point) to allow when entering quantities using this unit

of m easure. This value is used when editing assets: whenever a

new selection is m ade for an asset's unitof m  easure the asset's
decim al digits value will be set to this default value. A value of 0
(zero) m eans only whole num  bers can be entered.
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Managing Expense Sheets

Employees can be given perm  ission to m anage other em ployee's Expense Sheets. A

manager can view, edit and even delete Expense Sheets, depending upon their perm ission
level. Any em ployee whose Permission Level allows expense sheetm  anagem ent (for
exam ple Adm inistrator or Manager) can m anage Expense Sheets and will see the Expense

Sheets tab. If you do not see the Expense Sheets tab then you have not been given a
Permission Level with expense sheet m anagem ent perm issions. You can check an
employee's Perm ission Level from the Employees tab.

If the em ployee's perm ission level allows only lim  ited expense sheet m anagem ent then the

employee will need to be added to the perm ission list for one orm  ore em ployee groups.
This ¢ an be done by clicking the Groups link under the Em  ployees tab, then clicking one of
the groups in the list. In the Permissions  section for the group click the Edit button and
add the em ployee to the perm ission list with the appropriate perm ission level. The  Groups

topic has m ore inform ation.

Note: You can use expense sheet m anagem ent perm issions to create " expense keepers"
employees with the ability to enter expenses for other em ployees. This avoids the need to

log in as another user in order to fill out their expense sheet. In im plem enting expense
keepers itis recom mended that you ¢ reate a new Perm ission Level with only the m  inim um
required expense sheet perm  issions such as m anage, edit and create. The Permission
Levels topic has m ore inform ation.

Expense sheet Lookup

To list em ployee Expense Sheets click the Expenses tab, navigate to Expense Sheets, enter
an appropriate  Start date, then clickthe ~ Search button. You can optionally enter a Finish
date and Status in order to narrow down the list of returned Expense Sheets.

If you do not find any Expense Sheets then you m ay have only lim ited expense sheet
managem ent perm issions. As m entioned above, you m  ay need to be added to the
perm ission list for one orm  ore em ployee groups.

Clickinga Time Period link in the list will load that em ployee's expense sheet. D  epending
upon your perm ission level, you m ay be able to edit or even delete this expense sheet.

Exporting Expense Sheets

If your perm ission level allows it you can export the list of Expense Sheets by clicking the

tools button in the upper right of the list and then clicking the Export List  link. This will
export the expense sheet status inform ation as displayed in the list to your local com puter,
in com ma-separated value (CSV) form  at. This file can then be opened in Microsoft Excel or

other applications that support the CSV form at. You can optionally change this to Microsoft
Excel's native form at (XLS) by ¢ licking the Preferences link on the Hom e tab.

Clicking the Export link will download the expense entries for each expense sheet in the list

as a file that you can save on your local com puter. This is useful for exporting expense

entries to external system s such as Payroll or Accounting applications. You can optionally

mark expense entries as being exported, so that you can avoid re-exporting the sam e data.

Expense Entry Corrections

Once an expense sheet has been m arked as exported it cannot be unsubm itted (unlocked)
for re-editing. You will need to m ake corrections to the expense sheet by clicking on the

tools button and then View Expenses in order to view and m anage expense entries. You can
searc h for any expense entries by setting the param eters of the expense entries in search.
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These can include em ployee, date range, project, etc. You can view already-exported and
proc essed expense entries and create correction expense entries as follows:

1.Click into the expense entry you intend to correct.
2.Clone the entry by clicking on the clone button.

3.Edit the cloned entry to create a negative entry. If the entry is a m ileage entry, change
the quantity entry to negative, or if the entry is an expense am ount entry, change
the am ount value to negative.

4.Clone and edit the entry again and m odify it to create the correct positive value of the

correction entry.
5.Subm it and approve the pair of correction entries so they are ready to exported and
processed.

This is a safeguard to avoid m odifying previously exported tim e entries.

Note that adm inistrators (those with the " Can Manage All' expense sheet perm ission) can
bypass this restric  tion and still unsubm it a previously exported expense sheet, if the need
arises.

Another option for getting access to expense sheet data is to run a Expense Details report.
This report can be ¢ ustom ized to only output the fields you require, and can be downloaded
inanum ber of form ats, inc luding Microsoft Excel. The  Reports topic has m ore inform ation.

Importing Expense Sheet Data

If your perm ission level allows you toim  port expense data by clicking tools button in the

upper right of the list and then clicking the Import link. The Im porting/Exporting _ topic has
more inform ation generally on how im  port/export utilities work, inc luding auto-im  port and
auto-export features. Im porting expense data has a few im portant features worth noting:

1.You can prepare and expense im  port data filetoim  port credit card data directly into

the system
2.You should prepare this file to group expense entries to list entries by em ployee first
and entry date second. You can have m ultiple groupings of expense entries grouped

by em ployee then date.

3.When you im port these expense entries each expense entry will be assigned an
auto-generated Expense Sheet ID for each em ployee. The series of expense entries
imported will be grouped into a unique expense sheet using this unique expense
sheet ID .

Printing Expense Sheets

The 'Print List' option in tools m enu in the upper right corner of the expense sheet list allows
you to download a printable hard copy sum mary list report of all of the Expense Sheets in
the list. You ¢ an also printout m  ultiple Expense Sheets for signing, for instance, by clicking
on the Print Expense Sheets button. Note that, rather than printing the entire list, you can

print selected Expense Sheets by clicking the checkbox on each row before selecting the

'Print' option.

You can also print individual Expense Sheets by ¢ licking into an individual expense sheet the
tim e period link in the expense sheet list, then clicking the 'Print’ view button in the

upper-right ¢ orner of the expense sheet. This will download a printable version of the

expense sheet suitable for printing.
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Expense Entries

Expense entries track the am ount other im  portant details of an expense item within an
expense sheet or report. For exam ple, you m ight have an expense entry of a m eal (the
expense type) that took place on Monday 3/28 (the date). You can control the specific fields

that are entered recorded against eac h expense item by clicking the Options link under the
More Menu (triangle button) in the upper-right corner of the Expense Sheets list.

Note: You can enable sheet support on any asset type. See the Asset Types help topic for
more inform ation.

Expense entries can have the following entry fields:

Property Description

Date The date of the entry. This is the date the expense was used,
for instanc e. This field is required.

Entry ID A unique ID for identifying this entry. If the field is not entered
by the em ployee then a value is autom  atically generated. You
can control the form  atting of this by editing the ID form at on
the Expense Types page. See the Asset Types topic form ore
inform ation.

Expense Item The expense item associated with this entry. The selected
expense type will be used by users to record:

x The am ount that the expense costs. Where the expense item
does not have a unitam  ount (unit cost) set in its profile,
users are only required to enter the expense item am ount,
and not enter values for quantity or unit am ount.

x The quantity of the expense item and the unitof m  easure
for a quantity field where the expense item requires
recording the quantity, such as m iles. The expense item  can
have a fixed unitam ount, such as unitam ountperm ile for a
mileage expense item . In this case, the am  ount will be a
calculated value (quantity X unit am ount= amount).

X The num ber of digits to the right of the decim al point that
can be entered for the quantity field.

X The currency for an expense item unitam ount can be set
when m ulti-currency is enabled.

x The unitam ount can be set as a “fixed” or “editable by
employee.” This ¢ an be used whenyoum ight have m ultiple
fixed rate expense item  s. In the case of a “Mileage USA,”
you could set the unitam  ount to a fixed rate of .54 USD . For
“Mileage Canada” you could set the unit am ount of a fixed
rate of .56 CAD

Quantity Quantity is used for certain expense item s that require
capturing a quantity, such as the num ber of m iles. You can
setup m ultiple expense types for m iles to reflect different
reim bursem ent rates that will be m ultiplied tim es the quantity
entered. For exam ple, #Miles USA would be have a different
unitam ount (per m ile) than #Miles UK.
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Description

Unit Am ount
Amount

Currency

Billable

Unit Bill Am ount

Bill Am ount

Reimbursable

Reimbursement
Amount

Reimbursement
Currency

Exchange R ate

A description for this entry, up to 255 characters. For larger text
input you can also use the Notes field.

The unit am ount (cost) of an expense entry.
The total am ount of an expense entry (quantity X unit am ount)

Currency is the selected by the em ployee to designate the
currenc y of the expense am  ount where the cost was incurred.
The currency can only be edited if multi-c_urrency is enabled.

A chec kbox field that indicates whether this expense entry is

billable or not. If the expense entry is not billable then the Unit

Bill Am ount and Bill Am ount values will be autom  atically set to
zero.

The unit billam ount of an expense entry that will be used to
calculate the billam  ount billed to a custom  er.

The total billam ount for this entry, com  puted as the quantity
tim es the unit billam  ount. Billam ount is what you charge for
this expense, as opposed to am  ount(cost), which is what you
pay for this expense.

Note that you can optionally allow this value to be overridden if

you m ake this field editable (see the Asset Entry Fields topic for
more inform ation). If this value is overridden then a new unit

billam ount will be com puted for the entry as the total bill

amount divided by the quantity.

Note that both Unit Bill Am ount and Bill Am ount will be
autom atically set to zero if the B illable checkbox is present and
not check ed.

A chec kbox field that indicates whether the em ployee associated
with this expense entry should be reim bursed for the cost. You
need to have the Reim  bursable field configured as an entry field

in order to see the Total Reim bursem ent value of an expense
sheet.

Reimbursem ent am ount is the am ountin the reim  bursem ent
currenc y that will be reim  bursed to an em ployee in the

reim bursem ent currency. The reim  bursem ent am ount can be
overridden by an em ployee. The Reim bursem ent Am ount field
shows up autom atically in the Entry D etails dialog if the
Reimbursable field is present.

Reimbursem ent currency is designated by the em ployee in the
Expense Sheet and is used to convert an expense am ount from
and expense currenc yinto areim bursem ent currency. For
exam ple, an airfare expense that is incurred in USD (the
expense ¢ urrency) m ight be converted into CAD  (the

reim bursem ent currency). The Reim  bursem ent Currency can
only be edited if the Reim  bursable field is present, and
multi-c_urrency is enabled.

The exchange rate that converts the expense am ount into a
reim bursem ent am ount. Exc hange rate ¢ an be overridden by an
employee. The Exc hange Rate field shows up autom atically in
the Entry D etails dialog if the Reim  bursable field is present, and
multi-c_urrency is enabled.
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Notes

Employee

Reporting G roup

Custom er/Project/Task

Custom Fields

Notes for this entry, up to 4,000 characters (2,000 for Oracle

databases). Use this for longer inform ation about the entry, as
opposed to the description field, which has a lim it of 255
characters.

The em ployee to associate with this entry. By default it is set to
the em ployee who created the entry.

Note that you can optionally allow this value to be overridden if
you m ake this field editable (see the Asset Entry Fields topic for
more inform ation).

The group to associate with this entry. B y default it is set to the
reporting group of the em  ployee who created the entry.

Reporting G roup is aterm inology item and can be changed to
"Cost Center”, "D epartm ent”,” Crew", etc. The Term inology topic
has m ore inform ation.

Note that you can optionally allow this value to be overridden if
you m ake this field editable (see the Asset Entry Fields topic for
more inform ation).

You can enter a value for the work breakdown structure (WB S)
for this entry. For m  ore inform ation on see the  Work Breakdown

Structure topic.

Note that you can have the em ployee inputas m any or as few
of the WBS levels as you like by editing which fields are allowed
for entry (see the  Asset Entry Fields topic for m ore inform ation).

You can have any num  ber of custom fields that can be entered

by the em ployee for an expense entry. To add new custom fields
select Options on the More m  enu, and then Entry Fields:

Configure Entry Fields (see the Custom Fields topic form ore
inform ation).
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Multi-Currency

Multi-c urrenc y allows em ployees to enter expense entry am ounts in the local currency.

Enabling Multi-Currency

To enable m ulti-currency for expenses, assets or other entry types, you need to do
following:

1. Goto Adm in> System >System Options and edit. Enable the currencies you want to
use in your system  from a currency picklist.

2. Gotothe m ain enabled Expense/Asset page, navigate to the tools button, and click
into and edit the Expense/Asset type for which you want to enable m ulti-currency.
Next to the Multi-Currency Enabled heading, check “Yes - Allow users to choose
currenc y for entered am ounts.”

How Multi-Currency Works

Once enabled, the system  autom atically fetches and records the exchange rates and
amounts between:

-The original expense am  ount
-The reim bursem ent am ount, and
-The system base currency am ount.

In the following exam  ple rec orded on June 21, 2016, the data for an airfare expense is
recorded where the expense entry currency is CAD , the reim bursem ent currency is G BP,
and the system ’s base currency is USD

Currency T ype Description
Expense Local Currency Expense Type = Airfare
Expense Local Currency =  USD
Expense Am ount= CAD547.00
Reimbursem ent Currenc y Expense Type = Airfare
Reimbursem ent Currenc y = GBP
Reimbursem ent Currency Exchange Rate = 0.531140
Reimbursem ent Am ount = GBP290.53
Base Currency Expense Type = Airfare

Base Currenc y= USD
Base Currenc y Exchange Rate = 0.782920 CAD /USD
Base Currenc y Am ount = USD428.26

Once enabled, there will be several specific m ulti-currency fields that will be m ade available
that will be used with other related fields in the system . The m ulti-currency fields are
marked below with an asterisk (*).

Expense ltem Currency*

The Expense Item Currency field will be enabled with a pick list of your enabled currency

p69



© 2000-2021, Pacific Timesheet

values. Users will set the expense item currency value to the local currency where the
expense was incurred. Thisc  urrency value will then be used to convert the expense item
amount to the reim  bursem ent currency am ount.

Reimburse Amount*

The Reimburse Amount field shows the system  -calculated reim bursem ent am ount for this
expense entry. You can override this am ount by selecting the Override check box. This field
should be setup to appear in the details of the expense entry tem plate.

Exchange R ate*

The Exchange R ate field shows the system  -calculated exchange rate for this expense
entry. You c an override thisam ount by selecting the Override check box. This field should
be setup to appear in the details of the expense entry tem plate.

Expense Amount

The Amount field is the am ount of the expense entry. This am ount m ust always be paired
with a selected expense currency for m ulti-currency purposes.

Reimbursable
The reimbursable field, whic h can be used in non-m ulti-currency m ode, is a check box that

flags the expense entry as reim bursable, and m ust be checked by the user to include an
expense entry in the reim bursem ent am ount.
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Employees
You need to create an em  ployee account for each user that needs to record tim e or log into
Pacific Tim esheet . Em ployee acc ounts are where you specify the login nam e, em ail address,

tim esheet tem plate and other properties.

Note: You can change the term inology for 'Em ployee' to suit your organization's needs.
The Term inology topic has m ore inform ation.

Employee acc ounts have the following properties:

Property
Login Name

Password

First Nam e

Last Nam e

ID

Status

Description

The em ployee login nam e. This is required, and m  ust be a unique value
up to 80 characters. The login nam e is NOT case-sensitive.

Note: If you are integrating with an LD AP server or an Active D irectory
server then you will want this value to m atch the login nam e used for
those accounts. See the  Security help topic for m ore details.

The em ployee password, up to 40 characters. The password IS
case-sensitive. The com  plexity of the password is controlled by

application's security settings. See the Security help topic form ore
details.
Note: If you are integrating with an LD AP server or an Active D  irectory

server then the em  ployee will use the password configured in those
accounts. See the  Security help topic for m ore details.

The em ployee's first nam e, up to 80 characters.

The em ployee's last nam e. This field is required and can be up to 80
characters.

The em ployee ID, upto 80 ¢  haracters. This value is not required, but if
avalue is entered it m  ust be unique for allem  ployees. The value here
is c ommonly used when synchronizing with external system s such as
payroll proc essing.

The em ployee status, either  Active , Inactive or Locked .

Note: Accounts can becom e autom atically locked aftertoom  any
unsucc essful login attem  pts in a short period of tim e. See the Security
help topic for m ore detalils.

Note: Locked or inactive em  ployee accounts are not counted when

checking your Pacific Tim esheet license to see if you have reached your
maxim um num ber of em ployee accounts. You can have as m any Locked
or Inac tive em ployees as you require. For instance, when an em ployee
leaves the com pany you will generally just change their status to

Inac tive so that you ¢ an retain their historical inform ation, rather than
deleting the em ployee account.
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First D ay

Last D ay

Last Login

The first day of em  ploym ent. Specifying a value can be im portant for
several reasons:

- The em ployee will not be allowed to enter tim e for dates prior to their
First Day value.

- The em ployee will not be allowed to subm it leave requests for dates
prior to their FirstD  ay value.

- This value will affect balance accruals that vary based on the years
employed (see the Balanc e and Accrual R ules topic form ore
inform ation).

The last day of em ploym ent. The em ployee will not be allowed to enter
tim e for dates after to this date. It is good practice to set this value
when inac tivating an em ployee.

This is a read-only field showing the date and tim e of the em ployee's
last successful login.
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Photograph An optional em ployee photograph. Supported form ats are PNG , GIF and
JPG, and itis recom mended the im age be square and approxim  ately
180x180 pixels. You can spec  ify anim age up to 500x500 pixels, but it
will be scaled to 180x180 in web pages. Also, the file size m ust be no
greater than 48K bytes. Note that setting the photograph results in a
copy of it being stored in the application database, so you do not have

to m aintain the photograph in the sam e location that you used when
uploading it.
You can bulk set em ployee photographs by using an auto-im port file.

You can upload all of your em  ployee photograph files to an FTP site,
then send an em ployee CSYV file with two colum ns as the following
exam ple shows:

Login Name,Photograph
employeel,empl-photo.jpg
employee2,emp2-photo.jpg

When the auto im  port directory is scanned and the CSV file is read, it

will look for each photograph file in the sam e directory as the CSV file
and set the user's photograph. You can optionally put the photographs

in a subdirectory, e.g.

Login Name,Photograph
employeel,photos/empl-photo.jpg
employee2,photos/emp2-photo.jpg

When the CSV file is proc  essed it will look for files in the "photos"
subdirectory within the directory containing the CSV file.

Alternatively, if you have an existing repository of photographs you can
use URLs for the Photograph field values in the im port file, e.g.

Login Name,Photograph
employeel, http://xyz.com/images/photol.jpg
employee?2,ftp://xyz.com/pub/foto2.gif

Supported URL form ats for the Photograph field in the im port file are
HTTP, HTTPS and FTP. Another advantage of using a URL is that you

can m anually im port the file via the web interface, rather than using

the auto-im port directory. N ote that setting the photograph results in a
copy of it being stored in the application database, so you do not have

to m aintain the photograph in the sam e location that you used when
importing it.
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Permission Level

Employee Type

Policy

Job Title
Reporting G roup

Default Bill Rate

Default Pay R ate

The perm ission level determ ines the m axim um perm issions an
employee has for the applic  ation. The exact perm issions m ay depend

upon whic h objects a user is assigned to, and the perm ission level they
have for that object. For exam ple, an em ployee m ay be given a default
perm ission level of Manager, but will not be able to m anage a project

unless they are assigned to it and given the role of Manager for that
project.

When editing an em  ployee, the list of perm ission levels will be lim  ited
to only ac tive perm ission levels. This list will be further lim ited
depending upon the default perm ission level of the logged-in user. For
instance, an Adm inistrator will see the full list of active perm ission
levels, whereas a Manager will not see the Adm inistrator role as it is
considered to have a higher security level.

For m ore inform ation on perm ission levels see the  Security help topic.

The type of em ployee, for exam ple Non-exem pt, Exem pt, H ourly,
Salaried, etc . This property is essentially a label used for categorizing
your various types em  ployees. The list of em ployee types can be
custom ized from the Employees > Employee Types page, available
under the More m enu on the Em ployees page.

The polic y for this em ployee. Policies are sets of rules affecting tim e
entry, leave balanc es, overtim e handling, etc. andare m  anaged from
the Palicies page under the System  tab.

The optional job title for this em ployee, up to 80 characters.

The prim ary or reporting group for this user. This group will be the

default group associated with em ployee's tim e and asset entries. For
instance, whenever an em  ployee saves theirtim  esheet, the em ployee's
current reporting group value will be stored with each tim e entry.

Note: Reporting Group can be thought of as D ivision, Cost Center,
Charge Code, etc. depending upon your organization. You can renam e
'‘Reporting G roup' from the Term inology page under the System  tab.

The default bill rate. The rate can be specified as either a nam ed rate or
a custom num eric value. Nam ed rates are configured from the Rate
Options page. The current bill rate, if non-zero, is used when a

tim esheet is saved to ¢ ompute the billam ount for each tim e entry.

The default pay rate. The rate can be specified as either a nam ed rate
or a custom num eric value. Nam ed rates are configured from the Rate
Options page. The current pay rate, if non-zero, is used when a

tim esheet is saved to com  pute the pay am ount for each tim e entry.
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Salary

Scheduled Work
Days

Scheduled Hours

The annual salary for non-hourly em ployees. The salary, if non-zero, is
used to com pute an effective pay rate when a tim esheet is subm itted.
You should therefore only specify a pay rate or a salary, not both. If

both are specified the pay rate is used and the salary ignored.

Note that the effective pay rate is based on the total hours for the

tim esheet period. Since the total hours is only accurate when the

tim esheet is subm itted, the effective pay rate is not com puted until the
tim esheet is subm itted. You can also have the effective pay rate

com puted before a subm it by spec ifying the 'Scheduled Hours' property.
Then, when atim esheet is saved (but not subm itted) the scheduled
hours will be used instead of the total hours on the tim esheet to give
an approxim ate effective pay rate. Once the tim esheet is subm itted,
however, the total hours will be used to give an accurate effective pay

rate.

The days of the week the em ployee is scheduled to work, for exam ple
Monday-Friday. Specifying a value can be im portant for several
reasons:

- Holidays, when autom  atically added to tim  esheets, will only put hours
on days m arked as a work day. See the Schedule Rules topic form ore
inform ation.

- Leave requests, when added to tim esheets after approval, will only
put hours on days m arked as a work day. See the Schedule Rules topic
for m ore inform ation.

- Tim e entry rules that require a m inim um num ber of hours each work
day will only ¢ heckondays m arked as a work day. See the Time Entry
Rules topic for m ore inform ation.

The num ber of hours the em  ployee is scheduled to work each week and
each work day. The scheduled hours values affect the following areas of
the system :

- When leave requests and holidays are autom atically added to the
employee's tim esheetthe Scheduled Hours Per Day will be used to
determ ine how m any hours to put on the tim esheet. If no value is
specified, the Hours Per D ay property on the System > General page is
used. See the Schedule Rules help topic for m ore inform ation on how
holidays and leave requests can be configured to be autom atically
added to tim esheets.

- The sc heduled hours value is used when displaying how m any days of
balanc e are available on the em  ployee's hom e page. If no value is
specified, the Hours Per D ay property on the System > General page is
used.

- Percent Tim e Entry tim esheets need the Scheduled Hours Per
Week value in order to convert percentages to hours. See the
Tem plates topic for m ore inform ation ontim esheettem plates.
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Scheduled Start

Scheduled Finish

Email
Phone
Mobile
Fax

Tim esheet
Tem plate

The tim e of day the em ployee is scheduled to start work or "punch in".
The scheduled starttim e affects the following areas of the system

- Em ployee lateness is determ  ined based on the scheduled start value,
and can trigger the sending of an em ail notice. Seethe  Notices topic for
inform ation about sending late em ail notices.

- When adding a new row to an attendance tim esheet (one that has
start and finish tim  es) the starttim e will default to the em  ployee's
scheduled starttim e.

- If you ¢ onfigure rounding rules to round punches to the scheduled

start tim e then you will need to specify the em ployee's scheduled start
tim e. See the sec tiononroundinginthe  Time Entry Rules help topic for
more inform ation.

- If you are keeping track of absence points you will need to specify the
scheduled starttim e. See the Absence Points R ules help topic form ore
inform ation.

The tim e of day the em ployee is scheduled to finish work or " punch
out". The scheduled finish tim e affects the following areas of the
system :

- If you ¢ onfigure rounding rules to round punches to the scheduled

finish tim e then you will need to specify the em ployee's scheduled
finish tim e. See the section on rounding in the Time Entry Rules help
topic for m ore inform ation.

- If you are keeping track of absence points you will need to specify the
scheduled finish tim  e. See the Absence Points R ules help topic for m ore
inform ation.

The em ail address, up to 80 characters.

The phone num ber, up to 40 characters.

The m obile phone num ber, up to 40 characters.
The fax num ber, up to 40 characters.

The tim esheet tem plate for thisem ployee. D ifferent em ployees can
have different tim esheet tem plates, for exam ple hourly workersm  ay

use a tem plate that has fields for tracking their in and out tim es on
specific tasks, whereas salaried workers m ight use atem plate that only
requires trac king the total hours spent on each task. Tim esheet

tem plates are m anaged from the Tem plates page under the System
tab.

A blank value is allowed for the tim esheet tem plate, but the em ployee
will not get a "My Tim  esheet" tab when they log in to the application.

This m ay be desired in som e cases, such as for an adm inistrative
account, or an em ployee who needs to log into the application to review

and run reports on other em ployee's tim esheets, but does not need
record their own tim  e.
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Tim esheet
Memory

Hours Form at

Locale

Time Zone

New tim esheets are created at m  idnight of the start of every new tim e
period. The tim esheet m emory setting allows you to specify whether

rows and hours are carried forward from the previous tim  esheet period
when the new tim  esheet is created. Thiscanm  ake it easier for your
employees to track their tim e if they com monly work on the sam e tasks
as appropriate rows will already be on the tim esheet.

The following tim  esheet m emory options are available:

None New tim esheets will be blank: no rows or hours will
be c arried forward from  the previous tim e period.
Note that even if no rows or hours are carried
forward from the previous period, the application
will still keep track of recently used projects, tasks,
materials, etc. in order to facilitate data entry.

Rows New tim esheets will have the sam e rows as the
tim esheet for the previous period, but all hours
fields will be blank. This is the default value for
employees.

Rows and Hours | New tim esheets will have the sam e rows and hours
as the tim esheet for the previous period. Only work
hours are carried forward - leave (or paid tim e off)

rows will carry forward, but not the hours.

Regardless of the tim  esheet m emory setting, em ployees can m anually
copy a previous tim  esheet via an option in the Tools m enu on their

tim esheet. You can hide this option from em ployees by turning off the
"Can c opy previous tim esheet hours" tim  esheet perm ission for the
employee's perm ission level. See the  Permission Levels topic form ore
inform ation.

The choice of how the em  ployee enters hours, either decim al form at
(for exam ple 7.50) or hours:m inutes (for exam ple 7:30).

Note: This setting does not affect the tim e form at - whether a 12 or 24
hour clock is used is determ  ined by the em ployee's locale setting.

The locale is a geographic  /language region that determ ines the

following:

X The language displayed, e.g. English, French, Spanish, etc.

X The form atting of dates and tim  es. N ote that in locations that use
12 hour tim e (e.g. the United States) you can optionally override
the loc ale preference and use 24 hour tim e. The em ployee can
change this on theirH ome > Preferences page.

X The form atting of num bers

X The list of com pany holidays for the selected location. H olidays can
be c onfigured to only apply to em ployees in specific tim e zones. See
the Holidays help topic for m ore inform ation.

Note: The application will always assum e the em ployee is in this locale,
rather than pick up the locale from the browser, for instance.

The em ployee's tim e zone. When tim esheet data is saved it will be
relative to thistim e zone.

Note: The application will always assum e the em ployee isin thistim e
zone, rather than pick up the tim e zone from the browser, for instance.
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Approver This is the prim ary approver for the em  ployee. A prim ary approver can
review and approve or rejec  tthis em ployee's tim e entries and leave
requests (depending upon the approver's perm ission level).

Primary approvers can also receive em ail rem inders and notices when
there are tim esheets or requests that need approving, or when

employees are late subm itting their tim e. See the Notices help topic for
more inform ation.

Note: Only em ployees with perm ission to approve will appear in the list
of possible approvers. If you do not see an em ployee in the list then
youm ay need to ¢ hange that em ployee's perm ission level, or enable
the appropriate approval perm ission for their perm  ission level. See the
Security help topic for m ore inform ation.

Approver Backup This is the bac kup approver for thisem  ployee. The backup approver has
the sam e c apabilities as the prim  ary approver, but will not receive the
approval em ail notic es that are sent to the prim ary approver. Itis a
good idea to assign a backup approver for tim es when the prim  ary
approver is away or otherwise unavailable.

Notes

Clicking the Notes disclosure triangle allows you to review and enter notes about the
employee (up to 2000 characters).

Current Balances

Clicking the Current Balances disc  losure triangle shows the list of current balances for the
employee. You can editem  ployee balances by clicking the current balance link. The
Employee Balances topic has m ore inform ation. Note that em  ployee balances cannot be
edited unless your Perm ission Level has the "Can edit advanced properties" Employee
perm ission ¢ hecked.

Group Membership

Clicking the G roup Mem bership disclosure triangle shows the list of groups the em ployee is
amember of. The Employee G roups topic has m ore inform ation about m anaging groups.

Calendar

Clicking the Calendar disc  losure triangle shows the em ployee's calendar of holidays, leave
requests and other events.

Importing/Exporting Employees

You can im port and export em  ployee data using CSV (Com  ma Separated Values) form  at
files from the Em ployees tab. When im  porting data a good way to start is to do an export

first - this will generate a file you can use as a tem plate. Once you m odify this file
(including rem oving unnecessary colum  ns) to have your new data you can then im port it
back into the application. See the Employee CSV Form at help topic for m ore inform ation on

the im port file form  at.

Note: The default form  atis CSV but you can change this from the Hom e > Preferences
page.

Importing/Exporting Employee Balances

You can im port and export em  ployee balance data using CSV (Com ma Separated Values)
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form at files from the Em ployees tab. When im  porting data a good way to start is to do an

export first - this will generate a file you can use as a tem plate. Once you m odify this file
(including rem oving unnecessary colum  ns) to have your new data you can then im port it
back into the application. See the Employee Balances CSV Form _at help topic form ore
inform ation on the im  port file form at.

Note: The default form  atis CSV but you can change this from the Hom e > Preferences
page.

Custom Fields

Like all m ajor objects in the application, you can custom ize them by creating new fields.
Choosing the 'Manage Custom Fields' option onthe Em  ployees tab will let you create a
variety of new fields or properties specific to your needs.

Related Topics

X Employee Balances
X Employee G roups
X Rate Options
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Employee Balances

Employee balances are banks of hours that em ployees can accrue and use on their

tim esheets, suc h as Vacation, Sick or Flex-tim  e. B alances are associated with leave pay
codes: for instance if you have a Vacation pay code you can optionally have a Vacation

balance (see the Pay Codes topic has m oreinform ation). Each balance can have its own set

of rules for how hours are accrued and how situations such as when the em ployee's balance
goes negative are handled. See the Balanc e and Accrual R ules help topic for m ore
inform ation.

You can update an em ployee's balance from the Employee D etails page by clicking the
Current Balances disclosure triangle, which shows the em ployee's balances as of the
current date. Clicking on the ¢ urrent balance link will load the Balance History page. The
Balanc e History page lists all changes m ade to the balance: the actual balance for any given
date is sim ply the total of all the balance changes up to that date. If you have appropriate

perm issions you can m odify the balance by adding, deducting or setting the balance for a

given date.

Note: In order to change an em ployee's balance you m ust have the 'Can edit advanced
properties' Em ployee perm ission. In addition, for security purposes, you can only delete
balanc e c hanges that you m ade. Only adm inistrators (those with the ‘Can m anage all
Employee perm ission) can delete balance changes m ade by others.

Making Bulk Changes To Employee Balances

If you need to update balances for a num ber of em ployees you canim port the list of
changes using an im  port file. When im  porting data a good way to start is to export the

current em ployee balanc es via the Export Em  ployee B alances option on the Em  ployees tab -
this will generate a file you can use as a tem plate. Once you m odify this file (including

rem oving unnec essary colum ns) to have your new data you can then im port it back into the
application. The Managing Em ployees topic has m ore inform ation.
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Employee Groups

Employee G roups are lists of em  ployees, and can be used for several purposes. You can

create em ployee groups that represent cost centers or divisions, for instance. These can

then be assigned to the appropriate em ployees as their Reporting Group (see the
Managing Em ployees help topic for m ore inform ation). In addition, groups are used by

Pacific Tim esheet for m anaging applic ation perm issions. For instance, rather than assigning
managers to spec ific em ployees you give the m  anager perm ission for a specific em ployee
group (the Security help topic has m ore inform ation about configuring perm issions).

Employee groups have the following properties:

Property Description

Name The group nam e, up to 80 ¢ haracters. A value is required and m ust be
unique for all groups.

Description A description for the group, up to 255 characters.

ID The group ID , up to 80 characters. This value is not required, but if a
value is entered it m  ust be unique for all groups. The value here is
com monly used when synchronizing with external system s such as
payroll proc essing.

Status The group status, either Active or Inactive. You can delete a group, but

often it is preferable to change its status to Inactive. This will keep it
from being used for new data entry, but allow it to be reported on for
historical purposes.

Type The group type allows you to control whether this groups shows up in
lists or pickers on various parts of the application:

X Permission groups are used to provide fine-grained control of
application security. For instance, you m ight create a Tim  ekeeper
group thatis ¢ omposed of users who entertim e for other em ployees.
All groups are always perm ission groups, regardless of whether they
are also used as reporting groups or crews.

X Reporting groups are groups that are assigned to em ployees in their
profile or properties page, and serve as the em ployee's current cost
center or departm ent (you ¢ anrenam e theterm "reporting group” as
appropriate for your organization from the System > General >
Term inology page). The reporting group value is autom atically
recorded when an em ployee saves their tim e, m aking it easy to do
departm ental or ¢ ost ¢ enter reporting and costing. Enabling the
reporting group chec  kbox will allow the group to be selected on the
em ployee properties page, as well as on the tim esheet if the group
field is configured for the tim esheettem plate.

X Crews are groups of em  ployees that can have their tim e recorded for
them by m anagers or tim ekeepers using the Crew Tim  esheet page.
Enabling the ¢ rew checkbox will allow the group to be selected on the
Crew Tim esheet page (as well as the Crew Approval K iosk).

Notes

Clicking the Notes disclosure triangle allows you to review and enter notes about the group
(up to 2000 characters).

Employees
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Clicking the Em ployees disclosure triangle allows you to review and edit the list of

em ployees belonging to this group. An em ployee can be inm ore than one group at the
sametim e. If youwanttoc  heckifanem ployee belongstom ore than one group you can
view their group m  embership on the specific  em ployee's properties page.

Permissions

Clicking the Perm issions disclosure triangle allows you to review and edit which em ployees
or em ployee groups have been given special perm issions for this group. Typically you would
use this to assign anem  ployee m anager (som eone with 'Can m anage lim ited' Em ployee
perm ission) to this group in order to review and edit tim e or asset entries forem  ployees
who are m embers of this group. See the Security help topic for m ore inform ation.

Importing/Exporting Groups

You can im port and export group data using CSV (Com ma Separated Values) form  at files
from the Em ployees > Groups page. When im  porting data a good way to start is to do an

export first - this will generate a file you can use as a tem plate. Once you m odify this file
(including rem oving unnecessary colum  ns) to have your new data you can then im port it
back into the application. See the Group CSV Form at help topic for m ore inform ation on the
import file form  at.

Note: The default form  atis CSV but you can change this from the Hom e > Preferences
page.

Custom Fields
Like all m ajor objects in the application, you can custom ize them by creating new fields.

Choosing the 'Manage Custom Fields' option on the Em  ployees > Groups page will let you
create a variety of new fields or properties specific to your needs.
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Employee Options

The Em ployee Options page allows adm inistrators to configure various em ployee settings,
suc h as which fields are required to be entered when editing em ployees, etc.
Note: Em ployee options are global settings that will affect all users. Only adm inistrators

will have access to the Em  ployee Options page.

Note: The term inology of em ployees, groups and other objects can be changed via the
System > General > Term inology page.

Required Fields

You can specify which fields are required when adding or editing em ployees. By default
fields such as login nam e, last nam e, etc. are required, but for your use you m ay need
additional fields m arked as required, suc h as the em ployee ID .

Employee Types

An Em ployee Type is an em ployee property that you define as a way to differentiate

different categories of em  ployees, for exam ple "Exem pt" and "Nonexem pt", or "Salaried"
and "Hourly". You can define any num ber of em ployee types. Em ployee types have the
following properties:

Property Description

Label The display nam e of the em ployee type, up to 255 characters. For
exam ple, "Hourly". This is the text shown in the user interface, as
well as in exported data.

Value The internal value for the em ployee type, up to 255 characters. For
exam ple, "hourly". This is the text stored in the database and,
therefore, shown on reports. G enerally you will want to use the sam
value for Label and Value.
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Reports

Pacific Tim esheet supports over 50 different reports. Reports are custom

to:

Alter data sorting

X X X X X

In addition, m  ost reports can be output in HTML, PD

Timesheet Reports

Alter which data ¢

Alter data filtering
Publish your custom

izable, allowing you

olum ns are displayed
Alter the nam es of the data colum ns

ized reports for otherem  ployees to use

F, CSV and Excel form ats.

Report
Employee Hours

Pay Code H ours

Project Group Hours

Project Hours

Description

This report sum marizes tim esheet hours by em ployee. You can
expand this report to further group hours by:

X Pay Code

Project

Project G roup

Reporting G roup

Task

Task G roup

X X X X X

This report sum marizes tim esheet hours by pay code. You can
expand this report to further group hours by:

X Employee
Project

Project G roup
Reporting G roup
Task

Task G roup

X X X X X

This report sum marizes tim esheet hours by project group. You
can expand this report to further group hours by:

X Employee

Pay Code

Project

Reporting G roup
Task

Task G roup

X X X X X

This report sum marizes tim esheet hours by project. You can
expand this report to further group hours by:

X Employee

Pay Code

Project G roup
Reporting G roup
Task

Task G roup

X X X X X
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Reporting G roup Hours

Task G roup Hours

Task Hours

Tim esheet Details

Create Custom
Timesheet Sum mary
Report

Leave R eports

This report sum marizes tim esheet hours by reporting group.
You can expand this report to further group hours by:

X Employee

Pay Code
Project

Project G roup
Task

Task G roup

X X X X X

This report sum marizes tim esheet hours by em
expand this report to further group hours by:

X Employee

Pay Code

Project

Project G roup

Reporting G roup

Task

This report sum marizes tim esheet hours by em
expand this report to further group hours by:
X Employee

Pay Code

Project

Project G roup

Reporting G roup

X Task G roup

X X X X X

X X X X

This report lists tim e entry details for a given date range. As
there are m any tim e entry fields available to report on, you will
probably want to generate a custom version of this report to
show only the inform  ation you are interested in.

If the above tim  esheet sum mary reports do not group the data
in the form at you like you can create your own custom

sum mary report. You can group by up to 5 different objects or
factors, including custom fields.

Report
Employee Leave

Employee Leave D etails

Description
This report sum marizes em ployee leave hours.

This report lists em  ployee leave tim e entries in full detail.

Employee R  eports

Report
Balance Activity

Balanc e Activity D etails

Employee Attendance

Description

This report sum marizes changes to balances (sick, vacation,
etc.) foreach em ployee.

This report lists details of each change to balances (sick,
vacation, etc.) foreachem  ployee.

This report shows em  ployee infouttim  es on a daily basis, as
well as indicating if em  ployees are in com pliance with their
scheduled infout tim  es. Any leave taken is also shown. See the

Employee Attendance R _eport help topic for m ore inform ation.
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Employee D etails

Employee Pay Report

System R eports

This report lists details for each em
num bers, etc.

ployee, such as em ail, phone

This report shows pay data, such as R T/OT etc. hours and pay
amounts, using rates that depend on the type of hours. For

exam ple OT hours can be configured to have a pay rate 1.5

tim es the RT pay rate. This report is a variation of the Profit

Report (see below), and for m ore inform ation see the Profit

Report topic.

Report
Audit Trail

Logins

System Even Log

Description

This report lists audit events for the given date range.

This report lists em  ployee logins (successful and unsuccessful)
for the given date range.

This report lists inform  ation about system  events such as sent

emails, scheduled im ports and exports, etc.

Other Reports

Report
FTE Sum mary Report

Hours Sum mary Report

Profit R eport

Description

This report sum marizes full tim e equivalent (FTE) hours in a
colum nar form at. For m ore inform ation see the FETE Sum mary

Report topic.
This report sum marizes tim esheet hoursinac olum nar form at.
For m ore inform ation see the Hours Sum mary Report

(Colum nar) topic.

This report sum marizes profit/loss based on pay am ounts and
billam ounts. You can custom ize this report to break down the

data by em ployee, project, group, etc. For m ore inform ation see
the Profit R eport topic.

Report Properties

See the Report Properties

Reporting on Archived Data

Older tim e entry and asset entry data will eventually be m

help topic for inform ation on standard report properties.

oved into archival storage. You

can still report on archived data if you need to (e.g. for auditing purposes, etc.) by altering

the report's "Archive Settings"
topic has m ore inform ation on how the system

to target the archived data storage tables. The Data Archival

archives data.
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Standard R eport Properties

When c reating or editing reports you can set the following report properties (not all of the
following properties apply to all reports):

Property
Name

Description

Tem plate

Published

Page Size

Orientation

Reporting Period

Report Colum ns

Sort Colum ns

Description
The report nam e or title, up to 80 characters.

A description for the report, up to 255 characters.

A read-only property that indicates which report was used as the
tem plate for creating this report.

If ¢ hec ked then this report can be run by other em ployees. You can
limit which em ployees ¢ an ac cess a published report by clicking the
button to the right of the check box and selecting the appropriate

perm ission levels.

Publishing a report does not allow others to edit it - only the
em ployee who created the report can subsequently edit it.

The page size for the report. R eports are designed for easy and
accurate printing, and this setting will determ ine how reports are
paginated.

The page orientation for printing, either Portrait or Landscape. For
reports with m any colum ns you will generally want to specify
Landsc ape orientation.

The default tim e period for the report. The reporting period can be
overridden when running the report.

The list of data ¢ olum ns to display on the report. In addition to being
able to add or rem ove any colum ns you like, you can also edit the
colum n heading.

The list of data ¢ olum ns to use for sorting. You can have m ultiple sort
colum ns, and sorting can be ascending or descending.

p87



© 2000-2021, Pacific Timesheet

Subtotal Colum ns You can optionally show subtotals for any of the report colum ns
(exc ept for decim al or float colum ns, as subtotalling for these types of
colum ns would not m ake sense). Subtotals will break up the report
into sec tions with a subtotal for each specified subtotal colum n. You
can have m ultiple subtotal colum nsif needed, butyoum ay only
choose from colum ns that are specified in the R eport Colum ns

property.

As an exam ple, suppose your data looked like this with no subtotal
colum ns specified:

Employee  Project Task RT OT

Johnson, B. P1 T1 8.00 1.50
Johnson, B. P1 T1 8.00 0.00
Johnson, B. P2 T2 8.00 0.00
Johnson, B. P2 T2 8.00 0.00
Swayze, P. P1 T1 8.00 0.00
Swayze, P. P1 T2 8.00 2.00

Total 48.00 3.50

If you specified Em ployee.Nam e as the subtotal field then your report
would look like this:

Employee  Project Task RT OT

Johnson, B. P1 T1 8.00 1.50
Johnson, B. P1 T1 8.00 0.00
Johnson, B. P2 T2 8.00 0.00
Johnson, B. P2 T2 8.00 0.00

Subtotal for Johnson, B.: 32.00 1.50

Swayze, P. P1 T1 8.00 0.00
Swayze, P. P1 T2 8.00 2.00

Subtotal for Swayze, P.: 16.00 2.00

Total 48.00 3.50

If you also wanted to see subtotals for projects you would add the
Project.Nam e colum n to the list of subtotal colum ns.
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Employee Filter

Reporting G roup
Filter
Pay Code Filter

Project Group Filter

Project Filter
Task G roup Filter

Task Filter

If non-em pty then the report will only show data for the Em ployees in
the list. You ¢ an override this value when running the report.

In addition to spec ifying individual em ployees, you can also specify
the following special em  ployee filter values:

Filter Description
(Self) When you add "(Self)" to the Em ployee Filter only
data for the currently logged-in em ployee will be

shown (any other em  ployees in the Em ployee Filter
will be ignored). This is useful for allowing

employees to run reports on only their own tim e
entries.
(Approvees) When you add "(Approvees)" to the Em ployee Filter

only data forem ployees that the currently

logged-in em ployee is an approver of will be shown
(any other em ployees in the Em ployee Filter will be
ignored). This is useful for allowing approvers to

run reports on justem  ployees they can approve.

An approvee is any em  ployee that the logged-in
user is setas a prim  ary approver of in the
employee's profile.

If non-em pty then the report will only show data for the G roups in the
list. You ¢ an override this value when running the report.

If non-em pty then the report will only show data for the Pay Codes in
the list. You ¢ an override this value when running the report.

If non-em pty then the report will only show data for the Project
Groups in the list. You can override this value when running the
report.

If non-em pty then the report will only show data for the Projects in
the list. You ¢ an override this value when running the report.

If non-em pty then the report will only show data for the Task G roups
in the list. You can override this value when running the report.

If non-em pty then the report will only show data for the Tasks in the
list. You ¢ an override this value when running the report.
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Employee Attendance R eport

This report shows em  ployee infout tim  es on a daily basis, as well as indicating if em ployees
are in ¢ ompliance with their sc  heduled infout tim  es. Any leave taken is also shown. N ote
that anyone running this report will only see em ployees they are perm itted to report on
based on their perm issions.

When c reating or editing this report you can set the following properties:

Property
Name

Description

Tem plate

Published

Reporting Period

Report Colum ns

Alerts

Employee Type
Filter

Employee Filter

Reporting G roup
Filter

Description
The report nam e or title, up to 80 characters (required).

A description for the report, up to 255 characters.

A read-only property that indicates which report was used as the
tem plate for creating this report.

If ¢ hec ked then this report can be run by other em ployees. You can
limit which em ployees ¢ an ac cess a published report by clicking the
button to the right of the check box and selecting the appropriate

perm ission levels.

Publishing a report does not allow others to edit it - only the
employee who created the report can subsequently edit it.

The default tim e period for the report. The reporting period can be
overridden when running the report.

Note: Due to the colum  nar nature of the report your date range will
be restricted to 31 days or less.

The list of em ployee properties to display as colum ns on the report.
You can also show additional em  ployee reporting group (or cost
center/departm ent depending on your term inology) properties that
you m ay need to display.

You can optionally have the report com pare em ployee infouttim es
against scheduled tim  es, and display discrepancies in color on the
report.

Use this filter to restrict the report to only em ployees of specific
types, e.g. "Hourly" em  ployees. This acts as a default filter - the filter
can always be changed when running the report.

Use this filter to restrict the report to only specific em ployees. This
acts as a default filter - the filter can always be changed when

running the report. Note that anyone running this report will only see
employees they are perm itted to report on based on their

perm issions.

Use this filter to restrict the report to only em ployees in specific
reporting groups (or ¢ ost centers/departm  ents depending on your
term inology). This acts as a default filter - the filter can always be
changed when running the report. N ote that anyone running this
report will only see reporting groups they are perm itted to report on
based on their perm issions.
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Hours Summary R eport (Columnar)

The Hours Sum mary Report (Colum nar) allows you to sum  marize em ployee hours as a
series of colum ns. Each ¢ olum n represents an interval of tim e, such as m onthly or quarterly.
This is an alternative to the other tim esheet reports that list data in a row-oriented form at.

When c reating or editing this report you can set the following properties:

Property Description

Name The report nam e or title, up to 80 characters (required).
Description A description for the report, up to 255 characters.

Tem plate A read-only property that indicates which report was used as the

tem plate for creating this report.

Published If ¢ hecked then this report can be run by other em ployees. You can
limit which em ployees ¢ an ac cess a published report by clicking the
button to the right of the check box and selecting the appropriate
perm ission levels.

Publishing a report does not allow others to edit it - only the
employee who created the report can subsequently edit it.

Reporting Period The default tim e period for the report. The reporting period can be
overridden when running the report.

Note that, depending on the Report Interval , the actual start and
finish date of the report m ay not m atch the reporting period exactly.
For instanc e, if the reporting period is set to "Today" and the report
interval is "Yearly" then when the report runs it will snap the start

date to Jan 1 and the finish date to D ec 31 of the current year.

Due to the ¢ olum nar nature of the report your date range m ay be
restricted in order to avoid producing too m any colum ns: large

num bers of colum ns can adversely affect the system 's perform ance.
For instanc e, you won't be able to a report with a daily interval for a

year as it would produce 365 colum ns and affect database

perform anc e adversely. You can bypass these lim its by specifying a
report filter, whic  h will reduce the am  ount of data returned. The

report will give youac  lear m essage when you exceed a reporting
period lim it, and indicate to you which filter to set to increase the

limit.

Report Interval The report interval determ ines how the data is grouped into colum ns.
For instanc e, a m onthly interval for a report being run over the
previous year would show 12 colum ns, one for each m onth. Possible
values for the report interval are: Daily , Weekly , Monthly ,

Quarterly and Yearly .

Note that when the report runs it will always snap the start date and

finish date to encom  pass com plete intervals, regardless of the

Reporting Period ¢ hosen. For instance, if the reporting period is set

to "Today" and the report interval is " Yearly" then when the report

runs it will snap the start date to Jan 1 and the finish date to D ec 31
of the current year.
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Report Colum ns

Sum marize

Subm itted Filter

The list of data ¢ olum ns by which to group or sum marize the report

data into rows (required). You can add or rem ove colum ns, and click
and drag to change the colum n order. The list of colum  nsislim ited to
data that can be recorded with tim e entries, such as em ployee and

project values, tim  esheet custom fields, etc. You m ust have at least
one but no m ore than 10 report colum  ns.

Note that the report will autom atically insert subtotal rows in the

report if you select m  ore than one type of colum  n. For instance, if

you have 2 ¢ olum ns, Projec t.Nam e and Em ployee.Nam e, then the
report will insert a subtotal row after each group of projects. If you

have 3 colum ns, Custom er.Nam e, Project.Nam e and Em ployee.N ame,
then the report will insert a subtotal row after each group of projects

and after each group of custom ers.

Choose which tim  esheet hours data you want to total or sum marize
in the report. This can be AllHours , Work Hours  or Leave Hours
If you choose Work Hours or Leave Hours you can optionally lim it the

hours to specific pay codes. For instance, if you choose only Over
Tim e and Double then the hours totalled on the report for each
interval colum n will be ¢ omputed as SUM(Over Tim e + Double Tim e).

Use this filter to restrict the report to only hours for tim esheets that
are Submitted (loc ked), or only hours for tim esheets that are  Open
(unsubm itted). By default all tim esheet data is reported on,

regardless of its subm ission status.

p92



© 2000-2021, Pacific Timesheet

FTE Summary R eport (Full Time Equivalent)

The FTE Sum mary Report allows you to sum marize em ployee hours in full tim e equivalent
employee (FTE) units. The report form ats FTE as a series of colum  ns, where each colum n
represents an interval of tim e, such as m onthly or quarterly.

Using FTE units provides a way to m easure how m any full-tim e em ployees would be
required to perform  the work done in your organization. An FTE is the equivalent of one
person working full tim  e. Consider an em ployee working the following full tim e schedule:

8 hours / day

X 5 day / week

X 52 week / year

= 2,080 hours / year

One em ployee working full tim e would equal 1 FTE. Two people each working 4 hours per

day, 5 days per week would also equal 1 FTE. The FTE Sum mary R eport com putes the FTE
value by totalling the hours for eac h interval and dividing by the appropriate full tim e
equivalent hours. For instance, if the total hours against a project for 1 year was 3,120,

then the FTE would be com  puted as 3,120/ 2,080 = 15.

When c reating or editing this report you can set the following properties:

Property Description

Name The report nam e or title, up to 80 characters (required).
Description A description for the report, up to 255 characters.

Tem plate A read-only property that indicates which report was used as the

tem plate for creating this report.

Published If ¢ hec ked then this report can be run by other em ployees. You can
limit which em ployees ¢ an ac cess a published report by clicking the
button to the right of the check box and selecting the appropriate
perm ission levels.

Publishing a report does not allow others to edit it - only the
employee who created the report can subsequently edit it.

Reporting Period The default tim e period for the report. The reporting period can be
overridden when running the report.

Note that, depending on the Report Interval , the actual start and
finish date of the report m ay not m atch the reporting period exactly.
For instanc e, if the reporting period is set to "Today" and the report
interval is "Yearly" then when the report runs it will snap the start

date to Jan 1 and the finish date to D ec 31 of the current year.

Due to the ¢ olum nar nature of the report your date range m ay be
restricted in order to avoid producing too m any colum ns: large

num bers of colum ns can adversely affect the system 's perform ance.
For instanc e, you won't be able to a report with a daily interval for a

year as it would produce 365 colum ns and affect database

perform anc e adversely. You can bypass these lim its by specifying a
report filter, whic  h will reduce the am  ount of data returned. The

report will give youac lear m essage when you exceed a reporting

period lim it, and indicate to you which filter to set to increase the

limit.
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Report Interval

Report Colum ns

The report interval determ ines how the data is grouped into colum ns.
For instanc e, a m onthly interval for a report being run over the

previous year would show 12 colum ns, one for each m onth. Possible
values for the report interval are: Daily , Weekly , Monthly
Quarterly and Yearly .

Note that when the report runs it will always snap the start date and

finish date to encom  pass com plete intervals, regardless of the

Reporting Period ¢ hosen. For instance, if the reporting period is set

to "Today" and the report interval is " Yearly" then when the report

runs it will snap the start date to Jan 1 and the finish date to D ec 31
of the current year.

The list of data ¢ olum ns by which to group or sum marize the report

data into rows (required). You can add or rem ove colum ns, and click
and drag to change the colum n order. The list of colum  nsislim ited to
data that can be recorded with tim e entries, such as em ployee and

project values, tim  esheet custom fields, etc. You m ust have at least
one but no m ore than 10 report colum  ns.

Note that the report will autom atically insert subtotal rows in the

report if you select m  ore than one type of colum  n. For instance, if

you have 2 ¢ olum ns, Projec t.Nam e and Em ployee.Nam e, then the
report will insert a subtotal row after each group of projects. If you

have 3 colum ns, Custom er.Nam e, Project.Nam e and Em ployee.N ame,
then the report will insert a subtotal row after each group of projects

and after each group of custom ers.
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Full Tim e Equivalent

Entry Type Filter

Subm itted Filter

This is the FTE hours per week used by the report to convert total

hours into FTE. Enter the num ber of hours per week that your
organization considers to be full tim e. For instance, a typical value in
North Am erica would be 40. When the Report Interval is not weekly
then this value is converted to an appropriate am ount for the interval
in the following m  anner:

Interval  FTE Per Period Example

Daily Weekly FTE /5 8 =40/5

Weekly Weekly FTE 40 =40

Monthly ~ (Weekly FTE*52) /12 173.33 = (40 * 52)

/112

Quarterly (Weekly FTE*52)/4 520 =(40*52)

/4

Yearly Weekly FTE * 52 2080 =40*52

Note: If you are running this report for em ployees who work in

different countries or regions that have different FTE hours per week,

you can optionally specify an API Variable forthe Full Tim e
Equivalent. For instanc e, if you define anem  ployee custom field to
hold the full tim e equivalent weekly hours as "FTE Hours", then you

could enter {User.xFTEHours} for Full Tim e Equivalent. When the
report runs it will look up this value for each report row and use it

when com puting the FTE value for the given colum n. If
{User.xFTEHours} doesn't return a value then the system default will
be used (based on the System > General > Default H ours Per D ay
multiplied by 5).

If using an API Variable m  ake sure that the custom field is of type
Num ber, and that you specify the API Variable nam e exactly
(case-sensitive) enclosed in curly braces.

Use this filter to restrict the report to only Work hours or to only
Leave hours. By default all tim esheet hours are included in the
report.

Use this filter to restrict the report to only hours for tim esheets that
are Submitted (loc ked), or only hours for tim esheets that are  Open
(unsubm itted). By default all tim esheet data is reported on,

regardless of its subm  ission status.
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Profit R eport

This report sum marizes profit/loss data based on pay am ounts and billam ounts. You can
custom ize this report to break down the data by em ployee, project, group, etc.

Note that all em ployee data will be shown in the em ployee's tim e zone, regardless of the

tim e zone of the person running the report. For instance, if the report is run by a reporter

in the Pac ific Tim e for Jan 1-Jan 7, it will correctly sum marize data foranem ployee in
Brisbane using Jan 1 - Jan 7 Brisbane Tim e. This is different than other tim esheet sum mary
reports that do not shift the data.

When c reating or editing this report you can set the following properties:

Property
Name

Description

Tem plate

Published

Reporting Period

Grouping Columns

Description
The report nam e or title, up to 80 characters (required).

A description for the report, up to 255 characters.

A read-only property that indicates which report was used as the
tem plate for creating this report.

If ¢ hec ked then this report can be run by other em ployees. You can
limit which em ployees ¢ an ac cess a published report by clicking the
button to the right of the check box and selecting the appropriate

perm ission levels.

Publishing a report does not allow others to edit it - only the
employee who created the report can subsequently edit it.

The default tim e period for the report. The reporting period can be
overridden when running the report.

The list of colum ns by which to group or sum marize the report data
into rows (required). Youc  anadd orrem ove colum ns, and click and
drag to change the colum  norder. The list of colum  nsislim ited to
data that can be recorded with tim e entries, such asem ployee and
project values, tim  esheet custom fields, etc. You m ust have at least
one but no m ore than 10 grouping colum  ns.

Note that the report will autom atically insert subtotal rows in the

report if you select m  ore than one type of colum  n. For instance, if

you have 2 ¢ olum ns, Projec t.Nam e and Em ployee.Nam e, then the
report will insert a subtotal row after each group of projects. If you

have 3 colum ns, Custom er.Nam e, Project.Nam e and Em ployee.N ame,
then the report will insert a subtotal row after each group of projects

and after each group of custom ers.
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Data Colum ns

Subm itted Filter

The list of data ¢ olum ns to sum marize (required). You can add or

rem ove colum ns, and click and drag to change the colum n order. The
list of ¢ olumnsis lim ited to data that is num eric and can be recorded
with tim e entries, such as hours, leave, R T, OT, etc. Youm ust have
at least one butnom  ore than 25 data colum  ns.

Some data ¢ olum ns are treated differently than in other tim esheet
sum mary reports:

The " Time Entry.Pay Amount "and " Time Entry.Bill Amount "
colum ns are com puted as the sum  of the adjusted rate m  ultiplied by
the hours. The pay rates and bill rates used in the calculation are

adjusted based on OT/R  T/D T factors. For instance, OT hours are paid
at1.5tim esthe R Trate. You can m odify the rate factors by clicking

the Options button on the report. Note that the base or RT rate

values used are the rates in effect when the tim e entry was recorded:
the total am ounts will be correct whether there was only one rate or
multiple rates used in the reporting interval.

The " Time Entry.Pay R  ate "and" Time Entry.Bill Rate "colum ns
will show the unadjusted rate value (e.g. the base or RT rate). Note

that if m ore than one rate was used during the reporting interval

then the maximum rate during the interval will be shown.

The Calculation.Profit ¢ olum n will show the result of subtracting the
total pay am ount from the total billam ount.

Use this filter to restrict the report to only hours for tim esheets that
are Submitted  (loc ked), or only hours for tim esheets that are  Open
(unsubm itted). By default all tim esheet data is reported on,

regardless of its subm ission status.
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Advanced Topics

Administration covers m  ore advanced configuration settings, such as security settings and
custom ization.

Related Topics

System Settings

Pay Codes
Tem plates
Policies
Security
Notices
Devices
Schem a
Custom Fields

Im porting/Exporting
Data Archival

X X X X X X X X X X X
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Administrative Overview

If you are setting up your tim esheet system for the firsttim e, the following settings should
be c onfigured first:

X Week Start
X Default Tim e Zone
X Email Reply Address

These can be setonthe  System Settings page. These can be changed at any tim e, butitis
a best-practice to define these before you start creating new em ployees.
_0_
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System Settings

The System page allows you to control application-wide settings, and is only accessible by
employees with a perm ission level that allows them to edit system  settings, such as
Admiinistrator. The following properties can be set:

Property Description
Default Week Start The default first day of the week, for instance Sunday
or Monday. This is the default value for em ployees, but

you can have as m any different tim e periods with
different week starts as needed by your organization.

For instanc e, one group of em ployees could use a

tim esheet tem plate that has a period starting on

Sunday, while another group could use a tem plate that
starts on Monday. See the ~ Time Periods help topic for
more inform ation on tim e periods, and the  Tem plates
help topic for m ore inform ation on tim esheettem plates.

Default Hours Per D  ay The default num ber of work hours in a day. This value
is used when putting leave and holidays on tim esheets.
In addition, this value is used when displaying how
many days of balance are available on the em ployee's
hom e page. This is the default value, but you can
override this value for each em ployee by setting the
Scheduled Hours Per Day property on each em ployee's
profile. See the Managing Em ployees help topic for
more inform ation.

Default Locale The default locale for new em ployees. A locale is a
language/country com  bination that determ  ines the
form atting of dates, currency and num bers. All
diagnostic and audit log inform  ation is form atted using
the default locale, too.

Default Tim e Zone The default tim e zone for new em ployees.

Base Currency The base ¢ urrency for application. This will be the
default currenc y when displaying or prom  pting for
currenc y am ounts. In addition, asset entries (for
exam ple expense entries), if configured to allow entry
of c ost am ounts in local currencies, will convert the
entered values into the base currency, for ease of
reporting.

Note that the list of available currencies can be
modified from the System > System Options page. See
the System Options topic for m ore inform ation.

Outgoing Em ail (SMTP) Server The host nam e or IP address of your outgoing em ail
server. Spec ify a value here in order to enable the
application to send em il notifications such as
tim esheet events or forgotten password requests.
Self-hosted version only.

Port The port num ber for your SMTP server. The default is
25,
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Security

Login Name
Password

Reply Address

If your SMTP server is using connection security you
will need to select the appropriate value here. Your
options are:

None No connection encryption
TLS Transport Layer Security encryption
SSL Secure Socket Layer encryption

The optional login nam e for the outgoing em  ail server.
Self-hosted version only.

The optional password for the outgoing em ail server.
Self-hosted version only.

The em ail reply address for notifications sent by the
application. This is required if you have specified the
outgoing em ail server address.

Note thatyoum aywanttousea"”™ noreply” email
address, e.g. "noreply@som  eco.com ", if you want to
make it clear to your em  ployees that they should not
respond to the autom  ated em ail notices sent by the

application.

Spam note: Be careful what address you use for the

reply address. Som e destination em ail servers will

rejec tthe em ail notices sent by  Pacific Tim esheet if the
reply address is for a different dom ain than that of the
email server used to send the em ail.
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Audit Level The audit level ¢ ontrols the am ount of auditing the
system perform s. All audit events can be reported on
using the Audit Report, available from the Reports tab.
The following audit levels are provided:

Audit Levels
None No auditing
Standard Standard auditing, which includes

the following audit controls:

X Logging successful and
unsucc essful login attem  pts,
inc luding their IP address

X Logging login nam e and
password changes

X Logging audit setting changes

X Logging user creation,
modific ation and deletion

X Logging tim esheet deletion

High (DCAA) Full Defense Contract Audit Agency
(DCAA) auditing. This provides the
following additional audit controls
over the Standard audit level:

X Logging of any changes m ade to
an em ployee's tim esheet by
another em ployee (for exam ple
their m anager).

X Logging of any changes an
employee m akes to their own
tim esheet if the tim e entry is
more than 24 hours in the past.

X Timesheets require approval

X Comments m ust be recorded
when tim esheets are approved,
rejec ted, or resubm itted for
approval.

X Form oreinform ation see http://
www.dcaa.m il/

Audit D ays The num ber of days to keep audit data (m axim um
365). Note that audit data, especially if using the high
(DCAA) level, ¢ an consum e a considerable am ount of
storage.

Application URL The base address for this application, for exam ple
http://hostnam  e/tim esheet. This is used when
form atting links in em  ail notic es and other m essages.
For instanc e, the notic e variable ${System .url} will be
replac ed with this value (see the Notices topic for m ore
details). Self-hosted version only.

Send Test Email

After ¢ onfiguring your em ail server settings it is a good idea to send a test em ail. The em ail
will be sent to the sam e address as the reply address.

Related Topics
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X X X X X X X X X X X X X

Work Breakdown Structure

Tim e Periods
Holidays

Work Shifts
Approval Levels
Rate Options
Term inology

Branding
Data Integration

System Options

System Tools
License

System Lists
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Work Breakdown Structure

The work breakdown struc  ture (WB S) is used to organize work into a series of com ponents,
such as projects, phases, tasks, etc. You can define up to 5 com ponents, and nam e each
level as you need. For instanc e, your organization m  ight have the following WB  S:

Client > Project> Phase> Task

Or

Task > Labor Code

WBS c omponents have the following properties:

Property Description

Enabled Indicates whether the WBS com ponent is enabled.

Dependent By default, com ponentsinthe WB S structure are independent of each
other, and are essentially flat lists. B y enabling dependency on a
WBS c omponent, you can restrict the list of item s presented to your
employees to just those for the selected parent com ponent,

eliminating a com mon source of data entry errors. With dependency
enabled the WBS struc  ture can m ore resem ble a tree structure.

There are two types of dependency settings: Optional and Required
Optional dependency m  eans item s that do not have a parent specified
for them will be visible regardless of which parent is selected by the
employee. However, item s with one orm ore parents will only be
visible if those parents are selected.

Required dependency m eans any item  without a parent will not be
visible. You m ust assign each item a parentif you wantem  ployees to
be able to select it.

Note: For large lists of item s (> 50K) it is highly recom  mended that if
you enable dependenc yyou m ake it required. This will drastically
improve perform ance of pick lists.

See the Dependencies  section below for m  ore inform ation.

Name The singular nam e of the com ponent, for exam ple " Client".
Plural The plural nam e of the ¢ omponent, for exam ple " Clients" .
Dependencies

Dependencies allow you to lim it or scope which item s canbe addedtoatim esheet based on
a previous selection in the WBS structure. For instance, you m ightwantto lim itsom e
projects to specific custom  ers. To do this you would select the appropriate " Dependent”
selection from the D ependentm enu:
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>> General >> Work Breakdown Structure

Work Breakdown Structure (WBS)

’ &
= | L
F o’ P R v [Proi Pr L #4
7 s~ Parend Ontional v Tas Tash [/
Selecting "Yes" indicates that a project depends on the parent com ponent above it, in this
case the ¢ ustom er. Now when you view the properties for a project (from the Tasks >

Projects page) you will see a Custom ers section:

>> Projects >> Project 019 20 & |P_i| ﬂ
* Project Deta E it lone Delata
Name: F
Descriptio
IC

Status: Active

Planned Starl Date

Planned Finish Date
Planned Waork
Actual Start Date
Actual Finish Date
Actual Work
Locatiorn
Iy
eate rI1A B i ¢ | AM by Ad
P Motes

} Project Dashboard

¥ Customers (1) - Resinct this Project to tha following Customers 00

P Permissions

If you leave the Custom  ers section blank (no restrictions) then this project will be not be

visible if "Yes - Parent R equired" was chosen. If"  Yes - Parent Optional" was selected and

there were no parents specified, this project would always appear regardless of the selected

custom er. This allows you to have 'global' com ponents that are always available, whether a
parent selectionis m ade or not. To lim it this project to one or m ore specific custom ers click
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the Add button and add the appropriate custom ers. Then, when em ployees browse for
projects to add to their tim esheet, they will not see this project unless one of the custom

in the list is selected first.

Note that dependencies take effect on the tim esheet page, as well as for reports that allow

you to filter based on custom ers, projects, etc., such as the "Tim esheet D etails" report.
Translations

The term inology you enter should be appropriate for the default language of your system

(as configured on the System > General page). You can provide translations for up to 4
additional languages by clicking the globe icon next to each term inology row. Users will see

the appropriate translation based on the Locale setting in their em ployee profile (as
configured in theirem  ployee record on the Em  ployees tab).

p106

ers



© 2000-2021, Pacific Timesheet

Time Periods

Tim e periods are used to define com mon tim esheet and reporting periods. You can define as

many different tim

e periods as you need. Once defined, they can be used when editing and

creating Timesheet Tem plates , or when running reports. The following types of tim e periods

are supported:

Type

Weekly
Biweekly
Semimonthly

Quadweekly
Monthly
Custom

Description
7 day tim e period, with your choice of the first day of the week.

14 day tim e period, with your choice of the first day of the week.

Semi-m onthly tim e period, typically the 1st through the 15th, and the
16th through the end of the m onth.

28 day tim e period, with your choice of the first day of the week.
Monthly tim e period, with your choice of the first day of the m onth.

Custom tim e periods, where each tim e period can be a different
num ber of days.
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Holidays

The Holidays page lets you define your com pany holidays. The following properties can be

set for each holiday:

Property
Name

Description
Date
Repeat

Partial D ay

Locale

Groups

Description

The nam e of the holiday, up to 80 characters. You should keep this as
short as reasonably possible, however, to better fit it on tim esheets
and dashboards.

A description for the holiday, up to 255 characters.
The date of the holiday.

If this holiday recurs then select the appropriate value. For instance,

for N ew Years you could set the date to January 1, 2009 and choose a
repeat value of "Yearly on this date" . For the U.S. holiday

Thanksgiving you could set the date to Novem ber 27, 2009 and
choose a repeat value of "Yearly on the 4th" Thursday of Novem  ber.

Check this option to create a partial day holiday. For instance, you

might have a half-day holiday on New Year's Eve. The actual num ber
of hours pushed onto em  ployee tim esheets will be determ  ined by
their Scheduled Hours Per Day property on the Em  ployees page

(or, if the em ployee property is not set, the Hours Per Day  property
on the System > General page). For exam  ple, if the em ployee is
scheduled to work 8 hours per day, a half-day holiday would result in

4 hours being placed on the tim esheet.

You can lim it the holiday to a specific set of locales or countries. If
this list is em pty then there is no locale lim itation. See the  Managing
Employees topic for m ore inform ation on em ployee locales.

You can lim it the holiday to a specific set of em ployee groups. If this
listis em pty then there is no group lim itation.
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Work Shifts

The Work Shifts page lets you define your com pany work shifts. Work shifts affect how
much an em ployee is paid by applying a pay differential when working in certain shifts. The
following properties can be set for each shift:

Property Description

Name The nam e of the shift, up to 80 characters.

Description An optional description for the shift, up to 255 characters.

ID An optional unique identifier for the shift, up to 80 characters.
Start Tim e The start tim e for the shift, for exam  ple "8:00 AM"

Finish Tim e The finish tim e for the shift, for exam ple " 5:00 PM".

Valid D ays The days of the week for which the shift is valid, such as Monday

through Friday.

Shift D ifferential The differential rate used to calculate a shift prem ium when
working in the shift, for exam ple "0.25". Iftheem  ployee's base
pay was $20/hour, the shift differential would result in a real pay
rate of $25/hour.

Once you have created your shifts you will still need to activate them per em ployee policy
from the System > Policies page. See the = Wage Rules topic for m ore inform ation.

Additional Configuration: Shift Over Time
If you need to track how m uch regular tim e, overtim e and double tim e was spent in shifts,

you will need to do som e additional configuration. You will need to create 3 custom
tim esheet fields as follows (from the System > Templates> Custom Fields page):

Field N ame Description
Shift Regular Tim e Type = Num ber, dec imal digits= 2

Shift Over Tim e Type = Num ber, dec imal digits= 2

Shift D ouble Tim e Type = Num ber, dec imal digits= 2

The nam e of the custom field m ust be exactly the sam e as shown above. However, once you
have created the custom field, you can later renam e it as desired without affecting the
system . Once you have defined these fields then any regular tim e, over tim e or double tim
hours that fall in a shift will be placed into these fields.

_O_
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Approval Levels

You can define m ultiple tim esheet approval levels. Many organizations require additional
approval levels to handle different work flows. For instance, you m ight have am anager
approval, a billing approval and a payroll approval. Creating separate approval levels can

facilitate any work flows that are triggered by the approval process.

Approvals are optional - you do not need to have any approval levels enabled if your
organization does not require tim esheet approvals. Am  axim um of four (4) approval levels
are supported.

The following properties can be configured for each approval level:

Property Description

Enabled Indicates whether the approval level is enabled.

Display Nam e The nam e for the approval level, up to 40 characters. N ames should
be as short as possible, and not include the word " approval" or
"approved" as that will often be redundant in places where approval
inform ation is displayed by the application. A blank nam e is allowed,
but if you have m  ore than one approval level enabled the nam es must
be unique.

Applies To You can specify which areas of the application the enabled approval

level is applic able. For instance, you m  ight want 2 levels fortim e
approval, but only one level for project approval.

Enabled approval levels always apply to tim e (e.g.tim esheet approval
on the Approvals > Timesheet Approvals page ), leave requests
(approval from the Leave R equests page ) and assets (approval of
asset entries and sheets, from the Assets > Asset Entries page ).
You can optionally enable the level for projects if you intend on doing

project approval (e.g. approval from the Approvals > Project Time
Approvals page ).
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Bill/Pay Rate Options

Rate options allow you to control how bill and pay rates are specified when an em ployee
saves their tim e. Pacific Tim esheet has a very flexible bill and pay rate engine that allows

you to configure your rates to depend on not just the em ployee or the project, but to have
rates that also depend on tasks, jobs and cost centers.

Note: Changes to rate options take effect for the current tim esheet period and will not
affect previously subm itted tim esheets.

The following properties can be configured for bill and pay rates:

Property
Rates Depend On

Make Exceptions For

Billable/Payable Flag On

Rates Apply Only For

Description

The type of object that rates prim arily depend on, for exam  ple
Employees, or Projects.

The type of object for which you m ay need to m ake exceptions to

the prim ary rate. For instance, if your organization's bill rate
depends prim arily on Projects, then you m ight m ake exceptions
for certain Em ployees.

The object that has the billable/payable flag. A com mon exam ple
is to have the billable flag on Tasks, so that certain tasks can be
marked as non-billable.

The type of hours for which these rates are applicable. Bill rates
would generally only apply to work hours, whereas pay rates
might apply to both work and leave (in other words, paid leave).

Different organizations have different rules for how bill and pay rates are specified. For

instance, when keeping track of project bill rates you m ight configure bill rates as follows:
Rates Depend On: Projects
Make Exceptions For: Employees
Billable/Payable Flag On: Tasks
Rates Apply Only For: Work Hours
In the above exam  ple the default bill rate is set on the project. Em ployees can be given
specific bill rates on projects, overriding the default rate. Tasks have a billable flag, allowing
the creation of tasks that are non-billable. Tim e recorded against a non-billable task will
have a bill rate of zero, regardless of the project or em ployee bill rate.
Standard R  ates
When specifying bill and pay rates you have the option of using nam ed values, rather than

specifying an ac tual num

eric rate. By assigninganam  ed value to a set of em  ployees, for

instance, you can later change the nam ed value's rate and all of the em ployees will pick up
the new value. Rates have the following properties:

Property
Name

Rate

Description

The rate nam e, up to 80 characters. A value is required and
must be unique for all rates.

The hourly rate, in the base currency. The base currency is
specified from the System Settings page.
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Status The rate status, either Active or Inactive. You cannot delete
rates that are currently assigned to em ployees. Setting the
rate to inactive will prevent the rate from being assigned to

new em ployees.
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Terminology
You can override the default term inology foranum ber objects and phrases in the
application. Make sure when changing the term inology that you specify both singular and

plural versions to avoid confusion.
Translations

The term inology you enter should be appropriate for the default language of your system

(as configured on the System > General page). You can provide translations for up to 4
additional languages by clicking the globe icon next to each term inology row. Users will see
the appropriate translation based on the Locale setting in their em ployee profile (as
configured in theirem  ployee record on the Em  ployees tab).
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Branding

Branding allows youto ¢ ustom ize the application suit your organization. You can specify the

following properties:

Property
Company Nam e

Application Nam e

Application Logo

Description

The nam e of your com pany or organization. The com  pany nham e can
be used in em ail notices sent by the application.

The application nam e. The application nam e appears in several places
in the produc t, including the window title and em ail notices sent by
the application.

The application logo, which appears in the upper-left corner of the

page. Supported form  ats are PNG , GIF and JPG , and the im age size
can be at m ost 320x100 (320 pixels in width and 100 pixels in

height).

Note that when you upload an application logo file a copy of it will be
stored in the database: the uploaded file is no longer needed by the
application.

Clicking the Restore Defaults button will reset the properties to their factory settings -

make sure you click the

OK button after clicking Restore D efaults to confirm  the change.
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Data Integration

Data Integration allows you to enable and configure the external data and device integration
facilities provided by  Pacific Tim esheet . The following integration types are provided:

Integration Type Description

Timesheet Export Configure tim esheet export settings, such as which tim e
entry fields are exported, etc. See the Export Options _ topic
for m ore inform ation.

Timesheet Export - Tim e Bank Time Bank software provides integration with m ost popular
payroll, HR and general ledger applications. Over 250
system s are supported, and you can find out m ore by

contac ting your sales representative or visiting our website
at https://www.pacifictim esheet.com /.

Quic kBooks Interchange File Quic kBooks IIF file support allows you to export your

(1F) tim esheets into QuickBooks for both invoicing and payroll.
See the QuickBooks Export File  help topic for m ore
inform ation.

Employee Export Configure regularly scheduled exports of em ployee data.
See the Export Options _topic for m ore inform ation.

Group Export Configure regularly scheduled exports of group data. See
the Export Options topic for m ore inform ation.

Auto-Im port D irectory The auto-im port directory allows you specify a folder that is
monitored for CSV files that will be autom atically im ported

into the system . See the Auto-Im port D irectory help topic
for m ore inform ation.

LDAP/Active D irectory LDAP/Active Directory support allows you to use an LD AP or
Active D irectory server for authentication, as opposed to
the built-in application authentic ation. For m ore inform ation
see the Security topic.

Barc ode Scanner Barc ode scanner support allows you to use Codereadr
barc ode scanning apps/devices for em ployee in/out, asset
tracking and other applications. For m ore inform ation see

the Barc ode Scanner Support _ topic.

Time Cloc k Device Time clock device support allows you to integrate with
external tim e clock devices, such as those provided by
ACTAtek. For m oreinform ation see the Devices topic.

Web Services API The web services API allows you to send and receive
tim esheet, em ployee, project and other inform ation with
Pacific Tim esheet . System adm inistrators canlearnm  ore
about this topic by logging into the custom  er support portal
and searching for "R EST API" to locate and download the
REST API docum ent.
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Timesheet Export Options

The Tim esheet Export Options page allows you to configure how tim e sheet data is
exported. You can enable and define m ultiple export configurations, which is useful if you
need to exportto m  ore than one system , for exam ple payroll and billing. The following
options are provided:

Options

Name

Description

Enabled

Clipto D ate
Range

Exported Fields

Custom
Header

Description

You can nam e the export, which is useful if you have m ore than one
defined export. For exam  ple you m ight nam e one 'Payroll' and the other
‘Billing'. The nam e can be up to 80 characters in length.

A description of the export configuration, up to 255 characters.

If ¢ hec ked then this export will show up in the list of available exports in
the Tim esheets and Approvals tabs.

Check this option to clip tim e entries to the selected date range when
exporting. This option is useful if you are exporting tim e entries for tim e
periods different than the tim esheet period. You would want to check this
option, for instanc e, iftim esheets have weekly periods but you export to
payroll sem imonthly.

Select the data fields to export, as well as their order. This option is useful

if you need to integrate data with external system s such as payroll

proc essing, etc. For exam ple, SurePayroll  system s require the following 6
fields in this order:

TimeEntry.D ate
Employee.ID
Employee.Last Nam e
Employee.First Nam e
Pay Code.ID

Tim eEntry.Hours

You can ¢ reate a ¢ ustom ized export fields by adding Expression Fields. See
the Expression Fields help topic for m ore inform ation.

For som e external system syou m ay want a special header at the

beginning of the export file, rather than the standard list of field nam es.
For exam ple, SurePayroll  system s require the following two lines at the
start of the file:

TC
00001
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Pay Code
Rollup

Date Form at

Time Form at

Norm ally a tim esheet export will have one record in the export file for each
tim e entry on an em  ployee's tim esheet. You can use the following Pay
Code Rollup optionsto m  odify this:

Rollup time entries by pay code:

This option will sum  marize or total the hours by pay code for each

employee tim esheet. For instance, let's suppose em ployee Jeff worked 4
days of regular tim e and 1 day of vacation, and had 5 tim e entries on his
tim esheet. The export file would show only two rows for Jeff:

Jeff, R T, 32.00
Jeff, Vacation, 8.00

As you can see above, the 5 tim e entries have been rolled up or

sum marized into two rows. If Jeff had worked on only one pay code in the

week then there would only be one row in the export file for him . If Jeff
had worked on 3 pay codes in the week then there would be 3 rows in the
export file for him

Split time entries by pay code:

This option will split a tim e entry intom  ultiple rows if thereism  ore than
one pay code value for the tim e entry. For instance, let's suppose Jeff had
worked 41 hours in the week, with 9 hours on Friday (8 regular tim eand 1
overtim e). He had 5tim e entries on histim  esheet. The export file would
show 6 rows:

Jeff, Mon, R T, 8.00
Jeff, Tue, RT, 8.00
Jeff, Wed, RT, 8.00
Jeff, Thu, RT, 8.00
Jeff, Fri, R T, 8.00
Jeff, Fri, OT, 1.00

As you can see above, the Friday tim e entry has been split into two records
in the export file, for a total of 6 records for Jeff.

Select the date form  at you want to use for exported date and date-tim e
fields. The following characters specify how the dates are form atted:
d Dayinm onth. Use dd to always output a two-digit day of
month, e.g. "01".
M Month. Use MM to always output a two-digit m onth, e.g.
01",
y | Year. Use yy to always output a two digit year, e.g. " 14",
Use yyyy to always output a 4 digit year, e.g. " 2014" .
Select the tim e form at you want to use for exported tim e and date-tm e
fields. The following characters specify how the tim es are form atted:

h  'Hour in day using 12 hour clock (1 - 12). Use hh to
always output a two-digit hour, e.g. "01"

H Hour in day using 24-hour clock (0 - 23). Use HH to
always output a two digit hour, e.g. " 01"

m  Minute in hour. Use m  m to always output a two-digit
minute, e.g. "01".

a AM.orP.M.
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Timesheet Export Schedule

You can autom ate tim esheet exporting using the tim esheet export scheduling feature. This
allows you to export tim  esheets to a file on the server (or network drive) where Pacific
Timesheet is installed (self-hosted only), or to an FTP server. The following options are

provided:

Options Description

Schedule Check this option to enable scheduled tim esheet exporting.

Enabled

Schedule The schedule or frequenc  y fortim esheet exporting. The tim e period can be
any created in the System > General > Tim e Periods page. To specify the
exact tim e withinthe tim e period when the export occurs you specify an
offset (in hours:m inutes) from the start or end of the tim e period. For
instance, if you want to export tim esheets at 4:30 PM (16:30) on the last
day of the tim e period, you would specify "7:30 hh:m m before the period
ends".

Next Run As you m odify the schedule, this property will update to show when the

next export will occur.
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Export To

Direc tory

File Nam e

Form at

You have several options for where you can send the export file:

Direc tory The export file will be sent to a directory on the
com puter's local file system ,e.g." c:\exports"
(self-hosted only)

FTP Server The export file will be sent to a rem ote directory
using the FTP protocol.

Web Directory  The export file will be sent to the custom er's web

directory, e.g.
"https://som  eco.pacifictim esheet.com /custom ers/som

eco".
If you choose "FTP Server" the following properties m ust be configured by
clicking the settings button that appears to the right of the m enu:
FTP Server The host nam e or IP address of the FTP server.
Login The user account or login nam e for the FTP server.
Password The password for the login, above.
FTP Directory | The directory where export files will be created, e.g.
“I" or "ftmp". FTP server paths start with a forward
slash, and backslashes are not valid. If blank, the
root direc tory will be used, which is equivalent to " /.
FTP Port The port num ber for the FTP server, where 21 is the
default value form  ost FTP servers.
FTP Mode Check this option to enable passive m ode, which aids
when transferring files through firewalls.
Security If the FTP server has connection security enabled you
will need to set the appropriate value here. Your
options are:
None No connection encryption

Im plicit SSL Im plicit Sec ure Socket Layer
encryption (FTPS)

Explicit SSL Explicit Secure Socket Layer
encryption, also known as (FTPES)

The directory on the com  puter or FTP server where the export file will be

created. If the "Export To" property is set to " Directory”" then this is the file
path to the directory where the export file will be created, e.g. " ftm p",
"c:\exports” or "\m  orpheus\\c\exports". The path m ust be valid for the

server that Pacific Tim esheet is installed on.

If the "Export To" property is setto " FTP" then this is the directory on the
FTP server where you want the export file created, e.g. " ["or"tm p". FTP
server paths start with a forward slash, and backslashes are not valid.

The nam e of the export file, e.g. "tim esheets-for-payroll* . The " Append
tim estam p" option will add the date and tim e of the export to the file
name, e.g. "tim esheets-for-payroll.200908150831" . Note that the file
extension will autom  atic ally be added when the export file is created,

based on the Form at property, described below. For CSV form at, the file
extension ".csv" will be added to the file nam e. For MS Excel form at, the
file extension ".xIs" will be added to the file nam e.

The form at of the export file, either com ma-separated-values (CSV) or
Microsoft Excel (XLS).
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File Encryption

Tim e Period

Status

Group

Export Status

Mark as
Exported

You can optionally encrypt the export file using PG P (Pretty G ood Privacy).
If you choose this option you need to specify the following options:

Encryption K ey The public encryption key to use when encrypting the
export file. Click the settings button to the right of
the m enutoim portand m anage your encryption
keys. An encryption key is required.

Arm or Check this option to output the encrypted file in
arm ored ASCII form at, rather than binary form at.
The file will have the ".asc' file extension appended to
it.

When the file encryption is set to PG P the export file will have the '.pgp’
file extension appended to the file nam e. Ifthe arm or option is selected
then the file will also have the ".asc' extension added to it, so the export

file will end in ".pgp.asc'.

The tim e period to use when searching for tim esheets to export. For
exam ple, you m ight schedule the export to occur weekly, but want to
export the previous week's tim esheets.

Select a value if you want to only export tim esheets with a particular
status, such as subm itted or approved.

Select a value if you want to only export tim esheets forem ployeesin a
particular group.

Select a value if you want to only export tim e entries that are either
unexported or exported. Tim e entries are only m  arked as exported if the
"Mark as Exported" option is selected (described below).

Checking this option willm  ark eac h exported tim e entry as having been
exported. This works in conjunction with the "Export Status" filter option,
described above.
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Expression Fields

You can c¢ reate ¢ ustom export fields using Expression Fields. Expression fields allow you to
access and ¢ ombine a large num ber of variables for export using sim ple JavaScript syntax.
For instanc e, you can com bine RT and OT using an expression such as:

{TimeEntry.payCodel1}+{TimeEntry.payCode2}
Or you ¢ ould com hine the ¢ ustom er, project and task nam  es into one field:

{TimeEntry.customerld.name}+"."+{TimeEntry.projectld.name}+"."+{TimeEntry.taskI
d.name}

Expressions m ust evaluate to either a num ber or string (text) value, as per the usual rules
of JavaScript. For instanc e, the following expression would evaluate to a num ber:

{TimeEntry.hours}+100
But the following expression would evaluate to a string:

{TimeEntry.hours}+" hours"

Note 1 : null variable values will be converted to a blank value if the variable type is
string, or to zero if the variable type is a num ber.

Comparisons and Logical Operations

You can use JavaScript c  omparison and conditional operators. For exam ple, you could
output an em ployee ¢ ustom field value depending upon a pay code ID

if ({Tim eEntry.payCodeld.uid}=  ="maternity")
{Tim eEntry.userld.xMaternityAccount};
else

You can also ¢ ompare hum eric values:

if ({Tim eEntry.hours}> 8.0)
"ot

else
"RT";

Note 2 : You should not use the "return” JavaScript keyword. Instead, the expression
should just evaluate to a single value.

Debugging Scripting Errors

If your expression has a syntax error then the cause will outputted to the export file (as a

string). Even if the syntax is correct, you could encounter errors in the evaluated

expression if your data is not valid (for exam ple, you divide by zero). You will want to put
any proper ¢ hecks in place in the expression to avoid this (you can even use try/catch

exc eption handling if warranted).
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Time Entry Export Variables

Here is a partial list of variables you ¢
must be enclosed in "{" and "}".

an refer to in your expression. Note that all variables

Variable

{Tim

{Tim

{Tim

{Tim

{Tim

eEntry.date}

eEntry.start}

eEntry.finish}

eEntry.hours}
eEntry.type}
eEntry.workHours}
eEntry.leaveHours}
eEntry.payCodel}
eEntry.payCode?2}
eEntry.payCode3}

eEntry.payCode4}

eEntry.userld.fullNam

eEntry.userld.uid}

eEntry.userld.login}

eEntry.groupld.nam

Data
Type

Date

Date-tim e

Date-tim e

Num eric
Text

Num eric
Num eric
Num eric
Num eric
Num eric
Num eric

Text

Text

Text

Text

Description

Date of tim e entry. N ote that you can control
the form atting of this using a pattern argum ent
- see the section below on D  ate Form atting.

Date and tim e of start of tim e entry. Note that
you can control the form  atting of this using a
pattern argum ent - see the section below on
Date Form atting.

Date and tim e of finish of tim e entry. N ote that
you can control the form  atting of this using a
pattern argum ent - see the section below on

Date Form atting.

Total hours for tim e entry.

Type of tim e entry, either 'Work' or 'Leave'.
Same as hours if type is 'Work', zero otherwise.
Sam e as hours if type is 'Leave’, zero otherwise.
Regular hours.

Overtim e hours.

Double-tim e hours.

Triple-tim e hours.

Full nam e (last, first) of em  ployee for this
entry. You can also use the alias
{User.fullNam e}.

ID of em ployee for this entry. You can also use
the alias {User.uid}.

Login nam e of em ployee for this entry. You can
also use the alias {User.login}.

Name of group (departm  ent/crew) for this
entry. You can also use the alias
{Group.nam e}.
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{Tim eEntry.groupld.uid} Text ID of group (departm  ent/crew) for this entry.
You can also use the alias {G  roup.uid}.

{Tim eEntry.payCodeld.nam e} Text ID of pay code for this entry. You can also use
the alias {PayCode.nam e}.

{Tim eEntry.payCodeld.uid} Text ID of pay code for this entry. You can also use
the alias {PayCode.uid}.

{Tim eEntry.c ustom erld.nam e} Text Name of ¢ ustom er for this entry. You can also
use the alias {Custom  er.nam €}.

{Tim eEntry.c ustom erld.uid} Text ID of custom er for this entry. You can also use
the alias {Custom er.uid}.

{Tim eEntry.projectGroupld.na Text Nam e of project group for this entry. You can
me} also use the alias {ProjectG  roup.nam €}.
{Tim eEntry.projectGroupld.uid Text ID of project group for this entry. You can also

} use the alias {ProjectG  roup.uid}.

{Tim eEntry.projectid.nam €} Text Name of project for this entry. You can also use

the alias {Project.nam €}

{Tim eEntry.projectld.uid} Text ID of project for this entry. You can also use the
alias {Project.uid}.

{Tim eEntry.taskGroupld.nam e Text Nam e of task group for this entry. You can also
} use the alias {TaskG roup.nam e}.
{Tim eEntry.taskGroupld.uid} Text ID of task group for this entry. You can also use

the alias {TaskGroup.uid}.

{Tim eEntry.taskld.nam e} Text Nam e of task for this entry. You can also use
the alias {Task.nam €}.

{Tim eEntry.tasklid.uid} Text ID of task for this entry. You can also use the
alias {Task.uid}.

You m ay also refer to any objec  t's custom fields, using the appropriate variable nam e. For
exam ple, the "Maternity Ac  count” custom field on an em ployee object would have a variable
nam e like this:

{Tim eEntry.userld.xMaternityAccount}

You can get the variable nam e of any custom field from the custom field properties page for
the appropriate object.

Time Sheet Export Variables

Variable Data Description
Type
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{Tim eSheet.start} Date-tim e

{Tim eSheet.finish} Date-tim e

Date and tim e of start of sheet period for the
tim e entry being exported. Note that you can
control the form  atting of this using a pattern
argum ent - see the section below on D ate
Form atting.

Date and tim e of finish of tim e sheet period for
the tim e entry being exported. Note that you

can control the form  atting of this using a
pattern argum ent - see the section below on
Date Form atting.

Aliases

Many expression variables can be replaced with shortcuts or aliases. For exam
Tim eEntry.projectld.uid can be replaced with Project.uid, or Tim

be replaced with User.fullNam

there is am biguity about whic
user who subm
nam e of the first approver you would use Tim

Date Formatting
You can ¢ ontrol the form  atting of dates, tim

pattern as an argum
Form at Pattern, described here:

https://doc _s.orac le.c om/javase/10/docs/api/java/text/Sim

itted the tim e you would use Tim

ent to the variable. The form

ple,

eEntry.userld.fullNam
e. You will want to use the full expression variable nam
h field to refer to. For exam ple, to get the fullnam e of the

eEntry.lockerld.fullN ame, or to get the full
eEntry.apprvlid.fullN ame.

at
ple D ate

es and date-tim es by adding a date form
at of this pattern is the Java Sim

pleD ateForm at.htm |

If you want to form
variable nam e. For instance, to form
following:

{Tim eEntry.start,yyyy-MM-dd}

The date pattern argum

at a date variable you would add a date pattern argum
at a date variable as YYYY-MM-D D you would do the

ent after the

ent follows a com ma after the nam e of the variable. Make sure the

argum ent is contained within the '}, and you cannot use the '{, '} or',' characters in date

patterns.
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QuickBooks Online Data | ntegration

Intuit Quic kBooks Online (QBO) allows the im porting of tim  esheet data (called Tim e
Activities in QBO) from  an external source.  Pacific Tim esheet provides a QBO-com patible

tim esheet integration that allows the transfer of em ployee tim esheet data directlyinto QB O.
Once transferred, the tim e activities can then be used for invoicing, payroll and reporting

from within QBO.

Note 1: The Pacific Tim esheet connection to QB O is configured from  the System >

General > Data Integration > Timesheet Export - QuickBooks Online page. If you do

not see the "Tim esheet Export - Quic kBooks Online" option on this page it m eans you have
already enabled both of the first two Tim esheet Exports. You will need to disable the

second Tim esheet Export in order to see the Tim esheet Export - QuickB  ooks Online option.

Note 2: Pacific Tim esheet will only upload tim e activities to your QB O account. It will not
modify objec ts suc h as em ployees, custom ers, etc. in your QBO system . Your QB O account
is c onsidered the system  of record forem ployees, custom ers, etc. and for data safety

Pacific Tim esheet will not m odify your QB O account except to upload tim e activities.

To connectto a Quic kBooks Online account you will need to configure the following
properties in Pac ific Tim esheet (from the System > General > Data Integration >

Timesheet Export - QuickBooks Online page):

Property Description

Enabled Check this option to enable exporting of tim esheet data from  Pacific Tim esheet to
QBO. When enabled you will see an "Export - QuickBooks Online" item infthe
options m enu on the Tim esheets and Approvals tabs.

Authenticated Click the "Click to Authenticate" link to connect to your QB O account and allow
access to it from Pacific Tim esheet. For security, after 100 days you will be asked
to re-authenticate. You can either do this from the System > General > Data
Integration > Quic kBooks Online page, or when m anually synchronizing or
uploading data (you will be prom pted autom atically if the authentication has
expired).

Note that for auto-synchronization and auto-export of data you will need to go to
the System > General > Data Integration >  QuickBooks Online page every 100
days to re-authenticate, or the background process will fail. You and other

adm inistrators will be given a warning when the authentication is going to expire
on the Hom e page several days before the expiration. If you are not using the
auto-synchronization or auto-export options then you can re-authenticate when
you m anually sync hronize or exporttim  esheet data.

pl25



© 2000-2021, Pacific Timesheet

Mapping Mapping allows you to specify how objects in QuickBooks are m apped to objects in

Pacific Tim esheet. You can additional specify whether objects in QuickB 00ks are
synchronized (downloaded from QuickBooks) and created in Pacific Tim esheet.

QB Object Pacific Timesheet Object |
Employee QB em ployees always m aps to Pacific Tim esheet em ployeles.

Vendor QB vendors/contractors always m ap to Pacific Tim esheet
employees.

Custom er QB custom ers ¢ an be m apped to any Pacific Tim  esheet WIF S
objec t, but are generally m  apped to the custom er object.

Project QB projec ts should be m apped to the Pacific Tim esheet WBS
object that is dependent on the project object. Additionally, as
you can reuse project nam  esin QB under different custom | ers,
you need to enable the "Allow duplicate project nam es" option on
the Projects >  Project Options page.

If you do not use projects in QB (this is a QB advanced setting
option) then you can set the m apping to 'blank’ and projects|will
be ignored.

Service Item QB service item s can be m apped to any Pacific Tim esheet WBS
objec t, but are generally m  apped to the task object.

Each m apping that has synchronization enabled will result in a custom field nam ed
"QBO ID " being created for the m  apped object in Pacific Tim  esheet. For instance, if
you enable sync hronization forem ployees, every em ployee in Pacific Tim esheet

will have a QBO ID field that is autom atically filled in when the data is
synchronized. The value in this field should NOT be m odified and should be
considered read-only.

Last Clicking the "Synchronize Now" link will download objects from QB and create (or

Sync hronized update, if ¢ hanged) the correspondingly m apped object in Pacific Tim  esheet. Only
objec ts with the "Sync  hronize" option checked in the m apping table will be
downloaded.

Note that if your authentic ation has expired you will be autom atically asked to
authenticate again upon clicking the "Synchronize Now" link.

Timesheet Export:

When "Tim esheet Export - QuickBooks Online" is enabled, you will see the " Export -

Quic kBooks Online" option under the "tools" m enu (triangle button) on both the Tim esheets
and Approvals tabs. Choosing this option will prom pt you if you want to export the listed

tim esheets to QBO. Note that only subm itted (locked) tim  esheets can be uploaded to QBO.

Succ essfully uploaded tim  esheets will be m arked as exported. H owever, som e tim esheet
data m ight be skipped or generate an error for the following reasons:

X Timesheets ortim esheet data that have already been exported will not be re-exported
and are ignored.

X Timesheets forem ployees in Pac ific Tim esheet that have no corresponding em ployee,
contractor or vendor in QB O will be ignored.

X Time entries in Pacific  Tim esheet with no ¢ ustom er specified will result in an error and
not be uploaded. The custom er field is a required field and should be configured as such
for tim esheet tem plates. The selected custom  erforatim eentrym ustm atch an
custom er object in QBO or an error will result.

X Project and service item s are optional, but if a value is selected then it m ust m atch the
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corresponding object in QBO or an error will result.
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QuickBooks Export File

Intuit Quic kBooks Pro allows the im  porting data from  an external source.  Pacific Tim esheet
provides a QuickBooks-c ompatible tim esheet export file that you can use to transfer tim e

activities directly into QuickBooks for both invoicing and payroll. The form at of the file is the
Intuit Interc  hange Form at (lIF), and uses the Tim er Activity im  port feature of QuickB  ooks.

Note: More advanced QuickBooks integration, including bi-directional transfer of jobs,
employees and ¢ odes, is supported through the Tim e Bank data integration facility. You
can find out m ore by contacting your sales representative or visiting our website at
https://www.pacifictim esheet.com /.

To set up your system  for proper export you will need to configure the following properties:

Property Description

Enabled Check this option to enable the QuickBooks export file support. When
enabled you will see an "Export - QuickBooks" item in the options m  enu
on the Tim esheets and Approvals tabs.

Company The QuickBooks com pany nam e. This value is found by doing a Tim er

Activity Export from  Quic kBooks, as detailed below.
Company Create | The QuickBooks com pany create tim e. This value is found by doing a

Time Tim er Activity Export from Quic kBooks, as detailed below.
Tem plate The QuickBooks tim er ac tivity export file tem  plate. This is detailed
below.

You can ¢ ontrol which tim e entries are exported by specifying any of the following filters:

Property Description

Billable Filter Use this filter to export only billable or non-billable hours. You m ight use
this filter if you are only using QuickBooks for billing, for instance.

Payable Filter Use this filter to export only payable or non-payable hours.

Hours Filter Use this filter to only export work hours or leave hours.

Employee Filter Use this filter to only export specific em ployee types.

Getting the Company N ameandCreate T ime

The first step to ¢ onfiguring your system  for proper QuickBooks exporting is to determ ine

the Com pany nam e and Com pany Create Tim e. To do this you need to start QuickBooks Pro

and run the Tim er Lists export under the File > Utilities > Export m enu. Save this file to a

convenient location and open it with a text editor such as Notepad or Wordpad. Look for
lines like the following:

ITIMERHDR VER REL COMPANYNAME IMPORTEDBEFORE FROMTIMER
COMPANYCREATETIME
TIMERHDR 7 0 Arpent N Y 1165339129

The TIMERHDR line has the Com pany nam e and Com pany Create Tim e values we need. In
this case the Com pany nam e is Arpent, and the Com  pany Create Tim e is 1165339129.

The TIMERHDR fields are:
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VER The version num ber of the QuickBooks Tim  er, forexam ple 7. You can
find this inform  ation by first running an Tim er Activity export in
Quic kBooks and viewing the output. You will need to m odify the

tem plate replacing the exam  ple value with your specific value.

REL The release num ber of the QuickBooks Tim  er. You can find this
inform ation by first running an Tim er Activity export in QuickBooks and
viewing the output. You m ay need to m odify the tem plate to replace the
exam ple value with your spec ific value, otherwise QuickB  ooks m ay
generate awarning m  essage when im porting the data.

COMPANYNAME  The nam e of your QuickBooks com  pany. If you leave this as
${System .com pany} it will be autom atically substituted with the
Company property entered above.

FROMTIMER Indicates whether you are exporting or im porting data. It should always
be the value " Y".

COMPANYCREATE A unigue num ber that c omes from your Quic kBooks Pro com pany file.
TIME You can find this inform  ation by first running an Tim er Activity export in
Quic kBooks and viewing the output. You will need to m odify the
tem plate replacing the exam  ple value with your specific value.

Configuring the Template

The export file generated by Pacific Tim esheet will contain the TIMERH DRrecords above, as
well as TIMEACT records for each tim esheet's tim e entries. The form at of a TIMEACT m ight
look like the following:

ITIMEACT DATE JOB EMF ITEM PITEM DURATION PRO. NOTE

XFERTOPAYROLL BILLINGSTATUS

TIMEACT 3/25/08 ABCompany:Job 123 Bill Williams  Support 02:00
N 1

The TIMEACT fields are:

DATE The date the activity was perform ed, form atted as YYYY-MM-D D (the
standard QuickBooks date exchange form at). This is generally set to the
variable ${Tim eEntry.date}, described below.

JOB The QuickBooks job, whic  hisinthe form at Custom er:Job. This is
generally set to the variable ${Custom er.nam e}.${Projectnam e},
described below.

EMP The nam e of the em ployee. Thisism eantto m ap to the QuickBooks
employee nam e and m ust m atch exactly. Outputted as " Lastnam e,
Firstham e" by default. This is generally set to the variable
${User.nam e} or ${User.fulNam e}, described below.

ITEM The nam e of the service item  assigned to the activity. This is generally
set to the variable ${Task.nam e}, described below.

PITEM The nam e of the payroll item . This is generally set to the variable
${PayCode.nam e}, described below.

DURATION This is the duration of the activity in hours and m inutes, in HH:MM
form at. This is generally set to the variable ${Tim eEntry.hours},
described below.

NOTE This field contains the tim  esheet cell notes. Note that any newline or
tab characters will be replaced with a space on the export. This is
generally set to the variable ${Tim eEntry.notes}, described below.

XFERTOPAYROLL "N"if not for payroll, or "Y" if for payroll.
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BILLINGSTATUS Indicates the billing status of the activity, either " 1" for billable, or "0"
for non-billable. By default populated with the Task billable status. This
is generally set to the variable ${Tim eEntry.billFlag}, described below.
You can control which values from Pacific Tim esheet are substituted into the TIMEACT

records by editing the tem

case-sensitive  ):

plate. The following tem  plate variables are supported (and are

Variable
${Tim eEntry.date}

${Tim eEntry.dateUS}

${Tim eEntry.hours}

${Tim eEntry.notes}
${Tim eEntry.billFlag}

${Custom er.nam €}

${User.name}
${User.fullNam e}
${User.id}

${Custom er.id}

${Projec tGroup.nam e}

${Projec tGroup.id}

${Projec t.nam e}

Description

The date of the tim e entry, form atted as YYYY-MM-D D (the
standard QuickBooks date exc  hange form at). This is generally
used for the D ATE field of a TIMEACT record.

Just like ${Tim eEntry.date}, only form atted as M/D D/YY. Som e
older versions of QuickBooks require this form at.

The tim e entry hours, form  atted as hours:m inutes (the standard
Quic kBooks hours form at). This is generally used for the
DURATION field of a TIMEACT record.

The tim e entry notes, if any. This is generally used for the N OTE
field of a TIMEACT record.
The tim e entry billable flag, with the value " 0" ifthetim eentryis

not billable, or "1" if the tim e entry is billable.

The nam e of the Custom er for this tim e entry. This is generally

used for the JOB or ITEM field of a TIMEACT record. Note that

even if you ¢ ustom ized the term inology and renam ed Custom er to
som ething else (e.g. Client), you still use Custom er.nam e for the
variable nam e.

The nam e of the em ployee, form atted "Lastnam e, Firstnam e". This
is generally used for the EMP field of a TIMEACT record.

The nam e of the em ployee, form atted as "Firstham e Lastnam e".
This is generally used for the EMP field of a TIMEACT record.

The ID of the em ployee. This is generally used for the EMP field of
a TIMEACT record.

The ID of the Custom er for thistim e entry. This is generally used
for the JOB or ITEM field of a TIMEACT record. Note that even if

you custom ized the term inology and renam ed Custom er to
som ething else (e.g. Client), you still use Custom er.id for the
variable nam e.

The nam e of the Projec t Group for thistim e entry. This is

generally used for the JOB  or ITEM field of a TIMEACT record. N ote
that even if you custom ized the term inology and renam ed Project
Group to som ething else (e.g. Client Portfolio), you still use

ProjectG roup.nam e for the variable nam e.

The nam e of the Projec t Group for thistim e entry. This is

generally used for the JOB  or ITEM field of a TIMEACT record. N ote
that even if you custom  ized the term inology and renam ed Project
Group to som ething else (e.g. Client Portfolio), you still use

ProjectG roup.id for the variable nam e.

The nam e of the Projec tfor thistim e entry. This is generally used
for the JOB or ITEM field of a TIMEACT record. Note that even if

you custom ized the term inology and renam ed Project to

som ething else (e.g. Job), you still use Project.nam e for the
variable nam e.
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${Project.id} The ID of the Projec tfor thistim e entry. This is generally used for
the JOB or ITEM field of a TIMEACT record. N ote that even if you
custom ized the term inology and renam ed Project to som ething
else (e.g. Job), you still use Project.id for the variable nam e.

${TaskG roup.nam e} The nam e of the Task Group for this tim e entry. This is generally
used for the JOB or ITEM field of a TIMEACT record. Note that
even if you ¢ ustom ized the term inology and renam ed Task G roup
to som ething else (e.g. Phase), you still use TaskG roup.nam e for
the variable nam e.

${TaskG roup.id} The ID of the Task Group for this tim e entry. This is generally
used for the JOB or ITEM field of a TIMEACT record. Note that
even if you ¢ ustom ized the term inology and renam ed Task G roup
to som ething else (e.g. Phase), you still use TaskG roup.id for the
variable nam e.

${Task.nam e} The nam e of the Task for this tim e entry. This is generally used
for the JOB or ITEM field of a TIMEACT record. Note that even if
you custom ized the term inology and renam ed Task to som ething
else (e.g. Activity), you still use Task.nam e for the variable nam e.

${Task.id} The ID of the Task for this tim e entry. This is generally used for
the JOB or ITEM field of a TIMEACT record. N ote that even if you
custom ized the term inology and renam ed Task to som ething else
(e.g. Activity), you still use Task.id for the variable nam e.

${PayCode.nam e} The nam e of the Pay Code for this tim e entry. This is generally
used for the PITEM field of a TIMEACT record. N ote that even if
you custom ized the term inology and renam ed Pay Code to
som ething else, you still use PayCode.nam e for the variable nam e.

${PayCode.id} The ID of the Pay Code for this tim e entry. This is generally used
for the PITEM field of a TIMEACT record. Note that even if you
custom ized the term inology and renam ed Pay Code to som ething
else, you still use PayCode.id for the variable nam e.

Note that when using the .nam e variables you need to be careful to m atch the nam esin
Pacific Tim esheet with the nam es in QuickBooks. If your nam  esin Pacific Tim esheet cannot
be m ade identic al to those in Quic  kBooks you will want to use the ID field instead. Change
the appropriate tem  plate fields to use the .id variables instead, then update the ID property
of the em ployees, projects or other objects in Pacific Tim esheet with the nam e as it appears
in QuickBooks.

Exporting To QuickBooks

Once you have configured the com pany nam e, com pany create tim e and tem plate as
needed, you can generate the QuickBooks export file. To do this click on the Tim esheets or
Approvals tab in  Pacific Tim esheet and list the tim  esheets you are interested in exporting.
Click the options m enu (the icon button with a sm all triangle to the upper-right of the

tim esheet list) and choose the "Export - QuickBooks" item . Save the resulting file to the
appropriate location on your com puter.

Next, start QuickBooks Pro, then go to the File > Utilittes > Im port> Tim er Activities and
import the file you just saved. Quic kBooks will im port the data and generate a detailed
report of the im  port results. You canim  port data as often as your needs require, but be
careful notto im  port the sam e file twice as QuickB  ooks will generate duplicate tim er
activities.
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Export Options
The Export Options page allows you to configure and schedule autom atic exporting of
employees, groups, projects, tasks and other system object. The data can be exported in

either CSV or XLS form  at, and sent to either a directory (for the self-hosted version only) or
to an FTP server.

Note: Cloud system s support auto-exporting to FTP sites only (via FTP/FTPS protocol).
Self-hosted system s can additionally auto-export to file system directories.

The following options are provided:

Options Description

Schedule If ¢ hecked then the export will autom atically run on a recurring schedule.

Enabled

Schedule The autom atic export schedule, which can be daily at a specified tim e of
day.
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Export To

You have the option of exporting to a directory on the com puter running
the Pacific Tim esheet service (self-hosted only), exporting to an FTP (File
Transfer Protocol) server, orto a D ropbox folder.

If you choose " FTP Server " the following properties m ust be configured by

clicking the settings button that appears to the right of the m enu:
FTP Server The host nam e or IP address of the FTP server.

Login The user account or login nam e for the FTP server.
Password The password for the login, above.

FTP Directory  The directory where export files will be created, e.g. /"
or"/tm p". FTP server paths start with a forward slash,
and bac kslashes are not valid. If blank, the root directory
will be used, which is equivalent to " I".

FTP Port The port num ber for the FTP server, where 21 is the
default value form  ost FTP servers.

FTP Mode Check this option to enable passive m ode, which aids
when transferring files through firewalls.

Security If the FTP server has connection security enabled you will
need to set the appropriate value here. Your options are:

None No connection encryption

Im plicit SSL Im plicit Sec ure Socket Layer
encryption (FTPS)

Explicit SSL Explicit Secure Socket Layer
encryption, also known as (FTPES)

If you choose " Dropbox "youc anexportthe datatoaD  ropbox folder of
your choosing. Clickthe"  Link New Account” button to open a web page

that gives you the option to allow Pacific Tim esheet to access the D ropbox
account (you will be prom  pted to log into D  ropbox if not already logged

in). When you click "Allow" you will be given an authorization code. Select

and copy this code, then switch back to Pacific Tim esheet and enter the
authorization code into the dialog.

Once you have saved the configuration, Pacific Tim esheet will create a
"PacificTim esheet" folder within the "Apps" folderinthe D  ropbox account.
Pacific Tim esheet will only be able to upload files to this folder. You can

further spec ify a sub-folder within this folder: for instance, if you specify a
sub-folder nam ed "exports" then there would be an

"IApps/PacificTim esheet/exports" path created in the D ropbox account,
and all export files would be uploaded to that folder.
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Direc tory

File Nam e

Form at

File Encryption

Status Filter

Tim esheet
Filter

Exported Fields

Custom Header

The directory on the com  puter or FTP server where the export file will be
created. If the "Export To" property is set to " Directory”" then this is the

file path to the directory where the export file will be created, e.g. "/tm p",
"c:\exports” or \\m  orpheus\\c\exports”. The path m ust be valid for the
server that Pacific Tim esheet is installed on.

If the "Export To" property is setto " FTP" then this is the directory on the
FTP server where you want the export file created, e.g. " ["or"tm p". FTP
server paths start with a forward slash, and backslashes are not valid.

If the "Export To" property is set to " Dropbox” then this will be the
optional sub-folder within the D ropbox account to upload the export files
to. The sub-folder will be created directly under the

/Apps/Pacific Timesheet folder of the D  ropbox account. If left blank then
export files will be uploaded to the /Apps/PacificTim esheet folder of the
Dropbox account.

The nam e of the export file, e.g. "em ployees" . The "Append tim estam p"
option will add the date and tim e of the export to the file nam e, e.g.

"em ployees.200908150831". Note that the file extension will autom atically
be added when the export file is created, based on the Form at property,
described below. For CSV form  at, the file extension "  .csv" will be added to
the file nam e. For MS Excel form at, the file extension ".xIs" will be added

to the file nam e.

The form at of the export file, either com ma-separated-values (CSV) or
Microsoft Excel (XLS).

You can optionally encrypt the export file using PG P (Pretty G ood Privacy).
If you choose this option you need to specify the following options:

Encryption K ey The public encryption key to use when encrypting the
export file. Click the settings button to the right of the
menu to im port and m anage your encryption keys. An
encryption key is required.

Arm or Check this option to output the encrypted file in arm ored
ASCII form at, rather than binary form at. The file will
have the ".asc' file extension appended to it.

When the file encryption is set to PG P the export file will have the '.pgp’
file extension appended to the file nam e. Ifthe arm or option is selected
then the file will also have the ".asc' extension added to it, so the export

file will end in .pgp.asc'.

Select a value if you want to only export objects that are active or
inactive.

This appears only for Em  ployee exports. Select a value if you only want to
export em ployees who have atim esheet (thatis, the Tim  esheet property
in their em ployee profile is not blank).

Select the data fields to export, as well as their order.

For som e external system syoum ay want a special header at the
beginning of the export file, rather than the standard list of field nam es.
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Auto-Import Directory

The auto-im port directory provides another way for you to im port data into  Pacific
Timesheet . When CSV files are dropped into the auto-im port directory they will be

autom atically im ported into the system . The form at of the im port files is exactly the sam e
as when you im  port through the web browser. For inform ation about the CSV im  port file

form at see the Im porting/Exporting _ topic.

Note: Cloud system s support auto-im  porting from FTP sites only (via FTP/FTPS protocol).
Self-hosted system s can additionally auto-im  port files from  file system directories.

To set up a directory for auto-im porting you need to configure the following properties:
Property Description
Enabled Check this option to enable auto-im porting.
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Im port From

You have the option ofim  porting from a directory on the com  puter running
the Pacific Tim esheet service (self-hosted only), im porting from an FTP
(File Transfer Protocol) server, or im porting from  a D ropbox folder.

If you choose " FTP Server " the following properties m ust be configured by

clicking the settings button that appears to the right of the m enu:
FTP Server The host nam e or IP address of the FTP server.
Login The user account or login nam e for the FTP server.
Password The password for the login, above.
FTP Directory | The directory where export files will be created, e.g.
"I" or "ftmp". FTP server paths start with a forward
slash, and backslashes are not valid. If blank, the
root direc tory will be used, which is equivalent to " /.
FTP Port The port num ber for the FTP server, where 21 is the
default value form  ost FTP servers.
FTP Mode Check this option to enable passive m ode, which aids
when transferring files through firewalls.
Security If the FTP server has connection security enabled
you will need to set the appropriate value here. Your
options are:
None No connection encryption

Im plicit SSL Im plicit Sec ure Socket Layer
encryption (FTPS)

Explicit SSL Explicit Secure Socket Layer
encryption, also known as (FTPES)

If you choose " Dropbox " you ¢ anim port the data from  a D ropbox folder of
your choosing. Clickthe”  Link New Account” button to open a web page

that gives you the option to allow Pacific Tim esheet to access the D ropbox
account (you will be prom  ptedto log into D ropbox if not already logged

in). When you click "Allow" you will be given an authorization code. Select

and copy this code, then switch back to Pacific Tim esheet and enter the
authorization code into the dialog.

Once you have saved the configuration, Pacific Tim esheet will create a
"PacificTim esheet" folder within the "Apps" folder inthe D  ropbox account.
Pacific Tim esheet will only be able to see files within this folder. You can
further spec ify a sub-folder within this folder: for instance, if you specify a
sub-folder nam ed "im ports" then there would be an

"IApps/PacificTim esheet/im ports" path created inthe D  ropbox account,
and only that folder would be scanned for im port files.
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Direc tory The directory on the com  puter or FTP server from  where the export files
will be im ported. If the "Im  port From " property is setto"  Directory” then
this is the file path to the directory where the im port files will be replaced,

e.g."/tm p", "cAim ports” or "\m orpheus\\c\im ports". The path m ust be
valid for the server that Pacific Tim esheet is installed on.

If the "Im port From " property issetto"  FTP" then this is the directory on
the FTP server from  where you want to read the im port files,e.g.” /" or
"tm p". FTP server paths start with a forward slash, and backslashes are

not valid.

If the "Im port From " property is set to "Dropbox" then this will be the

optional sub-folder within the D ropbox account to scan for im port files.
The sub-folder will be created directly under the /Apps/PacificTim esheet
folder of the D ropbox acc ount. If left blank then files will be scanned for in

the /Apps/PacificTim esheet folder of the D  ropbox account. Im  port files in
folders below the specified sub-folder will be ignored - only the top level

will be scanned.

When Finished | This option determ ines what to do to the file when finished, so that it will
not be reprocessed. The following options are available:

Delete Delete the file after successfully im porting the data.

Rename Renam e the file by appending ".fin" after successfully
importing the data.

File Naming

Im port files need to be nam  ed in a specific way in order for the system to know how to
process it:

1. The flenam emustendis" .csv

2. The file nam e m ust start with the type of objects being im ported, then a hyphen, then
the key field, and finally a hyphen:

objects-keyfield-*.csv
The first part, 'objects’, is the type of objects being im ported, such as em ployees or tasks.
The next part, 'keyfield', is the object property to use to avoid creating duplicates, for
instance nam e orid. The *' is a wild-card indicating that any valid file nam e text can
appear after the hyphen. For exam ple, toim portem ployees using the login nam e as the key
field the following file nam e would be appropriate:

employees-login-m yem ployees.csv

The following tables lists the objects that can be im ported, along with their supported key
fields.

General Im ports:

Object Key Fields Notes
employees login, id, If you renam ed em ployees using the term  inology feature then
email use your plural term  inology, m aking sure to rem ove spaces, if

any, inthe nam e. For exam ple: "resources-nam e-.csv",
"resources-nam e-xyz.csv", etc.
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employeebala
nces

groups
tim esheets

billrates

payrates

Work Breakdown Structure (WBS) Im

Object
custom ers

projectgroups

projects

taskgroups

tasks

Asset Im ports:

Object
assets

assetclasses

(none)

name, id
(none)

(none)

(none)

Key Fields
name, id

name, id

name, id

name, id

name, id

Key Fields

name, id

name, id

No key field needed.

If you renam ed em ployees using the term  inology feature then

replac e 'em ployee' with your singular term inology, m aking sure

to rem ove spaces, if any, in the nam e. Forexam ple:
" " resourcebalances-xyz.csv"

"resourcebalances-.csv", , etc.

e, butifthe im port file
atch to a

No key field is needed in the file nam
specifies the ID  colum n then that will be used to m
possible previously existing entry.

File nam e exam ples: "tim esheets-.csv", "
etc.

No key field needed. For exam
"billrates-xyz.csv", etc.

No key field needed. For exam
"payrates-xyz.csv", etc.

tim esheets-xyz.csv",
ple: " billrates-.csv",

ple:" payrates-.csv",

ports:

Notes

If you renam ed custom ers using the term  inology feature then
use your plural term  inology, m aking sure to rem ove spaces, if
any, inthe nam e. For exam ple: "clients-nam e-.csv" ,
"clients-nam e-xyz.csv", etc.

If you renam ed project groups using the term inology feature
then use your plural term inology, m aking sure torem ove
spaces, if any, in the nam  e. Forexam ple:

"portfolios-nam e-.csv" , "portfolios-nam e-xyz.csv" , etc.

If you renam ed projects using the term  inology feature then use
your plural term  inology, m aking sure to rem ove spaces, if any,
in the nam e. For exam ple: "jobs-nam e-.csv",

"jobs-nam e-xyz.csv", etc.

If you renam ed task groups using the term inology feature then
use your plural term  inology, m aking sure to rem ove spaces, if
any, in the nam e. For exam ple: "phases-nam e-.csv" ,
"phases-nam e-xyz.csv" , etc.

If you renam ed tasks using the term  inology feature then use
your plural term  inology, m aking sure to rem ove spaces, if any,
in the nam e. For exam ple: "activities-nam  e-.csv"
"activities-nam  e-xyz.csv", etc.

Notes

If you renam ed assets using the term  inology feature then use
your plural term  inology, m aking sure to rem ove spaces, if any,
inthe nam e. For exam ple: "jobm aterials-nam e-.csv",

"jobm aterials-nam e-xyz.csv" , etc.

If you renam ed assets using the term  inology feature then use
your plural term  inology, m aking sure to rem ove spaces, if any,
in the nam e. For exam ple: "jobm aterialclasses-nam e-.csv" ,
"jobm aterialclasses-nam e-xyz.csv" , etc.
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assetentries (none) No key field is needed in the file nam e, but if the im  port file
specifies the ID  colum n then that will be used to m atch to a
possible previously existing entry.

If you renam ed assets using the term  inology feature then use
your plural term  inology, m aking sure to rem ove spaces, if any,

in the nam e. For exam ple: "jobm aterialentries-.csv",
"jobm aterialentries-xyz.csv" , etc.

Note that these file nam  ing conventions are case-insensitive!

Logging and Error Handling

An im port log file will be generated in the auto-im port directory, with details about what was
imported, and any errors that m ight have occurred. Up to 7 days of log files will be
generated - older ones will be deleted autom atically.

If any errors occ ur during the im  port, the im port file will be renam  ed by appending ".err" to
the file.
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Barcode Scanner Support

Pacific Tim esheet supports barcode reader software and devices from Codereadr (
codereadr.com ).

Barcode Settings

Settings are system  -wide properties that affect all barcode scanning services:

Property Description

Enable Codereadr ' Check this option to enable support for Codereadr barcode scanning. If

support not enabled then all Codereadr barcode scans will be ignored by Pacific
Tim esheet.

Enable diagnostic | Check this option to enable diagnostic logging. When checked, detailed

logging inform ation on each barcode scan subm itted to Pacific Tim esheet will be
written to the System Event Log. Log entries can be viewed from the

Reports > System > System Event Log report.

Note that this setting is generally used only when initially configuring a
new Codereadr service. It will autom atically turn itself off after 7 days,
to avoid cluttering the system event log.

Barcode Services

Services correspond to Codereadr services. Adm inistrators need to create a service entry in
Pacific Tim esheet for each Codereadr service that will be sending scans to Pacific Tim esheet.
Services have the following properties:

Property Description

Service ID The Codereadr Service ID  (required). When a barcode scan is sent to
Pacific Tim esheet it will identify itself with a Codereadr Service 1D , and
there m ust be a m atching service in Pacific Tim  esheet in order to process
the scan. There are at least a couple of ways to identify the service ID of
your Codereadr service: go to codereadr.com and 1) list your services
(Servic es tab) and click on a service and you will see the Service ID in the
address bar of your web browser, or 2) list your scans (Scans tab) and
click the View Postback Log link below a scan to see the service ID

Active Check this option to enable this service. If not enabled then barcode
scans with this Service ID will be ignored by Pacific Tim  esheet.

Description A description of this barcode service (required, up to 255 characters). The
value you enter here should help you m ore easily identify the
corresponding service in Codereadr, as Codereadr doesn't show service
IDs prom inently.
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Field Mapping Codereadr scans are sent to Pacific Tim esheet as a list of data fields.

These fields m ust be m apped to corresponding Pacific Tim esheet fields. A

typic al m apping m ight look like this:

Codereadr Field/Question | D Pacific Timesheet Field

scanid Scan ID

tid Employee.ID

tim estamp Timestam p

1355861 Punch

1355862 Project.ID

1355863 Task.ID

Note 1: "scanid", "tid" and "tim estam p" are required field m  appings.

Note 2: The Codereadr field nam es are case-sensitive! For instance,
"Scanid" willnot m atch, and m ust be lower-case " scanid" .

Note 3: If certain questions are required, such as the Project, then you

must set the ¢ orresponding field on the em  ployee's tim esheettem plate to

be required. This is done on the System > Tem plates page in Pacific
Tim esheet.
Note: changes to these Pacific Tim  esheet settings can take up to 30 seconds to tak e effect.

Codereadr Service Configuration

Log into codereadr.com  to create your barcode scan service. The type of service you will
create is "Postbac k URL (Real-Tim e)":

Service type  : Postback URL (Real-Time)
Postback URL : <hostname>/timesheet/codereadr

For exam ple, if your Pacific ~ Tim esheet cloud system URL is
https://xyzco.pacifictim esheet.com then the Codereadr postback UR L would be:

https://xyzco.pacifictimesheet.com/timesheet/codereadr

When c reating your service questions , the first question should be the " punch " status
(first to avoid having the keyboard on the phone popping up), and the possible answers
must be " In "or" Out " (case-insensitive).

After specifying your punch status question, you can then have zero or m ore barcode
guestions that would m  ap to a Pacific Tim esheet project, task, etc.

The following Advanced settings are generally also enabled:
[x] Enable Kiosk Mode:
{

"pin":"1234",

"stop_auto_next":"true",
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"manual_input":"true"

}

[X] Enable custom display configuration:

{

"value_label":"Badge",

"response_hidden":"false"

}
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Time Clock Devices

Pacific Tim esheet supports tim e and attendance tracking using hardware access devices,
such as m odels provided by ACTAtek (www.actatek.com ).

The following devices are supported:

Manufacturer

ACTAtek
www.actatek .com

ZK Software
usa.zksoftware.com

Model

PIN

Smart Card
Fingerprint
Combination
PIN

Smart Card
Fingerprint
Facial

RFID

X X X X X X X X X

Devic es have the following properties:

Property
Name

Description

Enabled

Work Codes Are

IP Address

Secure Connection

Login ID
Password

Last Synchronization

Adding Devices

There are two types of tim

Description

The device nam e, up to 80 characters. A value is required and
must be unique.

A description of the device, up to 255 characters.

This determ ines whether the device will be periodically (every
5 m inutes or so) synchronized. Synchronization is where
device attendance inform  ation is converted to em  ployee
tim esheets.

For cloc ks that support entering work codes, this allows you
configure how work codes are m apped to Pacific Tim esheet
objects. For instance, youm  ight want work codestom  apto
tasks.

The TCP/IP address of the device.

This option determ  ines whether a secure or encrypted

connection is used when the Pacific Tim esheet softwar e
synchronizes with the device. For ACTAtek devices this m eans
SSL.

The adm inistrator login ID  for the device. For ACTAtek devices
this is case-sensitive.

The adm inistrator login password. This is always
case-sensitive.

The date and tim e Pacific Tim esheet last successfully
synchronized with the device.

e clocks that Pacific Tim  esheet supports: 1) poll devices and 2)

push devic es. For poll devices (such as ACTAtek) Pacific Tim esheet m ust periodically request
attendance inform  ation by com municating with the tim e clock. In order to do this it m ust
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know the IP address of the tim e clock. Push devices (such as ZK Software) work in an
opposite m anner and send attendance data to Pacific Tim esheet whenever som eone
accesses the device. This requires configuring the device with the address of the Pacific

Tim esheet server.

Push Devices (ZK Software, etc.)

1. The first step will be to install your tim e clock device and configure it with the address of
your Pacific Tim esheet service. Once you have done this and have the tim e clock running, it
will autom atic ally register itself with the Pacific Tim esheet software.

2. Gotothe System > Devices page and you should see an entry for the new clock. For
sec urity reasons, the device will be disabled, and you m ust enable it before it will start
receiving attendance data from the device.

Poll Devices (A CTAtek, etc.)

1. The first step will be to install your tim e clock device and configure its IP address. If you
are using ACTAtek devicesthe = ACTAtek D evices topic has m ore inform ation.

2. Goto the System > Devic es page and click the Add button. Fill in the nam e, address and
other settings as appropriate for the device. You can test the connection by clicking the
"Test Connection" button. When finished click the OK button.

3. If Pacific Tim esheet can com municate successfully with the device you will see a status of
"Ready". If you see otherwise you will generally find the problem to be a network connection
issue (wrong IP address, no network connection, etc.). The first step to troubleshoot the

problem is to issue a "ping”" com  mand from a c onsole on the m achine running the  Pacific
Timesheet software, for exam ple "ping 192.168.0.100"

Synchronization

For poll devices (such as ACTAtek) Pacific Tim esheet will read the attendance inform ation
from each enabled devic e, usually about every 5m  inutes. For push devices (such as ZK
Software) attendance inform ationis sentto  Pacific Tim esheet as they happen. In order for
proper synchronization to work it is necessary for the em ployee's login ID  or PIN for the
device m atc h one of the following 3 em ployee properties in  Pacific Tim esheet :

1. The em ployee login nam e.

2. The em ployee D .

3. The "Tim e Clock ID" custom em ployee field. If the login ID used for the tim e clock is not

appropriate for either the em ployee login or em ployee ID in Pacific Tim esheet , then you can
create a custom text field nam ed"Tim e ClockID " (viathe Em ployeestab> Manage Custom

Fields option). If this field is present then the device synchronization will try to m atch
against this field to find the appropriate Pacific Tim esheet em ployee.
Some devices ¢ anrecord agroup ID  with each attendance record. Each group ID should

have a corresponding group in Pacific Tim esheet with the sam e nam e or ID for proper
synchronization.

Som e devices can record a work code or ID with each attendance record. Each work code or
ID should have a corresponding object in Pacific Tim esheet with the sam enameorID for
proper synchronization. You specify which type of Pacific Tim esheet object m aps to work

codes viathe " Work Codes Are" device property, described above.

Note: You can check for synchronization errors by viewing the synchronization log for each
device. From the System > Devices page click the nam e link to see the details of the
device. At the bottom of the page is the m  ost recent synchronization m essages.
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ACTAtek Devices
First Time Setup

Follow these steps to set up your ACTAtek device for the first tim e. Ifusingm ultipletim e
clocks please see the note at the end of this topic:

1. Connec t the power and network cable to the device. The installation instructions that
cam e with the package cover this in detail.

2. Configure the IP address of the device. You will want to use a fixed (static) IP address.

Press the m enu button on the device, which is the second button down from the top-right
corner of the keypad. You will be prom pted to log in - use the following values:
Login ID A999

Login Password 1

Press the arrow buttons on the bottom row of the keypadtom  ove the selection to the "IP
Setting” m enu, then press the enter button (the lower-right-m ost button on the keypad).

Then ¢ hange the following values:

Subnet Mask The subnet m ask, forexam ple 255.255.255.0

DHCP Turn this off since we are using a fixed IP address

IP Address The TCP/IP address of this device, for exam ple

192.168.0.100

Gateway The default gateway, for exam ple 192.168.0.1
The network protocol used by the ACTAtek device is HTTP/H TTPS,soyoum ayneedtom ake
sure that those ports are allowed if any firewalls are between the device and the Pacific

Timesheet softwar e.

The rem aining setup steps will be perform ed from the device's web-based adm inistration
interface.

3. Using a browser, enter the adm inistration web page address for this device:
http://192.168.0.100

Replac e the IP address above with the value appropriate for yours. Log in as the Super
Adm in with the following values:

Login ID A999

Login Password 1

Login Level Super Adm inistrator

Note that the login ID and password is case-sensitive (whereas for Pacific Tim esheet only

the password is case-sensitive).

4. Click the Term inal Clock link on the navigation panel on the left side of the page. Set the
following values as appropriate:

Date The current date
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Time The currenttim e

Time Zone The appropriate tim e zone for this device

Note: You have the option to use SN TP (Sim ple N etwork Tim e Protocol) to autom  atically
adjust the device's clock. This is not needed, however, as Pacific Tim esheet will

autom atically keep the device clock synchronized.

5. By default the ACTAtek device will record every access as an IN punch. This is useful if
you are using m ultiple devices and your em  ployees m ay punch in on one device but out on
another. If you require your em ployees to punch in and out on the sam e device you should
set the device to record both IN and OUT punches. To do this click the "Authentication/Log
Setup” link on the left side of the page, then enable the " Auto IN/OUT  "and" Auto Reset
IN/OUT " settings.

Adding Employees

Employees (also called Users by the ACTAtek device) are generally best added at the device,
a necessity if using fingerprints. To add a new user to the device follow these steps:

1. Press the m enu button on the device, which is the second button down from the top-right
corner of the keypad. You will be prom pted to log in - use the following values:
Login ID A999

Login Password 1

2. Choose the "Add User"m  enu and press the enter button (the lower-right-m ost button on
the keypad). Your options will include, depending upon the m odel, either fingerprint, sm  art
card or password. Choose the desired authentication m ethod and press the enter key. You

will be asked for a user ID  , which can be up to 20 characters (digits plus the letter A, B or

C). Enter the desired user ID and then follow the instructions for recording fingerprints,
smart ¢ ard inform ation or a password.

3. Using a browser, log into Pacific Tim esheet and create an em ployee to m atch the one just
created on the devic e. Make sure either the em  ployee's Login N ame, Em ployee ID or Tim e
Clock ID field m atches the user ID  entered on the device. The Tim e Clock ID field is an
optional custom field to use when you cannot use the login nam e orem ployee ID fields. To
create this, go to the Em ployees > Manage Custom Fields page and add a new text field

nam ed "Tim e Clock ID".

Note: Itisim portant that the  Pacific Tim esheet em ployee Login Nam e, Em ployee ID or
Time Clock ID field m atch the user ID  on the device, otherwise the em ployee's tim esheet
will not synchronize with the device.

Note: If you replace an old or defective device with a new one, you should also delete the
device entry from  the list and re-add it. Otherwise you m ay find the system  will not
synchronize with the new device.

Note: Using Multiple Time Clocks

When im plem enting m ultiple ACTAtek tim e cloc ks you have two m  ajor configuration
options:

1. Stand Alone Configuration (D efault)
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In this configuration each tim e clock acts as a stand-alone device. In this configuration,
each cloc km ust be individually configured, with users enrolled at each device. Each device
must be added to Pacific Tim  esheet for synchronization.

2. Master/Client Configuration

In this configuration you define one of your tim e clocks as the m aster device. Then every
other device is defined as a client and configured to synchronize with the m aster device. In
this configuration you only need to configure and enroll users at the m aster device. Only the
master device should be added to Pacific Tim esheet for synchronization as it will collect

access logs from the clienttim eclocks.

Note: Do not add ¢ lient devices to Pacific Tim  esheet for synchronization or you will get
duplicate tim esheet data.

Note: R esetting the Super Admin (A999) Password

For security reasons, there is no way to m anually reset the device back to its factory
settings or otherwise reset the Super Adm in (A999) password. If you have forgotten your
Super Adm in password please do the following:

1. Em ail the serial num ber and IP address of the unit to support@actatek.com , letting them
know you want to reset the Super Adm in password. To get the serial num ber and IP address
press the Enter button on the ACTAtek unit six tim es and it will display the inform ation.

2. You will be em ailed a link to a password recovery patch, which will, for security, expire
after 48 hours. D ownload this patch to your local com puter.

3. Open a browser on your local com puter and go to the recovery page of the ACTAtek unit,
as described in the em  ail response from  ACTAtek. For instance:

http://192.168.1.88/cgi-bin/recovery.cgi

4. Upload the recovery patch as per the instructions on this page. Once the upload is
com pleted you will be able to log in as the Super Adm in: A999 with password 1.
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Data Connections

The D ata Connec tions page allows you to review your cloud drive connections for D ropbox
and Microsoft OneD rive. You can configure auto-im port and exports to use these

connections. The D ata Connections page allows you to review and test (and re-authenticate,

if need be) your cloud drive connections, as well as to delete and add connections.

You can also add new data connections from the export options or from the auto-im  port
options pages. New connec tions added from the D ata Connections page will be available for
use from the export/im port options pages, as well.

Note: When authenticating a cloud drive connection, you will be redirected to the vendor's

(e.g. Dropbox's) authentication page. Once successfully authenticated the new connection

will appear in Pac ific Tim esheet. The vendor's authentication page will usually set cookies

that will persist the account nam e/em ail address used for the authentication. If you need

to add additional accounts for the sam e vendor you will have to restart the browser, use

another browser, or even delete ¢ ookies from the vendor's site. Otherwise you m ay end up
bypassing the authentication page without being asked for the account nam elem ail
address.
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System Options

System options are system -wide or global settings, and include the following properties:

using a large grid-style tim esheet.

Crew Mobile App If Crew Tim esheets is enabled you will see the "

following options:

any potential leave of the sam

Diem to be recorded on the m

events.

projects and jobs.

Clicking this allows you to specify settings for users of the Pacific
Timesheet - Crew m obile app (for iOS and Android). You can specify the

system when the crew tim  esheet is uploaded.
Typic ally you would allow paycodes like Sick or Per

leave like Vac ation or Holiday would not generally be
recorded on the m obile app as in offline situations the
mobile app m ight not be aware of such scheduled

Asset Tracking If enabled then asset tracking is available. Asset tracking allows the
recording of m aterial, equipm ent and other types of resources used on

Property Description
Crew Tim esheets If enabled then crew tim  esheets are available. Crew tim  esheets allow
you to quickly record and track tim e for groups (crews) of em  ployees

Note: You can change the term inology '‘Crew' to suit your
organization's needs. The  Term inology topic has m ore inform ation.

Mobile App" options link.

Data Retention How long data entered using the m obile app is stored
on the m obile device. The app is designed to operate
when there is no network connection and therefore
stores crew tim  esheet and asset data on the m obile
device. When a network connection is available it wil
synchronize and upload/synchronize any stored data
to the cloud system . D ata stored onthe m  obile device
will eventually be purged after the num ber of days
specified for data retention (regardless of whether it
has been uploaded or not, though the user will be
notified if un-uploaded data is nearing its purge date).

Enabled Leave Spec ify which types of leave paycodes (if any) will be
recorded on the m obile app. Asthe m obile app|is
designed to work offline, any leave recorded on it will
be assum ed to be accurate and will therefore erase

e paycode on the cloud

obile app. Scheduled

Note: You can change the term inology 'Asset' to suit your
organization's needs. The  Terminology topic has m ore inform ation.
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Location Tracking

Export File EOL

Im port File Blank Values

Enabled Currencies

Picker Button Width

Mobile Picker Fields

If enabled then em  ployee locations will be tracked as they record their
tim e. Chec king the "Location Tracking" checkbox will result in asset
tracking being enabled, and a new asset type nam ed " Location" [
created. You m ay still need to enable / disable the "Location" asset type
for eac h appropriate tim esheet tem plate (on the System > Tem p

page).

As em ployees enter tim e on their tim  esheets (or crew leads enter tin
for crews) a new location entry will be created indicating the location

along with atim  estam p. Subsequent data entry for the sam e day
only result in new location entries if the em ployee's location has ch
by m ore than about 11 m  eters (36 feet). Locations will be m ore a

for devices that have G PS, but a reasonably close location will usually

eing

ates

will
anged
ccurate
be

recorded even using com  puters/tablets without G PS (depending uTon

the OS and web browser).

This setting allows you to specify the type of EOL (End Of Line) character
to use when generating text export files, such as CSV (Com ma
Separated Values) data. What you choose here will depend upon what
external applications you wish to integrate with. Most applications
support the LF (Line Feed) character. However som e Windows
applications do require CR+  LF (Carriage Return and Line Feed)
characters.

Blank num ber and date values are generally ignored in im port file
avoid acc identally clearing out existing values. You can change this
default behavior by choosing the "Don't Ignore Blank Values" option:
when this is set a blank date or num eric value in anim  port file wil
out the appropriate value in the Pacific Tim esheet object.

Select whic h c urrencies are applicable for you organization. Users will
only be able to choose a currency type from the list of enabled
currenc ies. For easiest data entry for your users you should enable as
few currency types as possible so they do not have to navigate a long
menu of options. Enabling or disabling currencies will not affect any
previously entered data: this setting only alters the list of currency types
a user can select when entering, say, and expense entry in a local
currency.

The picker button isthe m  enu button that lets you choose projects,
tasks, expenses, etc. on m  any pages of the application. When used o
pages where real estate is at a prem ium, such as the Crew Tim  es
Expense Sheet pages, itm  ay be helpful to specify am axim um w
order prevent the page from becom ing too wide and unwieldy. The

value you specify is in units of "em ", m eaning the size of the widest
character in the alphabet, e.g. " M" (which is where the nam e "en
comes from ). So if you specify a value of 20 then you are guaranteed to
see at least 20 characters, and generally m any m ore as m ost cha
are notaswide as" M". If avalue is truncated then you can always see
the full value by sim  ply clic king the m enu button.

You can ¢ ontrol how m uch inform ation is displayed in the list of proje
expenses, etc. shown when you search for these item sinthem @
client. Youm ay not want to show the description, for instance, if you

5, t0

clear

n
heet or
dth in

acters

Cts,
bile

prefer to see m oreitem s atonetim e on the screen.
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System/Administrative Tools

System tools are advanced utilities that can be used to perform periodic adm inistrative
tasks, such as re-running leave accruals after m aking a policy change that need to be
applied retroactively, orm  ass-updating tim esheet data that needs to be charged to a
different project or group.

Rerun Accruals Wizard

The Rerun Accruals Wizard is tool that will walk you through reprocessing em ployee leave
accruals for a past period of tim e. You m ight use this wizard after m aking an accrual policy
change that needs to be applied retroactively to a set of em ployees. When the wizard runs

it willrem ove all old acc ruals for the affected em  ployees and date range and generate new
ones based on their current policy settings.

The wizard will collect the following inform ation from you before running:

Rerun Accruals (Wizard)

Policies Select one or m ore em ployee policies with accrual rules that you
wish to reprocess.

Balances Selectone or m ore balances that you wish to reprocess.

Employees This is an optional filter that allows you to lim it the reprocessing
to spec ific em ployees. If you don't specify any em ployees then

ALL em ployees with the selected policies will be reprocessed.

To select an em ployee, start typing a nam eorlID : alist of
matc hing em ployees will appear for you to choose from (you
must type at least 2 characters for the list to show).

Date Range Select the date range over which you want to rerun accruals.
Processing runs from midnight at the start of the date range to
11:59 PM (23:59) at the end of the date range, in the tim e zone
of each em ployee being processed.

Once this inform ation is ¢ ollected you will be given a chance to review all of the settings

before running the wizard. As reprocessing accruals can affect current tim esheet users by
altering their balanc  es, you should only run this wizard during off-peak usage hours, e.g.

after 5:00 PM if m  ost users finish work by then.

Mass Update Wizard

The Mass Update Wizard is tool that will walk you through updating m ultiple tim e and asset
entries for a past period of tim e. Youm ightuse thiswizardtom  ake m ass changes to
project, departm ent, etc. values for historical em ployee data. The wizard will not alter

tim esheet hours or asset entry am ounts, nor will it create or delete tim e or asset entries - it
will only change how those entries are classified. For exam ple, you could use this wizard to
change all tim e recorded against Project 1 to Project 2 for the past 3 m onths.

Note that the Mass Update W  izard does N OT update bill or pay rates and amounts based on
any new values. For instance, if your bill rate depends on the project, and you are mass

updating a new project value, the original bill rates and amounts for the affected records will

be left unchanged.
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Warning: You cannot undo the changes made by the Mass Update Wizard - use
extreme caution when running this wizard and verify every setting before clicking
the Run button!

The wizard will collect the following inform ation from you before running:

Mass Update (Wizard)

'Include’ Fields Specify one or m ore entry field values to determ ine whichtim e
or asset entries will be included in the m ass update. To select a

value start typing a nam eorlD:alistof m atchingitem swill
appear for you to choose from

If you do not choose any value for a particular 'include’ field

then ALL entries will be m  atched for that field. For instance, if
you leave the Project ‘include’ field blank then entries with
[NULL], Project 1, Project 2, etc. project values will m atch.

To select or m atc h the null value, start typing the expression
‘null’ (without the quotes) to see the [NULL] value option. The
[NULL] value will m  atch entries where the particular field was
left unset or blank by the em ployee.

'Set As' Fields Spec ify the new value for the field for the records specified by
the 'Include’ fields property. To select a value start typing a
name or ID: alistof m  atching item s will appear for you to
choose from .

Leave the 'Set As' field value blank for it to be ignored and left
unchanged.

To set the field to a null value, start typing the expression 'null’
(without the quotes) to see the [N ULL] value option. The
[NULL] value will ¢ lear out any previous value the record
contained.

Entry Types If you have assets enabled you can specify whether tim e
entries, asset entries or both types of entries are included in the
mass update. If you do not have assets enabled then you will
not see this option and tim e entries will always only be updated.

Employees This is an optional filter that allows you to lim it the m ass update
to spec ific em ployees. If you don't specify any em ployees then
ALL em ployee records with spec ified 'Include’ field values will be
updated. To selectanem  ployee starttypinganam eorID :a
list of m atching em ployees will appear for you to choose from
(you m ust type at least 2 characters for the list to show).

Date Range Select the date range for the entries to be included in the m ass
update. Processing runs from midnight at the start of the date
range to 11:59 PM (23:59) at the end of the date range, in your
tim e zone (the tim e zone of the system  adm inistrator running
the wizard, notthe tim e zone of the em ployees whose records
are being updated).

Once this inform ation is ¢ ollected you will be given a chance to review all of the settings

before running the wizard. This wizard will process both subm itted (locked) and
unsubm itted entries. If m  ass-updating a date range that has unsubm itted data you should
consider running this wizard during off-peak usage hours, e.g. after 5:00 PM if m ost users

finish work by then.
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Update Bill/Pay R ates Wizard

The Update Bill/Pay Rates wizard is used to update past tim e entries to use the current bill
and pay rate settings. When you save any changes to an em ployee's bill or pay rates the
change takes effec tim mediately, but only for current and future tim esheets. This wizard

allows you to apply the current bill and pay rate values retroactively, without having to
manually adjust individual tim esheets.

The wizard will collect the following inform ation from  you before running:

Update Bill/Pay R ates (Wizard)

Rate Type Select the type of rate you want to update, either B ill, Pay or
Both.

Employees This is an optional filter that allows you to lim it the updating to
specific em ployees. If you don't specify any em ployees then

ALL em ployees with tim e entries in the specified date range will

be reprocessed. To select an em ployee, start typinganam  eor
ID: alistof m atching em ployees will appear for you to choose

from (you m ust type at least 2 characters for the list to show).

Date Range Select the date range over which you want to update the rates.
Time entries that fall within m idnight at the start of the date
range to 11:59 PM (23:59) at the end of the date range will be
updated.

Once this inform ation is ¢ ollected you will be given a chance to review all of the settings
before executing the update. If updating m any users it is suggested you run this wizard
during off-peak usage hours, e.g. after 5:00 PM if m ost users finish work by then.
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License

Enter your lic ense key on this page. After clicking OK your new license will take effect
immediately.

The license lim its how m any active em ployees your system may have. Thereisnolim iton
how m any inactive users you m  ay have, so in general you need never delete term inated
employees, just inactivate their accounts.

If you are hosting the software yourself, a free, non-expiring 10-em ployee license is
generated when installed. This free license does not com e with any technical support. You
can purchase a support contract or a license for m ore em ployees by contacting your Pacific
Timesheet reseller or sales@pac ifictim esheet.com , or visiting www.pacifictim esheet.com .
When ordering a new lic  ense you will be asked to provide the host com puter nam e, which
can be found on System > General > License page.
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System Lists

System lists are collec tions of nam ed values that you can m  odify, such as Em ploym ent
Types. You m ight need to m odify lists when integrating with external system s such as
payroll applications.

Listitem s have the following properties:

Property Description
Name The nam e of thisitem , up to 255 characters.
Value The value for this item |, up to 255 characters.
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Pay Codes

Pay codes are used to categorize tim e entries. For instance youm ight use pay codes like
Regular Tim e or Over Tim e for work tim e entries, and pay codes like Sick or Vacation for
leave tim e entries.

Note: Som e built-in pay codes have special uses, and changes to them should be carefully
considered. For instance, to avoid confusion you would not want to renam e Holiday to
Vacation, or renam e Over Tim e to D ouble Tim e. The following built-in pay codes have

special uses:

Regular Time , Over Time and Double Time are used by the Over Tim e Rules (see the
Policies topic for m ore inform ation).

Flex Time is used by the Flex Tim e Rules (see the Policies topic for m ore inform ation).

Holiday is used when placing holidays onto tim esheets by the Schedule Rules (see the
Policies topic for m ore inform ation).

Note: You can change the term inology for Pay Code, Work and Leave to suit your
organization's needs. The  Terminology topic has m ore inform ation.

Pay codes have the following general properties:

Property Description

Name The pay ¢ ode nam e, up to 80 characters. A value is required and
must be unique for all pay codes.

Description A description for the pay code, up to 255 characters.

ID The pay ¢ ode ID , up to 80 characters. This value is not required,
but if a value is entered it m ust be unique for all pay codes. This
is commonly used for synchronizing with external system s, such
as payroll or accounting.

Status The pay code status, either Active or Inactive. You cannot delete
pay codes that have been used on tim esheets. Setting the

status to inactive will prevent any further use of the pay code.

Type The pay code type, either Work or Leave. This property can only
be changed when creating a new pay code - once a pay code
has been created you cannot change its type.

Note that the term  inology for Work and Leave can be changed
from the General page under the System  tab.

Can Request If ¢ hecked then this pay code can be requested from the
employee's Hom e tab. For instance, youm  ight want the
"Vac ation" pay code to be requested, but it would not m ake

sense for the "Sick”  pay code to be requested.

Note that this option is unavailable for W ork type pay codes: it
is intended for Leave pay codes such as Vacation.

Note that this option is unavailable if the "Don't add to hours
total" option is enabled in the Options dialog (see below). When
this option is enabled the pay code is assumed to be for
non-time data such as per-diem amounts.
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Balanc e Enabled If enabled, a balance will be tracked for this pay code. Leave
hours recorded against this pay code will autom atically be
deducted from the associated balance. The Employee Balances
topic has m ore inform ation.

Note that this option is unavailable for W ork type pay codes: it
is intended for Leave pay codes such as Vacation.

Note that this option is unavailable if the "Don't add to hours
total" option is enabled in the Options dialog (see below). When
this option is enabled the pay code is assumed to be for
non-time data such as per-diem amounts.

Color The color is used on em  ployee calendars when shading days
with leave requests or holidays. Em ployee calendars appear on
the Hom e tab or the Em ployees tab.

Notes Notes about this pay code, up to 2000 characters.

In addition to the above properties, the following advanced options are available by clicking
the Options link in the lower-right corner of the Edit Pay Code page:

Property Description
Has report colum n Checking this option will create a database colum n that will
store the num ber of hours for this pay code for each tim e entry.

This m akes it easy to add a colum  ntotim esheet reports to
display the total for this pay code (otherwise a SQL expression

needs to be used). The drawback is that this will increase

storage requirem ents by a few bytes for each tim e entry, so you
don't want to enable this for m ore than a handful of pay codes.

Don't add to hours total Checking this option will result in any values entered for this
pay code onatim esheet not contributing or adding to the
employee's hours. This is typic  ally used for tracking per-diem
amounts or other non-tim e data.

Note that when this option is enabled the pay code will no
longer be requestable or have a balance.

Permissions
Permissions allow you to restrict which pay codes em ployees can access on their
tim esheets. Em ployees witha Permission Level that gives them  only lim ited viewing

perm ission, for instance, will only be able to access pay codes for which they have been
added to the perm ission list.
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Timesheet Templates

Timesheet tem plates define the type and layout of tim e entry fields forem  ployee

tim esheets. You can ¢ reate any num ber of tim esheet tem plates, which gives you great
flexibility in the types of tim esheets you assign to em  ployees. For instance youm  ight
require hourly workers to record their start and finish tim es, whereas others m  ight just
track total hours.

Timesheet tem plates are assigned to anem  ployee from the Em ployee D etails page. See the
Managing Em ployees topic for m ore inform ation.

Timesheet tem plates have the following properties:

Property Description

Name The tem plate nam e, up to 80 ¢ haracters. A value is required and m ust
be unique for alltem  plates.

Description A description for the tem  plate, up to 255 characters.

Status The tem plate status, either Active or Inactive. You cannot delete
tem plates that are currently assigned to em ployees. Setting the status
to inac tive will prevent the tem plate from being assigned to new
employees.

Time Period The tim e period for thistem plate. The Time Periods topic has m ore
inform ation.

Default This determ ines whether thistem  plate is the defaulttim  esheet

tem plate for new em ployees.

Tim esheet Fields The list of tim e entry fields that appear in the m ain section of the
tim esheet. The fields will appear in the order specified. For each field
you can specify the following options:

Work Only: If ¢ hecked, this field will only be shown on work rows,
otherwise it will be shown on both work and leave rows.

Required: If checked then a value is required for this field. If no value
is provided then tim  esheet will generate an error m essage and will be
prevented from  being subm itted.

Detail Fields The list of tim e entry fields that appear in the D etails section of the
tim esheet. The fields will appear in the order specified. As for
tim esheet fields above, you can specify whether each field is Work
Only or Required.

Total Fields The list of fields that appear in the Totals section of the tim esheet.
The following tim e entry fields are available (as well as any custom fields you m ay have
created):

Property Description

Start The starttim e for the tim e entry. Tim es are entered in the form  at

appropriate for the em  ployee's locale.

Finish The finish tim e for the tim e entry. Tim es are entered in the form  at
appropriate for the em  ployee's locale.

Hours The num ber of hours for the tim e entry. The form  at can be entered in
either dec imal or hh:m m form at.
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Pay Code
Reporting G roup

Custom er
Project G roup
Project

Task G roup
Task

Bill Rate

Bill Am ount

Pay Rate

Pay Am ount

Notes

The pay code for the tim e entry.

The em ployee group associated with this entry. If not entered from the
tim esheet then pulled from the em ployee's profile. Thisvaluem  ay also
be c alled the Cost Centeror D epartm ent, depending upon your
organization (see the  Term inology topic for m ore inform ation).

The custom er for the tim e entry.

The projec tgroup for the tim e entry.

The project for the tim e entry.

The task group for the tim e entry.

The task for the tim e entry.

The bill rate for the tim
the value is pulled from
Options settings. See the

e entry. If not entered from the tim esheet then
the appropriate object as per the Bill R ate
Rate Options topic for m ore inform ation.

The billam ount for the tim e entry. If not entered from the tim esheet
then ¢ omputed as Bill Am ount= Hours x Bill Rate. If entered from the
tim esheet then the Bill Rate will be com puted as Bill Rate =  Bill
Amount / Hours.

e entry. If not entered from the tim esheet
the appropriate object as per the Pay

Rate Options topic form ore

The pay rate for the tim
then the value is pulled from
Rate Options settings. See the
inform ation.

The pay am ount for the tim e entry. If not entered from the tim esheet
then ¢ omputed as Pay Am ount= Hours x Pay R ate. If entered from

the tim esheet then the Pay Rate will be com puted as Pay R ate = Pay
Amount / Hours.

A text field for notes about this entry.

You can also define any num
Timesheet ¢ ustom fields are configured from
Fields page. Once you create the custom

ber of custom fields for use onthe tim  esheet tem plate.
the System > Tem plates > Manage Custom

fields they will show up in the list of available

fields for the tem plate.

You can preview what the tim

esheet will look like by clicking the Preview button on the

Timesheet Tem plate D etails page.

Subtopics

Tim esheet Asset Tracking

Tim esheet Advanced Settings

Tim esheet Subm it Message
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Asset Tracking

If Asset Tracking is enabled (see the Asset Tracking Options __ topic) then you can configure
whic h types of assets can be entered from this tem plate. B eing able to configure which
assets can be entered from the tim esheet tem plate gives you great flexibility in who can

input asset entries in your organization. For instance, you m ay only want to have field crews
keep track of equipm  ent usage, which you could do by giving the field crew their own

tim esheet tem plate with equipm ent entry enabled.
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Advanced Settings

Advanced settings allow you to control som e less com mon aspects of tim e entry:

Property Description

Tim e Entries This option allows you to lim it tim e entries on for thistim  esheet

Allowed tem plate to just work or leave. For instance, if you are only tracking
leave or tim e off you would set this value to "Leave Only" . Ifyou
never record leave then you would set this to " Work Only".

pl64



© 2000-2021, Pacific Timesheet

Time Entry Mode

This determ ines whether the em  ployee enters hours on their
tim esheet (Standard), or use som e other m ode to track their tim  e:

Standard

Percent Tim e Entry

Standard tim e entry in whichem  ployees
enter tim e in hours on theirtim  esheet.

Employees enter theirtim e asa

perc entage of the total tim e they worked
during the tim  esheet period. Both work
and leave tim e can be recorded. Just like
standard tim e entry, tim e can be

alloc ated as percentages against different
projects and tasks.

The system will convert percentages
entered by the em  ployee into actual

hours, based on the em  ployee's
Scheduled Hours Per Week property in
their em ployee profile (if not specified

then 40 hours per week is assum ed). The
employee only sees percentages, but
managers can review or report on both
percentages and actual hours.

Note 1:  Only weekly, bi-weekly and
guad-weekly tim  esheet periods are
supported. This is because entered

perc entages m ust be converted to hours
by the system , which is done using the
employee's scheduled hours per week

property.

Note 2:  Rounding is not supported with
perc enttim e entry - all percentages are
manually entered and can be up to 2
decim al digits. Do not enable the
Rounding Tim e Entry Rule asitm ay
produce odd results.

Note 3: To enforce that 100%  oftim eis
accounted for on an em ployee'stim esheet
you should enable the following 2

Schedule R ules :

[x] Tim esheet hours cannot be greater
than sc heduled hours

[x] Tim esheet hours cannot be less than
scheduled hours

See the Schedule Rules topic form ore
inform ation.

Presence/Absence Tim e | Rather then entering hours, em ployees

Entry

toggle checkboxes on their tim esheet
indic ating which days they worked. They
can have m ultiple rows per day or week
to track work done on different projects

or tasks.
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Attendance Entry If this option is checked then the Attendance Widget will be shown at
the top of the tim  esheet (week view only), as well as on the crew
tim esheet (by adding an In-Out colum n). This option is only useful if
you are not capturing start and finish tim esonthetim esheet itself.
Attendance entry tim  es will be rounded according to the em ployee's
polic y if rounding is enabled (see the Time Entry Rules topic for m ore
inform ation).

There are two attendance widget styles:

Single infout/m eal per  Only one in and outtim e can be entered

day per day for each em ployee. You can
specify whetheram eal was taken by
selecting the num  ber of m eal m inutes
from am enu, or by ¢ hecking a checkbox if
only one m ealtim e is allowed.

Multiple in/outs Multiple punches can be entered per day

(punches) per day for eac h em ployee. R ather than selecting
ameal from am enu or checkbox, the
employee would punc houtforam ealand
punch back in when returning to work.

The following options can be set if the attendance entry widget is

enabled:
Copy attendance hours If ¢ hec ked then attendance hours will be
down to tim esheet carried down to the first row of the
tim esheet whenever attendance is
changed.
Rejecttim esheet if If ¢ hecked then attendance hours m ust
different than tim esheet matc htim esheet hours before the
hours tim esheet can be subm itted.
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Submit and Review Messages

You can ¢ reate a ¢ ustom message that the em ployee is presented with when they subm it or
review their tim  esheet:

Property Description

Subm it Message The custom message to present to the em ployee upon tim esheet
subm it. If blank then no custom message is presented.

Review Message The custom message to present to the em  ployee upon tim esheet

review. Only em ployees with the "Can review m y tim esheet only"
perm ission will see thism  essage.
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Policies

Policies are sets of rules governing the behavior of em ployee tim esheets, leave accrual and
more. You can create any num  ber of policies and assign different policies to different
employees. For instance, youm  ight have one policy for exem pt em ployees titled "Exem pt

Policy", and another policy for hourly em ployees nam ed " Hourly Policy" , each with different
rule settings. Each em  ployee m ust have a policy, which is specified in the Employee D etails
page.

Policies are ¢ omposed of several sets of related rules. This includes Time Entry Rules

Balance and Accrual R ules , Over Time Rules and Flex Time R ules . Policies have the
following properties:

Property Description

Name The polic y nam e, up to 80 characters. A value is required and
must be unique for all policies.

Description A description for the policy, up to 255 characters.

Status The policy status, either Active or Inactive. You cannot delete
polic ies that are currently assigned to em ployees. Setting the
status to inactive will prevent the policy from being assigned

to new em ployees.

Default This determ ines whether this policy is the default policy for
new em ployees.

Policy R ules

Time Entry Rules

Schedule Rules

Flex Tim e Rules

Balanc e and Accrual R _ules
Over Tim e Rules

9/80 Over Tim e Rules
Work Shift Rules

Wage Rules
Absence Points R ules

X X X X X X X X X
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Time Entry Rules

Tim e entry rules can be used to control how m
e entries are rounded or not, and m

tim esheet, whether tim

violated an error will appear on the tim

any hours an em ployee can enter on a
any other options. If any rule is

esheet, and the tim  esheet cannot be subm itted for

approval until the rule violation is corrected.

Hours Checks
tim esheet:

are rules that restric

t how m any hours em ployees m ay enter on their

Rule

Minim um hours per
work day

Maxim um hours per day

Minim um hours per
week

Maxim um hours per
week

Minim um hours per
period

Maxim um hours per
period

Description

The m inim um num ber of hours that should be entered each work

day. This rule is ¢ hecked when the tim esheet is subm itted, and
counts both work and leave hours in the day total. For exam ple, if
you enter 8.00 hours for this value then the em ployee m ust
record 8 hours of work, sick, vacation, etc. for each day of the

work week, or they will not be able to subm it their tim  esheet.
What is considered a work day is determ ined by the em ployee's
Scheduled Work D ays property on theirem  ployee properties

page. See the Managing Em ployees topic for m ore inform ation.

The m axim um num ber of hours (both work and leave) that can be
entered per day.

The m inim um num ber of hours that can be entered per week.
This rule is ¢ hec ked when the tim  esheet is subm itted, and counts
both work and leave hours in the week total.

The m axim um num ber of hours (both work and leave) that can be
entered per week.

The m inim um num ber of hours that can be entered per period.

This rule is only useful for tim esheet periods that are longer than
one week. This rule is checked when the tim esheet is subm itted,
and counts both work and leave hours in the period total.

The m axim um num ber of hours (both work and leave) that can be
entered per period. This rule is only useful for tim esheet periods
that are longer than one week.

Leave Checks
given day:

are rules that restric

t how m any hours of leave em ployees m ay take on any

Rule

[Leave] m inim um hours
per day

[Leave] maxim um
hours per day

Description

If an em ployee puts non-zero [Leave] hours on their tim esheet,
this is the sm allest am ount that can be taken in one day. For
instance, if the em  ployee enters 2.00 hours of Vacation on their

tim esheet, and the m  inim um is set to 4.00, they will see an error
message when saving the tim  esheet, and will need to fix the

entry before they can subm it the tim esheet.

The m axim um [Leave] hours that can be taken in one day. For
instance, if the em ployee enters 9.00 hours of Vacation on their
tim esheet, and the m  axim um is set to 8.00, they will see an error
message when saving the tim  esheet, and will need to fix the
entry before they can subm  itthe tim esheet.
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[Leave] can't be taken The probationary period or num ber of days an em ployee m ust be
until em ployed for employed before they can take [Leave] hours. This rule requires
that the em ployee's "First D ay" property m ust be set in their
employee profile. When this rule is enabled the em ployee will not
be able to m ake [Leave] requests or enter [Leave] on their
tim esheet until after the specified num ber of days of em ploym ent.

In the above table [Leave] m eans any of your configured leave pay codes, e.g. Holiday,
Vacation, etc. You will be able to configure each pay code separately.

Note that if you set the m inim um and m axim um hours described above to be the sam e
value for a given pay code, this im plies the em ployee cannot take a partial day of leave.
When generating a leave request for the given pay code the em ployee will not see the
"Partial Day" option.

Rounding rules allow you to ¢ ontrol whether and how tim e entries are rounded:

Rule Description

Round tim e entries to The num ber of m inutes to round tim e entries to, for exam  ple 15.
If the tim esheettem plate hasthe Start and Finish fields, then
the start and finish tim  es will be rounded. If the tim esheet
tem plate has only the  Hours field then the hours will be rounded.

Note that if you want to keep track of the original or unrounded

start and finishtim  es you needto add the "  Actual Start and
Actual Finish " custom fields, as described in the note below. You
canalsoadd a" Disable R ounding " checkbox custom field to turn

off rounding for an individual tim e entry.

Rounding Mode How rounding is done, either Nearest, Round Up or R ound D own.
Nearest:
The Nearest rounding m  ode will round the start and finish tim e of
a punch to the nearest rounding increm ent. For exam ple, if

rounding isto 15 m  inutes then 8:07 will round to 8:00 and 8:08

will round to 8:15. For tim esheets that are only recording hours

(no startffinish tim  es) then the hours entered will be rounded to

the nearest rounding value, instead of the start and finish tim es.

Round Up

The Round Up rounding m  ode will round the start and finish tim e
of a punch to the next rounding increm ent. For exam ple, if
rounding isto 15 m  inutes then 8:01 will round to 8:15 and 8:16

will round to 8:30. For tim esheets that are only recording hours

(no startffinish tim  es) then the hours entered will be rounded to

the next rounding increm  ent, instead of the start and finish tim es.

Round Down

The Round Down rounding m  ode will round the start and finish

tim e of a punch to the prior rounding increm ent. For exam ple, if
rounding isto 15 m  inutes then 8:14 will round to 8:00 and 8:16

will round to 8:15. For tim esheets that are only recording hours

(no startffinish tim  es) then the hours entered will be rounded to

the prior rounding increm  ent, instead of the start and finish

tim es.
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Round punch-in to
scheduled start tim

Round punch-out to
scheduled finish tim

e

e

Checking this option will round punch-ins to the em ployee's
scheduled start tim e if the punch is within the specified m inutes
of the sc heduled starttim e. For exam ple, if you specify that

punches 15 m inutes or less before the scheduled start tim e be
rounded to the start tim e, and the em ployee is scheduled to start

at 9:00AM, then a punc  h of 8:50AM will be rounded to 9:00AM.
However, a punch of 8:40AM will not be rounded. This rule is

useful if you want to prevent em ployees from recordingm ore
than their scheduled num  ber of hours, even if they com einafew
minutes early.

If the regular rounding rule is also enabled (for exam ple, round
punches to the nearest 15 m inutes), then the regular rounding
rule will only run if the punch does NOT fall within the specified
minutes of the scheduled start tim e.

The em ployee's sc heduled start and finish tim es are specified in
their profile. See the  Managing Em ployees topic for m ore
inform ation.

Checking this option will round punch-outs to the em ployee's
scheduled finish tim e if the punch is within the specified

minutes of the scheduled finish tim e. For exam ple, if you specify
that punches 15 m inutes or less after the scheduled finish tim e be
rounded to the finishtim e, and the em ployee is scheduled to

finish at 5:00PM, then a punch of 5:10PM will be rounded to

5:00PM. However, a punch of 5:20PM will not be rounded. This

rule is useful if you want to prevent em ployees from recording
more than their sc  heduled num ber of hours, even if they leave a

few m inutes late.

If the regular rounding rule is also enabled (for exam ple, round
punches to the nearest 15 m inutes), then the regular rounding
rule will only run if the punch does NOT fall within the specified
minutes of the scheduled finish tim e.

The em ployee's sc heduled start and finish tim es are specified in
their profile. See the ~ Managing Em ployees topic for m ore
inform ation.
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Note: If you want to preserve the original or unrounded start and finish tim es you need to
add the following tim  esheet custom fieldsto Pacific Tim esheet :

Custom Field Type Description

Actual Star t Time This field holds the unrounded or original start tim e of
day.

Note that you m ust create this field exactly as

nam ed, "Actual Start" , in order to create the expected
underlying database field (t_tim eentry.xactualstart).
After ¢ reating the field you can then renam e it as this
will not affect the nam e of the underlying database
field.

Actual Finish Time This field holds the unrounded or original finish tim e
of day.

Note that you m ust create this field exactly as
nam ed, "Actual Finish", in order to create the
expected underlying database field

(t_tim eentry.xac tualfinish). After creating the field
you can then renam e it as this will not affect the
nam e of the underlying database field.

Disable Chec kbox This is optional and is only needed if you want to be
Rounding able to turn off rounding on a per-entry basis on a
tim esheet. After creating this custom field you can

add the ¢ heckbox to the tim e entry details, giving you
the option to turn off or disable rounding for an

individual tim e entry. The "disable rounding"

checkbox will only work if you also have the "Actual

Start" and "Actual Finish" tim e fields, describe above.

Note that you m ust create this field exactly as

nam ed, "Disable Rounding", in order to create the
expected underlying database field

(t_tim eentry.xdisablerounding). After creating the

field you can then renam e it as this will not affect the
nam e of the underlying database field.

Timesheet ¢ ustom fields are configured from the System > Tem plates > Manage Custom
Fields page. It is not required that you put these fields on the tim esheet tem plates

them selves - their value will still be filled in and you can report on them like any other
tim esheet field.

Meal Deduction rules allow you to autom  atic ally deduct m ealtim e from punches:

Rule Description
Autom atic meal Check this option to autom  atically deduct the specified m inutes
deduction from tim e entries. You m ight specify, for instance, that 30

minutes are deduc ted from tim e entries thatare 8 orm  ore hours.
This is done by splitting the tim e entry into two parts, and taking

the deduc tion from the m iddle of the tim e entry. In this way the
employee's start and finish tim es, if entered, are always

preserved.
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Apply to entries at least If autom atic meal deduction is enabled then you need to specify
the sm allest punch that getsam  eal deduction. For instance, you
may only wantam eal deduc tion for tim e entries that are 8 hours

or larger.
Maxim um deduc tions You can lim it how m any autom atically generated m eal deductions
per day an em ployee is allowed per day with this setting.
Note that the punc  h having the m eal deducted will be split into two punches, with a m eal
break in the m iddle. In this way the punch in and out tim es are preserved. The m  eal will fall

in the m iddle of the punch, starting at the nearest whole hour.

Splitting  rules are som etim es needed for certain payroll applications:

Rule Description
Autom atic midnight Check this option if you want punches that span m idnight to be
split split into two punches - one ending on m idnight and one starting

at m idnight. This will prevent hours that are worked after
midnight from  being booked to the tim  esheet period in which the
punch was started.

Default Timesheet rules control whic  htim esheet period an em ployee is presented with
when they log into  Pacific Tim esheet :

Rule Description

Default Tim esheet Check this option if you want to change the default tim esheet
period that loads when an em ployee logs in. Norm  ally the current
tim esheet is presented, but you can alternatively have the
previous tim esheet, if not subm itted, be presented. The

mandatory option is for cases where you want the em ployee to fill
out and subm it their previous tim  esheet before m oving to a new
one.

Miscellaneous  rules:

Rule Description

Don't allow subm itting Check this option to enable an additional check when the

tim e for inactive tim esheet is subm itted that prevents em  ployees from subm itting

Projects, Task s etc. tim e for inactive item s such as projects or tasks. Pacific
Tim esheet already prevents users from choosing inactive item s
when adding new rows to their tim esheet, and will not carry
forward inactive rows if using the "tim esheet m emory" or" copy

previous tim esheet" features. H owever, this rule does an extra
check to catch any item s that m ight have been inactivated after
any rows were added to the tim esheet.

For objects such as Projects and Tasks that have Actual Start

Date and Actual Finish Date properties, this rule will take those
values into consideration. For instance, an error will be presented

to a user if they try to save a tim e entry for a date that falls after
a project's last day, regardless of whether the project's status
property is currently set to active or inactive.

Note that this rule will only run for the previous and current
tim esheet periods to avoid difficulty if am anager retroactively
edits an older tim  esheet.
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Autofill

Autofill will autom  atically add work hours to a tim esheet when it
is subm itted to m ake it m atc h the em ployee's scheduled hours.
For this to work the em  ployee's scheduled hours per week
property m ust be set in their profile. The adjustm ent work entry
will be added to the last day of the tim esheet period.

This setting is useful for salaried em ployees who m ay be only
tracking leave, but the back-end payroll system requires their
total hours total to, say, 40 each week
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Schedule R ules

Schedule rules can be used to prevent em
they are scheduled for. You set an em

page.

ployees from entering m ore or less hours than
ployee's scheduled hours from the Employee D etails

The following rules can be configured:

Rule

Tim esheet hours cannot be
greater than scheduled
hours

Tim esheet hours cannot be
less than scheduled hours

Add Holidays to tim  esheet

Add Leave requests to
tim esheet

Don't allow subm itting of
Leave requests with
conflic ting or overlapping
dates

Don't allow subm itting of
Leave requests if balance
falls below m inim um

Description

Requires the em ployee to putnom ore than their scheduled
num ber of hours on the tim  esheet. The tim esheet cannot be
subm itted until they correct this.

Requires the em ployee to put no less than their scheduled
num ber of hours on thetim  esheet. The tim esheet cannot be
subm itted until they correct this.

If checked then any  Holidays the em ployee can take will be
put on their tim  esheet autom atically. N ote that if a holiday
falls on a day the em  ployee is not scheduled to work, no
hours will be added to the tim esheet. What is considered a
work day is determ ined by the em ployee's Scheduled Work
Days property on their em  ployee properties page. See the
Managing Em ployees topic for m ore inform ation.

If checked then approved Leave R equests will be put on the
employee's tim esheet autom atically. Note that if leave falls

on a day the em ployee is not scheduled to work, no hours

will be added to the tim  esheet for that day. What is

considered a work day is determ ined by the em ployee's
Scheduled Work D ays property on theirem  ployee properties
page. See the Managing Em ployees topic form ore

inform ation.

If ¢ hec ked then em ployees will not be able to subm it leave
requests that conflict with other leave requests they m ay
have subm itted for the sam e dates.

If ¢ hec ked then em ployees will not be able to subm it leave
requests that if the balance for the selected pay code (e.g.
Vacation) would fall below the m inim um allowed. If the pay
code has no balance associated with it then this setting is
ignored. The m inim um balance allowed is specified on the

Balanc e and Accrual R ules page.
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Flex Time R ules

Flex Tim e Rules allow you to autom  atic ally accrue hours into the Flex Tim e balance when
employees work m ore than a specified num  ber of hours in a day or week. This allows
em ployees to 'bank’ these hours for use on later days.

Note: You can change the nam  efrom Flex Time to whatever you prefer (for exam ple
Comp T ime ) by sim ply renam ing the Flex Tim e pay code on the System > Pay Codes
page. You will be warned against m odifying a built-in pay code, but renam ing this will not
cause any problem s unless you have previously created work flows (such as tim esheet
exports) that rely on this nam e.

The following rules can be configured:

Rule Description
Daily work hours If enabled, then total work hours over this threshold in a single day
over will result in hours being added to the Flex tim e balance. The num ber

of hours added depends on the Accrual Rate  (see below). For
exam ple, if the daily threshold is 8 and the accrual rate is 1.5, then an
em ployee who works 10 hours in one day will have 3.0 hours added to
their Flex Tim e balance.

You can override this daily threshold to specify values for each day of

the week, too. For instance, you m ight specify a threshold of zero for
Saturday and Sunday in order that any weekend work adds to the
employee's Flex Tim e balance.

You can cap how m any hours over the threshold can contribute to the
flex tim e balance by setting the Maximum Hours value next to each

daily threshold. For instance, if the em ployee works a total of 5 hours
over the threshold, but the m axim um is 4, then only (4 x Accrual
Rate) hours will be added to the Flex Tim e balance.

Weekly work hours If enabled, then total work hours over this threshold in a single week
over will result in hours being added to the Flex tim e balance. The num ber
of hours added depends on the Accrual Rate  (see below). For
exam ple, if the weekly threshold is 40 and the accrual rate is 1.5,
then an em ployee who works 42 hours in one week will have 3.0
hours added to their Flex Tim e balance.

This rule is proc essed after any daily rules, so that hours will not be
double counted. That is, any daily lim its will be processed first, and
any hours over the daily lim its will not add to the weekly total.

You can cap how m any hours over the threshold can contribute to the
Flex Tim e balance by setting the Maximum Hours value next to the
weekly threshold. For instance, if the em ployee works a total of 5
hours over the threshold, but the m axim um is 4, then only (4 x
Accrual Rate) hours will be added to the Flex Tim e balance.
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Period work hours
over

Accrual R ate

If enabled, then total work hours over this threshold in a tim esheet
period will result in hours being added to the Flex tim e balance. The
num ber of hours added depends on the Accrual Rate  (see below). For
exam ple, if the period threshold is 80 and the accrual rate is 1.5, then

an em ployee who works 82 hours in the tim esheet period will have 3.0
hours added to their Flex Tim e balance.

This rule is proc essed after any daily and weekly rules, so that hours

will not be double counted. That is, any daily and weekly lim its will be
proc essed first, and any hours over those lim its will not add to the
period total. This rule is only useful for tim esheet periods that are

longer than one week.

You can cap how m any hours over the threshold can contribute to the
Flex Tim e balance by setting the Maximum Hours value next to the
period threshold. For instance, if the em ployee works a total of 5
hours over the threshold, but the m axim um is 4, then only (4 x
Accrual Rate) hours will be added to the Flex Tim e balance.

The m ultiplicative fac tor used to determ  ine how m any hours will be
added to the balance for every work hour over the specified lim it. For
instance, if the ac  crual rate is 1.5 and the em ployee works 2 hours
over the lim it, then 3.0 hours will be added to the balance. The

accrual rate value defaults to 1.0, but can be any positive value.

_O_
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Balance and Accrual R ules

Balanc e and ac crual rules control how balance lim its and accruals are handled. B alances are
associated with  Pay Codes , and ¢ an be enabled from the Pay Code properties page.

Note: If autom atic accruals are enabled and you are not seeing the accruals you expect,
please refer to the troubleshooting section below.

The following rules can be configured for each enabled balance:

Rule Description

Minim um Balanc e The m inim um value for this balance, in hours. Em ployees will
be alerted when their tim esheet puts a balance below this
value, and they will not be able to subm it the tim esheet.

Maxim um Balanc e The m axim um value for this balance, in hours. The balance

will be capped at this value. Note that if accrual is enabled
(see below) this option will instead be entered in the accrual
table.

Enable Accrual Enables autom atic accrual on this balance. Autom atic accrual
means the system  will autom atically accrue hours and
perform rollovers to the em  ployee's balance on a regular
interval.

Accrual Period If accrual is enabled you should choose the appropriate
accrual period. The ac  crual will happen before m  idnight on the
last day of the period, m  aking it available for the first day of
next period. You ¢ an choose from any period you have defined
in the System > General > Tim e Periods page, as well as the
following special tim e periods:

Hourly - For Every H  our Worked

Hours are ac crued before m idnight on the last day of the
tim esheet period, based on the num ber of work hours
recorded on the tim  esheet. The accrual calculation is
perform ed when the tim  esheet is subm itted.

Yearly - Employee anniversary

Hours are ac crued at end of the anniversary year, in which
the anniversary year starts on the m onth and day of the
employee's first day of em  ploym ent. For instance, if the
employee started working on March 28, 2012, then
anniversary years would look like:

March 28, 2012 to March 27, 2013
March 28, 2013 to March 27, 2014
etc.

The ac crual would occur before m  idnight on March 27 of each
period for this em  ployee.

When you enable accrual an accrual rate table will appear. You can specify accrual rates,
etc. that vary by the num ber of years em ployed (if you don't have values that vary for the
num ber of years em ployed then you will only need one row in the accrual table). You can
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click the Add button to add as m
have the following properties:

any rows as you need. Each row in the accrual table can

Property
Years Em ployed

Accrual R ate

Max. Work

Maximum

Rollover

Description

The num ber of years of em ploym ent that this rate starts to
take effect. If you only have one row in your accrual table

this property will be hidden and default to zero, m eaning the
rate will apply to allem  ployees using this policy, regardless of
their years of em ploym ent.

The num ber of years of em ploym entis determ ined by the
employee's First D ay property (see the  Employees topic for
more details). If the em  ployee's first day is not set then it is
assum ed to be zero years.

The ac crual rate for this balance, in hours. Accruals will be
autom atically granted before m  idnight on the last day of the
specified accrual period.

This ¢ olum n only appears if the accrual period is set to

"Hourly - For Every Hour Worked". This is the m axim um
num ber of work hours to consider when calculating the

accrual, for exam ple 40 for a weekly tim  esheet period, or 80
for a biweekly tim  esheet period. Leave this value blank if

there is no maxim um.

The cap or m axim um hours the balance can reach. Leave this
value blank if there is no m axim um.

The m axim um hours that ¢ an be carried forward each rollover
period for this balance. The balance will be capped at this

value just before m idnight on the last day of the rollover

period (generally D ecem ber 31, but you can choose any
rollover period you need to, as described below). Leave this
value blank if there is no rollover.

You can specify several accrual/rollover options:

Rule

Description
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Rollover Period If a rollover value is specified in the accrual table (described
above), you should choose the appropriate rollover period (it
will default to Yearly starting on January 1). The rollover will

happen before m idnight on the last day of the period, m aking
it effective for the first day of next period. You can choose

from any period you have defined in the System > General >
Tim e Periods page, as well as the following special tim e
period:

Yearly - Employee anniversary

Rollover happens at end of the anniversary year, in which the
anniversary year starts on the m onth and day of the
employee's first day of em  ploym ent. For instance, if the
employee started working on March 28, 2012, then
anniversary years would look like:

March 28, 2012 to March 27, 2013
March 28, 2013 to March 27, 2014
etc.

The rollover would oc  cur before m idnight on March 27 of each
period for thisem  ployee.

Rollover/accrual This c ontrols whether the rollover runs immediately before  or
sequencing immediately after an acc rual that would fall on the sam e
date.

For instanc e, if you are using annual accrual and annual

rollover they will both occur on the last day, before m idnight
on Dec ember 31. You would likely want the rollover to

happen just before the accrual, otherwise the em ployee would
start the new year with no balance.

However, if your acc  rual period is m onthly, you m ight prefer
the rollover torun  just after the accrual, essentially acting as
a sort of cap.

How the sequenc ing of ac crual and rollover is handled varies,
so you will have to set this based on your organization's
requirem ents.

Move Excess Rollover If you specify a non-blank rollover value, you can have excess

Hours To hours (hours over the rollover value) be added to a separate
balanc e. For instanc e, you m ight set the annual rollover for
the 'Sic k Leave' balance at 0.00, and have any left-over hours
be added to an 'Extended Sick Leave' balance.

Forecast only If this option is checked then no accrual will actually be added
to the em ployee's balance. The accrual settings will only be
used in forecasting an em  ployee's available hours when
requesting leave (for instance from the H ome > New Leave
Request page). You would only want to check this option if
you are im porting or sync hronizing your balances from an
external payroll or HR system (that is, an external system is
calculating your accruals).

Troubleshooting Automatic Accruals

If you are not seeing the expec ted accruals or rollovers for your em ployees please review
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the following troubleshooting steps before contacting support:

1. Make sure that the em ployee has the correct policy in their em ployee profile, and that the
polic y has accruals enabled.

2.If no ac crual is happening, m ake sure the "Forecast only" option is not checked. Also
make sure the correct accrual rate is specified in the accrual rate table.

3. If the acc rual is happening but an incorrect rate is being used, m ake sure the correct
"First Day" property is set in the em ployee's profile.
4. For non-yearly accrual periods, em ployees who have been em  ployed for less than one

accrual period (forexam  ple, an em ployee started a week ago but the accruals happen every
month) will not trigger an acc rual. That is, the system will not give them  a partial or
pro-rated ac crual for working a partial accrual period. You can always specify an initial

balanc e for the em ployee if need be, from  the Current B alances section of theirem  ployee
profile page. For yearly accrual periods the accrual will happen even if the em ployee has
been em ployed less than one year. For these em ployees you can pro-rate or provide a

partial acc ruals by specifying accrual rates for partial years.

5. Understand that the accrual or rollover is not generated until the last day of the period,

just before m idnight. Any ¢ hanges you m ake to an em ployee's accrual rules will not take

effect until the end of the subsequent accrual or rollover period. If you add a new em ployee
whose first day is before the current date, you m ay need to specify an initial balance as the
system will not go bac kintim e and generate past accruals and rollovers.

6. This is for self-hosted custom ers only: As the system  generates accruals and rollovers

just before m idnight at the end of the period, you need to m ake sure the Pacific Tim esheet
service is running. If you shut down the com puter or service at night then the accruals or
rollovers m ight not happen. You can shut down or restart the com puter for m aintenance
needs, but in general you want to leave it running overnight in order for the accruals,

rollovers and other background processes to run.

7. There m ight be cases where you need to rerun accruals and rollovers for a past period of

tim e for a large num ber of em ployees. Pacific Tim esheet has a utility to rerun your current
accrual settings for a past tim e period. Please contact support@pacifictim esheet.com fora
solution docum ent outlining how to use this utility to rerun past accruals and rollovers.
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Over Time Rules

Over tim e rules allow you to autom atically ¢ ompute over tim e and double tim e on em ployee
tim esheets.

Note: Make sure you do not turn on both the regular over tim e rules and the 9/80 over
tim e rules for the sam e policy. There should be at m ost ONE type of overtim e rules
enabled for a policy.

The following rules can be configured for overtime and double time
Rule Description
Daily work hours over Any work hours over this am ount in a single day will be

marked as over tim  e. You can override this value and specify
individual values for each day of the week, too.

Weekly work hours over Any work hours over this am ountin aweek willbe m  arked as
over tim e, after the daily rule is processed.

Period work hours over Any work hours over this am ountin atim esheet period will be
marked as over tim e, after the weekly rule is processed. This
rule is only useful for tim  esheet periods that are longer than
one week.

Note that rules are processed in the above order, and that double tim e rules are processed
after all over tim e rules are processed.

The following rules can be configured to handle consecutive days

Rule Description

Consecutive days rules The num ber of consecutive days of work before the

start after consec utive days rules are applied. This can include days

worked prior to the current week (the "consecutive days"
option), or only consecutive days with the work week (the
"consecutive days in a work week" option).

Work hours over [ ] are Any work hours over this am ount on a consecutive day will be
Over Tim e over tim e.

Work hours over [ ] are Any work hours over this am ount on a consecutive day will be
Double Tim e double tim e.

The following rules can be configured to handle holiday work

Rule Description

Work hours on 'holidays' If ¢ hecked then work hours on 'holidays' will be converted to

over tim e (or double tim e, depending upon your selection).
'Holidays' are any days with hours for the selected pay codes
(by default sim ply the Holiday pay code).

Partial day holidays are also handled by the holiday work rule. A day is considered to be a

partial day holiday if the num ber of holiday hours is less than the em ployee's scheduled
hours. For exam ple, if an em ployee is scheduled to work 8 hours and has a holiday of 4
hours, then it is expec  ted that the em ployee would work 4 hours. Only work hours beyond
the 4 hours will be converted to over tim e.
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Options allow you specify additional tim e entry pay codes that you would consider as
regular work hours. For instance, som e organizations consider H  oliday hours to contribute to
the total regular hours. If so, you would add the Holiday pay code to the list.

Example

As an exam ple, here is how California, U.S. over tim e rules would be configured:

Over Time Rules:
[X] Daily work hours over [ 8.00]
[X] Weekly work hours over [40.00]

Double Time Rules:
[x] Daily work hours over [12.00]
[x] Weekly work hours over [60.00]

Consecutive Days Rules:

[X] Consecutive days rules start after: [6] [consecutive days in a work week]
On those consecutive days:
Work hours over: [ 0.00] are Over Time
Work hours over: [ 8.00] are Double Time
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9/80 Over Time R ules

9/80 or com pressed schedules allow em  ployees to work m  ore hours in the first 9 days of a
10 day (two week) work period, then take the last day off. For instance, rather than working
40 hours each week, em  ployees could work 44 hours in the first week, then 36 hours in the

second week, with that final Friday off. If you have em ployees working a com  pressed 9/80
work schedule you will want to use the 9/80 Over Tim e Rules rather than the regular Over
Time Rules . The 9/80 rules will correctly com pute overtim e for com pressed weeks, taking

into ac count hours worked in the previous week.

In addition to affec  ting how OT is ¢ alculated, em ployees with 9/80 Over Tim e Rules enabled
will also see changes to the following:

- Com pany holidays that fall on the Friday off will have not hours pushed onto tim esheets
for that Friday.

- Leave requests that fall on the Friday off will not have any hours pushed onto tim esheets
for that Friday.

- The Scheduled Work Days in the em ployee's profile is ignored if they are using the 9/80
Over Tim e Rules.

Note: You cannot enable both the regular Over Time Rules and the 9/80 Over Time
Rules for the sam e policy. There can be atm  ost ONE type of over tim e rules enabled for a
policy.

The following rules can be ¢ onfigured for com puting over tim e:

Rule Description

Weekly Hours The m axim um num ber of work hours per week considered
"regular tim e", for exam ple 40. Work hours over this value in a
single week will be ¢ onsidered over tim e.

Note that you can include certain types of leave hours as

"regular tim e" with respect to reaching the m axim um. For
exam ple, you m ight want Holiday hours to contribute to the over
tim e calc ulation. See the Leave property below for m ore
inform ation.

Midpoint The tim e and day of the week that is considered the end of the
week (or the m idpoint of the two week cycle), for exam ple Friday
12:00 noon. This defines the com pressed week - any hours
recorded beyond this will be counted for the next week (whether
work or leave). The selected day is usually taken off on the
second week of a two week  cycle.

Note: This only applies to em ployees entering start/finish tim es
on their tim esheets.

Day Off The 'Friday' in the two week cycle that is considered the day off.
Typic ally this would be the 'Friday’ in the 2nd week.

In c ases where your em ployees all have the sam e biweekly pay
cycle, but you don't want to have everyone off on the sam e
Friday, you would create 2 policies: one with the 1st Friday off

and another one with the 2nd Friday off. You would then assign

the appropriate policy to em ployees that work those schedules.
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Holiday Work

Callout Work

Leave

If an em ployee records hours on a day with holiday hours then
that day is considered holiday work. If you pay em ployees a
different rate for those hours then you m ay prefer to assign
those holiday hours to another pay code of your choosing, for

exam ple "Holiday Work".

The list of pay codes available is lim ited to work pay codes. See
the Pay Codes help topic forinform ation on creating new pay
codes.

Depending on how payroll is processed, you m ight want to avoid
double-paym ent of "holiday work" hours and "holiday" hours.
Consider an em ployee tim esheet that has 9 hours of Holiday and

2 hours of work on Tuesday, for a total of 11 hours. Rather than
sending 11 hours to payroll you can send 2 hours of holiday work

and 7 hours of holiday for a total of 9 hours by using the Holiday
Backout option. You can back out an equivalent am ount of
holiday hours for eac  h hour of holiday work. This is configured in
the Options dialog (see below).

Callout work is forem  ployees who m ay be called to work at

rem ote loc ations periodic ally to do "callout"  work - work that is
outside of the norm  al day-to-day work done at their norm al
location. This work ¢ ould oc cur during norm  al work hours, or
after work hours. If you pay em ployees a different rate for those
hours then you m ay prefer to assign those callout hours to

another pay code of your choosing, for exam ple " Callout Work" .

The list of pay codes available is lim ited to work pay codes. See
the Pay Codes help topic for inform ation on creating new pay
codes.

In order to specify that the tim e entered on the tim  esheet is
callout work you will need to define a tim esheet tem plate
custom field  nam ed " Callout ", then assign this custom field to
the appropriate em ployee tim esheet tem plates. The type of the
custom field m ust be either "Chec  k Box" or "List". You would

norm ally use a ¢ heck box, butm ight use a list if you have m ore
than one type of callout work for the em ployee to select.

Note: The custom field MUST be nam ed exactly " Callout"
(without the quotes, case-sensitive) the first tim e you create it
(in order for the database colum nnam e to be created correctly),
but once you save the custom field you can afterwards edit it

and renam e it to anything you prefer (the database colum n
nam e will not change).

You can optionally include specific leave pay codes in the

overtim e c omputation. For instance, you m ight want holiday
hours to be considered as work for the purpose of com puting
overtim e. For exam ple, if you add H oliday to the list of leave that
contributes to overtim e then working 41 hours up to the Friday
midpoint would give you one hour of overtim e whether all of
those hours were work or som e were work and som e were
Holiday.

You would not generally add H  oliday to the list of leave that
contribute to overtim e if you are already specifying the Holiday
Work rule, above.
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If you click the "Options" link in the lower-right corner of the 9/80 Over Tim e Rules page
you can specify the following optional properties:

Rule
Holiday Overtim e

Holiday Backout

Callout Mapping

Callout Minim um

Description

If the em ployee would have rec  eived overtim e hours during the
day of the holiday for the work done, you can optionally have

those overtim e hours placed in the specified pay code, for

exam ple "Holiday Work OT".

The list of pay codes available is lim ited to work pay codes. See
the Pay Codes help topic forinform ation on creating new pay
codes.

Depending on how payroll is processed, you m ight want to avoid
double-paym ent of "holiday work" hours and "holiday" hours.
Consider an em ployee tim esheet that has 9 hours of Holiday and

2 hours of work on Tuesday, for a total of 11 hours. Rather than
sending 11 hours to payroll you can send 2 hours of holiday work

and 7 hours of holiday for a total of 9 hours by using the Holiday
Backout option. You can back out an equivalent am ount of
holiday hours for eac  h hour of holiday work.

You can specify two ways that holiday hour deductions are
processed:

1. Deduct one hour of Holiday for every hour of work that occurs
on the sam e day.

2. Deduct one hour of Holiday for every hour of work that occurs
on the sam e day, as long as the work was done during scheduled
work tim e. The scheduled work tim e is specified by the
scheduled start/finish tim  esin the em ployee's profile.

If you are using a List custom field instead of a Check B ox
custom field then you need to specify the pay code for each list

item that you want the callout hours to go to. For exam ple, a
callout with two list choices m ight look like this:

Callout List Item | Pay Code

Callout | CO
Continue From Callout | COC

You m ay want to specify am  inim um num ber of hours an
employee is granted when doing callout work. For instance, you
might grant em ployees a m inimum of 4 hours of ¢  allout work
even if they only record 1 hour of actual work.

This m inim um is only granted if the callout occurred outside of

norm al work hours (as specified in by the em ployee's scheduled
start/finish tim e in their em ployee profile). You can extend what

is c onsidered norm al work hours by spec ifying the num ber of
minutes before/after their schedule that is still considered

norm al work hours. For exam  ple, if you spec ify 120 m inutes (2
hours) before/after as norm al hours, then anem  ployee with a

start/finish of 8AM-5PM would really have a norm al work hour
schedule of 6AM-7PM. Callout hours starting on 6AM or later and
starting before 7PM would not be granted the m inim um hours.
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Exem pt Mode Cap regular tim e to 40 hours per week with no overtim e. Thisis
intended for salaried em  ployees who work a com  pressed
schedule. They can record asm  any hours as they worked, even
if over the standard 9/80 schedule, but will receive no overtim e.

Test Mode Unlike other less ¢ omplex rules, 9/80 Over Tim e rules run only
when a tim esheet is subm itted. Check this option to run 9/80
Over Tim e rules on save, too. This will stay active for a
maxim um of 7 days then turn itself off autom atically, to avoid
adversely affecting system perform ance.

Important configuration notes:

1. If em ployees are not recording in/out tim es (just hours) then you need to specify the
employee's " Scheduled Start" property in their profile for the ¢ ompressed overtim e rule
to work properly. This is also true if you are including leave in overtim e calculations. The
scheduled start value is specified on the Em ployees properties page for each em ployee (or
can be set in bulk via an im port file).

2. Ifincluding leave in your overtim e calculations you need to enable the database colum
for eac h leave pay code included. This is required in order for any split leave (leave that

falls on the m idpoint) to be stored properly. You enable the database colum n by editing
each appropriate pay code on the System s> Pay Codes page, clicking the Options link in
the lower right corner, and checking the " Has report column " property.
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Work Shift Rules

Work shift rules are used to ¢

ompute how m any hours an em ployee worked fall into each

defined work shift. Before setting up your work shift policies you need to define your work
shifts, on the System > General > Work Shifts page. The  Work Shifts topic has m ore

inform ation.

When ¢ onfiguring your work shift rules you can specify the following properties:

Rule
Enabled Shifts

Shift Hours Depend On

Description

This is the list of enabled work shifts for this policy. Work
shifts are global objects, but you can selectively
enable/disable different ones for each policy. For instance,
you m ight have two different night shifts: one from
10PM-6AM for em ployees at one location, and one from
12AM-8AM at another location. You can then create two

polic ies and enable the appropriate night shift for each policy.

This property determ  ines how a work tim e entry has its hours
associated with the appropriate work shift. The possible
options are:

1. Each Shift Worked

Hours are proportioned into each shift that the tim e entry falls
on. For instance, if all 8 hours are worked in Shift 1 then all 8

hours are assoc iated with Shift 1. B ut, instead, if half the

work was in Shift 1 and the other half in Shift 2 then each

would get 4 hours.

2. Largest Shift Worked

All work hours are put into the work shift that had the m ost
hours. For instance, if an em ployee worked 8 hours, with 2
hours in Shift 1 and 6 hours in Shift 2, then Shift 1 would get

zero hours and Shift 2 would get 8 hours.

3. First Shift Worked

All work hours are put into the first work shift. For instance, if
an em ployee worked 8 hours, with 2 hours in Shift 1 and 6
hours in Shift 2, then Shift 1 would get 8 hours and Shift 2
would get zero hours.
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Wage Rules

Wage rules help keep you in com pliance with governm  ental rules regarding m  issed m eals,
split shifts and other work issues affecting em ployee wages and benefits.

Automatic Missed Meal Premium
Also c alled a"m issed m eal penalty"”, the autom  atic m issed m eal prem ium rule allows you to

credit an em ployee with regular tim e hours (the prem ium) for every m issed m eal in a block
of work. The following properties are supported:

Property Description

Add The num ber of regular hours (the prem ium) to add for every
missed m eal, for exam ple 1.00. These hours are added to the
regular tim e pay code for the tim e entry that incurred the
missed m eal.

For every The m inim um num ber of ¢ ontinuous hours thatm  ust be
worked before am eal is considered m issed, for exam ple 5.00.
Any hours worked over this value without a m eal break will
trigger the m issed m eal penalty.

Waive If Waives the second m issed m eal if hours worked are over this
value. If hours worked are over twice this value then no waive
occurs. A blank value m  eans no waive occurs.

Minimum Meal The m inim um num ber of hours that constitute a m eal, e.g.
0.5 (30 m inutes).
Adjust regular hours If c hecked the m issed m eal hours (the prem  ium) will be

added to the regular tim e hours for the tim e entry.

Adjust pay am ount If c hecked the pay am ount will be increased by the m issed
meal hours (the prem ium) * pay rate for the tim e entry.

Note: Only one m issed m eal prem ium will be ¢ omputed each day.

The additional regular hours or prem ium is added to the em  ployee's regular hours for the
appropriate tim e entry. Also, the pay am ount for that tim e entry will be increased by the
appropriate am ount (regular hours xem  ployee's pay rate).

To m ake it easier to report on m issed m eal prem iums, you can optionally define the
following two custom  tim esheet fields: "Meal Penalty Hours" and "Meal Penalty".

The " Meal Penalty Hours " field is the num  ber of regular hours (the prem ium) added. This
isa number field, and is ¢ reated from the System > Tem plates > Manage Custom Fields
page. You m ustnam e the field exactly as shown (without the quotes). Once you have

created the field, you can later edit it and change the nam e if desired without affecting
operation.

The " Meal Penalty "is the prem ium (num ber of regular hours added) m ultiplied by the
employee's pay rate. This is a currency field, and is ¢ reated from the System > Tem plates
> Manage Custom Fields page. Youm ustnam e the field exactly as shown (without the
quotes). Once you have created the field, you can later edit it and change the nam e if
desired without affecting operation.

If you want to waive the m issed m eal calculation for a day you can create a checkbox
custom field nam ed " Meal Penalty Waiver "and put it on the tim esheet details. If checked
foratim eentrythathasam issed m eal prem ium (visible by the com ment added), then the
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prem ium will be rem oved. Youm ustnam e the field exactly as shown (without the quotes).
Once you have created the field, you can later edit it and change the nam e if desired
without affecting operation.

Calculation N otes

Meal penalties are com  puted using a California lab law approach in which total work hours

are divided into blocks of, in the ¢ ase of California, 5 hours. This can result in som ewhat
surprising behavior. For instanc e, let's suppose an em  ployee works the following hours in a
day:

In Out Hours
9:00AM 12:00PM 3.00
12:45PM 6:45PM 6.00

You m ight expect that the em ployee would be granted a m issed m eal prem ium for the
second punch as it exceeds 5 hours. This would not be the case, however. The first 5 hour

work block starts at 9:00AM and goes to 2:45PM (accounting for the m eal break from
12:00PM to 12:45PM). As there was am eal break in that 5 hour block no penalty is granted.
The next 5 hour block starts at 2:45PM (not 12:45PM!). As the em ployee clocked out at

6:45PM there are only 4 hours in this block, so no penalty is granted.

Missed Meal Prem ium Exam ple

A typic al exam ple would be that of California:

Add: 1.00

For Every: 5.00
Waive If:

Minim um Meal: 0.50

To waive the sec ond m eal in California the configuration would be:

Add: 1.00

For Every: 5.00
Waive If: 6.00

Minim um Meal: 0.50

Automatic Split Shift Premium

The autom atic split shift prem  ium rule allows you to credit an em ployee with extra pay (the
prem ium) for every split shift worked. A split shift is one in which a day's work is divided

into two or m ore parts separated typically by at least one hour. The following properties are
supported:

Property Description

Shift separation The num ber of hours between two work shifts that, if greater
than this value, would indicate a split shift. In other words, if
two work shifts in a single day have a tim e separation greater
than this value then they are considered a split shift.

Minim um wage The m inimum wage used in ¢ omputing the prem ium. The
prem ium is com puted according to the following form ula:

Premium = M - ((E - M) x H)

Where M = Minim um pay, E = Employee's hourly rate and H =
the num ber of hours worked.

p190



© 2000-2021, Pacific Timesheet

The additional pay or prem  ium is added to the em ployee's pay am ount for the appropriate
tim e entry.

To m ake it easier to report on split shift prem ium s, the additional pay or prem ium is also
added to atim esheet custom field nam ed " Split Shift Premium ". You can create this field
from the System > Tem plates > Manage Custom Fields page. You m ust create a currency
field nam ed exactly as shown (without the quotes). Once you have created the field, you

can later edit it and change the nam e if desired without affecting operation.

If you want to waive the split shift calculation for a day you can create a checkbox custom
field nam ed " Split Shift Waiver "and putitonthetim  esheet details. If checked for a tim e
entry that has a split shift prem ium (visible by the ¢ omment added), then the prem ium will
be rem oved. You m ustnam e the field exactly as shown (without the quotes). Once you

have created the field, you can later edit it and change the nam e if desired without affecting
operation.

Split Shift Exam ple:

A typic al exam ple would be a shift separation of 1 hour. Let's presum e an em ployee works
two shifts with m  ore than 1 hour between them , for exam ple:

8:00AM - 12:00PM - 4 Hours
2:00 PM - 6:00PM - 4 Hours

If the em ployee has a pay rate of $10.00/hour, and the m inim um wage is set to
$12.00/hour, then the prem ium or additional wage would be:

Premium = 12 - ((10 - 12) * 8) = 28

The em ployee would gain an additional $28.00 pay.
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Absence Points R ules

Absence points rules will autom atically ¢ ompute dem erit points based onem  ployee
tardiness and absence. You can tailor the rules so that different points can be added based
on ¢ oming in late, leaving early, or for different types of absences (e.g. excused sick leave
might be given different points than unexcused sick leave).
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Absence points rules require the ¢

fields:

Custom Field

Absence Points

Absence R eason

Absence
Override

Absence Extra
(Optional)

Warning Type

Type

Num ber

List

Check Box

Text, Tex t
Area, List

Text, List

onfiguration of the following custom tim esheet tem plate

Description

This field holds any absenc e points incurred. The num  ber
of decim al digits depends upon your needs - if you allow

frac tional points then you will want to set an appropriate

num ber, e.g. 2. Note that you m ust create this field

exactly as nam ed, " Absence Points", in order to create

the expected underlying database field

(t_tim eentry.xabsencepoints). After creating the field

you can then renam e it as this will not affect the nam e
of the underlying database field.

This field allows m anagers to specify an absence reason
for leave taken by em  ployees. For instance, youm  ay
have the reason "Excused" for excused absence, and the
reason "Unexc used" for unexcused absence. Each reason
can result in different points being added (see the

Absence rule below). Note that you m ust create this field
exactly as nam ed, " Absence Reason", in order to create
the expected underlying database field

(t_tim eentry.xabsencereason). After creating the field

you can then renam e it as this will not affect the nam e
of the underlying database field.

Note that the list of reasons can have different absence

points ¢ onfigured for each reason. If you add or renam e
any of the reasons in the list you will need to edit the

points again in the absence rule. See the Absence rule
below for inform  ation on how to configure points for each
absence reason.

This field provides a way for the m anager to override or
manually enter absenc e points on em ployee tim esheets.
By ¢ hec king the Absence Override check box the

manager can change or enter points into the Absence

Points field. Note that you m ust create this field exactly

as nam ed, "Absence Override" , in order to create the
expected underlying database field

(t_tim eentry.xabsenc eoverride). After creating the field

you can then renam e it as this will not affect the nam e
of the underlying database field.

The Absence Extra fieldis  optional and can be used to
record additional inform  ation about the absence. For
exam ple, you m ay provide a list off additional reasons

for the absence, e.g. Medical Appointm ent, Plant Injury,
etc. Alternatively, you could sim ply have it be a text
area for entering additional details about the absence.

Note that you m ust create this field exactly as nam ed,
"Absenc e Extra", in order to create the expected

underlying database field (t_tim eentry.xabsenceextra).
After c reating the field you can then renam e it as this
will not affect the nam e of the underlying database field.

This field allows you specify that a warning was given to

the em ployee, and is generally a list of values such as

Verbal, Written, etc. N ote that you m ust create this field
exactly as nam ed, "Warning Type", in order to create the
expected underlying database field

(t_tim eentry.xwarningtype). After creating the field you

can then renam e it as this will not affect the nam e of the
underlying database field.
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The following absence rules can be configured:

Property Description

Absence rule If enabled then points will be added when leave hours are entered
on the tim esheet. The num ber of points added depends on the
selected Absence R eason. For instance you m  ight configure O

points for the reason "Excused" , and 5 points for the reason
"Unexcused". If no reason is selected then no points will be added
by the rule.

Note that if the list of absence reasons is changed (by editing the
Absence R eason custom field), then the points will need to be
entered for any new or renam ed absence reasons.

In-late rule If enabled then points will be added depending upon how m any
minutes late the em ployee cam e in. The em ployee m ust have the
Scheduled In property set in their profile in order for this rule to
work. You can enter m  ultiple levels of points, e.g. 2-5m inutes= .5
points, 6-15m inutes late = 1 point, etc.

Out-early rule If enabled then points will be added depending upon how m any
minutes early the em  ployee left. The em ployee m ust have the
Scheduled Out  property set in their profile in order for this rule to
work. You can enter m  ultiple levels of points, e.g. 2-5m inutes= .5
points, 6-15m inutes late = 1 point, etc.

Too-few-hours rule If enabled then points will be added depending upon how m uch
less than the scheduled hours of work were perform ed in any given
day. The scheduled hours will be taken from the Scheduled Hours
Per Day property inthe em  ployee's profile, if set, or from the
default Hours Per Day  property on the System > General page.

Points can be configured in two ways based on the " Use percent of
scheduled hours" check box. If this check box is checked then how

many points are incurred will depend upon the percentage of

scheduled hours worked, for exam ple 0-50% = 1 point, 51-99% =
.5 points and 100% = 0 points.

If the "Use percent of scheduled hours" check box is not checked

then the points incurred will depend upon the num ber of m inutes
early the em ployee left, forexam ple 2-5m inutes= .5 points, 6-15
minutes = 1 point, etc.

Too-long-m eal-break If enabled then points will be added depending upon how m any

rule minutes beyond the specified m eal break the em ployee takes. A
meal is considered any gap m  ore than 15 m inutes long between
two bloc ks of work. If thereism  ore than one gap between blocks

of work in one day then the longest one is assum edtobethem eal
break.
Note that what is considered a day is determ ined by the

employee's Scheduled Start and Scheduled Finish tim es (as
specified in the em  ployee's profile on the Em  ployees tab). For a
typic al 9AM to 5PM schedule a day is from midnight to m idnight.
For som eone working the late shift the day will be centered over

their sc heduled start and finish tim es, som ay run from 12 Noon to
12 Noon. In this way the system will not inadvertently consider a
meal break to be the end of a day's work.
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The following global options can be set:

Property
Default reporting
period

Minimum/maximum
total points allowed in
period

Description

The default tim e period to use when reporting em ployee absence
points. This can be overridden by the person viewing the report,
but is handy to ensure that the various reports default to an

appropriate date range for your business, such as " Last 365 D ays".
Note that the absence points shown on the Hom e tab will always
be for the default reporting period. If the em ployee wants to view

points for other periods they can click the points link to view a
details report and change the reporting period.

Enter non-blank num  eric values if you want to keep absence points
for em ployees from going below or above specified values. For
instance, if you do not want absence points to be less than zero

you would enter "0" for the "m inim um total points allowed" field.
Note that the m  inim um and m axim um values do not affect the
individual absence point entries the em ployees receive. Instead,
the m in/m ax rule is used when ¢ om puting the total absence points
for an em ployee when you run the Absence Points report on the
Employees > Absence Points page.

As an exam ple, suppose an em ployee had accum ulated the
following absence points over the current year, and no m inim um
total points were specified:

Date Points Total Points

Jan 1 1.00 1.00
Mar 3 -2.00 -1.00
Feb 7 1.00 0.00
Apr22 1.00 1.00

1.00

The total for the year if no m inim um is set would be 1.00. If you
now specify am inim um total points of 0.00 then you get the
following total points:

Date Points Total Points

Jan 1 1.00 1.00
Mar 3 -2.00 0.00
Feb 7 1.00 1.00
Apr22 1.00 2.00

2.00

As you can see, the total points is now 2.00, but the individual
points entries were not altered.
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Warning Threshold The num ber of points beyond which you will be suggested to give a
warning to the em  ployee. For exam ple, if you specify 5.0 points as
the warning threshold then any em ployee with m ore than 5.0
points will be m arked as needing review. If you wanted 5.0 to
trigger a warning then your threshold should be set to 4.99.

Warnings will not be autom  atically sentto em ployees. Instead,
when an em ployee's points are greater than the warning threshold

then the "Warning Ac  tion" colum n on the Absence Points

dashboard will show "Review", indicating the em ployee m ay need
to be warned by theirm  anager. If warned then the m anager would
then use the Absence Points dashboard to record the event.

Adjusting Points

Managers and adm inistrators ¢ an view and adjust absence points for individual em ployees.
This is done by viewing the Absence Points dashboard on the em ployee's profile page (note
that the Absence Points dashboard only appears for em ployees that have the Absence Points
Rules enabled on theirem  ployee polic y). B y clicking the Add Adjustment button you can
enter positive or negative absence points for specific dates. Adjustm ents can be deleted by
clicking the delete  [-] button on each adjustm  ent row on the dashboard.
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Security

The security page allows you to control security-specific application settings, such as
authentication and password policies. Security has the following properties:

Property
Expire Idle Sessions After

Authentication Type

Description
The num ber of m inutes of inactivity allowed before a login
expires.

Multiple types of authentication are supported through a
pluggable authentication architecture. The following
authentication types are provided in the base product
package:

Standard Authentication

LDAP/Active D irectory Authentication
SAML 2.0 Authentication

Okta Authentication

Onelogin Authentication

Ping Identity Authentication

X X X X X X

Refer to the appropriate topics below for m ore inform ation on

configuring these authentication types.

Standard Authentication

Standard authentic

ation provides basic login m

anagem ent and strong password support

from with the applic ation - no external authentication sources are required. Passwords are

stored sec urely in the database using a one-way encryption algorithm

. Standard

authentication has the following properties:

Property
Maxim um Invalid Login
Attem pts

Maxim um Password Age

Maxim um Password
History

Minim um Password Length

Minim um Lower Case
Characters

Minim um Upper Case
Characters

Minimum Num eric
Characters

Description

The m axim um num ber of invalid login attem pts before the
account is locked. Locked accounts m ust be either unlocked
by an adm inistrator, or can be unlocked by the user by
requesting a new tem  porary password. To disable this feature
enter a blank value.

The num ber of days before em  ployees are asked to create a
new password. To disable this feature enter a blank value.

Password history keeps em  ployees from reusing previous
passwords. Enter the num  ber of passwords you want to keep
in the history, or blank to disable this feature.

The m inim um num ber of ¢ haracters allowed in new
passwords. To disable this feature enter a blank value.

The m inim um num ber of lower case charac ters allowed in new
passwords (a..z). To disable this feature enter a blank value.

The m inim um num ber of upper case characters allowed in
new passwords (A..Z). To disable this feature enter a blank
value.

The m inim um num ber of num eric characters allowed in new
passwords (0..9). To disable this feature enter a blank value.
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Minim um Spec ial The m inim um num ber of special characters allowed in new
Characters passwords (for exam ple ,$#,% ). To disable this feature enter
a blank value.

Other Authentication T ypes

LDAP/Active D irectory Authentication
SAML Authentication

Okta Authentication
Onel ogin Authentication
Ping Identity Authentication

Related Topics

X Permission Levels
X Permission Lists
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Permission Levels

Permission levels have the following properties:

Property Description

Name The nam e of the perm ission level, up to 80 characters.
Description A description of the perm  ission level, up to 255 characters.
Status The status determ ines whether the access level appears in

lists or not. This is useful if you cannot delete an access level
because it is in use by one or m ore em ployees.

General object perm issions include:

Permission Description
View Determ ines whether an em  ployee with this perm  ission level
canview all or alim ited subset of the objects. If set to lim ited

then the em ployee m ust be assigned to the individual objects
you wish them  to see.

Report Determ ines whether an em ployee with this perm  ission level
canreporton all oralim ited subset of the objects. If set to
limited then the em  ployee m ust be assigned to the individual
objec ts you wish them  to report on.

Manage Determ ines whether an em  ployee with this perm  ission level
can m anage all or alim ited subset of the objects. If set to
limited then the em ployee m ust be assigned to the individual
objec ts you wish them  to m anage. Managem ent perm issions
inc lude:

Edit Can change properties of the object.

Edit Advanced Can change advanced properties of the
objec t, which generally m  eans anything
involving bill, pay and other m onetary rates
and am ounts.

Create Can create new objects of thi s type.

Delete Can delete objects of this type.

Im port Can im port objects of this type.

Export Can export objects of this type.

Custom ize Can m anage custom fields for objects of

this type.

Note that Leave Requests do not have any sub-perm issions
for Manage, unlike m  any other objects in the system . The
‘Can Manage' perm ission effectively gives the user the ability
to view leave requests in a read-only form at on the Leave

Requests tab. You m ight use this perm ission if you want to
allow som e em ployees to see leave requests for planning
purposes, but prefer other em ployees do the approvals.
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Approve Determ ines whether an em  ployee with this perm  ission level
can approve all or alim ited subset of the objects. If set to
limited then the em ployee m ust be assigned to the individual
objects you wish them  to approve.

Timesheet Special Permissions

There are som e spec ial tim esheet perm issions:

Permission Description

Canview m ytim esheet If not ¢ hecked, the "My Tim esheet" tab will not be shown,
even if the em ployee has atim esheettem plate in their
employee profile. This perm ission is useful for sim  plifying the
user interfac e forem ployees whom eet all of the following

criteria:
1. They are not recording work hours
2. They are not required to subm it their tim  esheet

3. They are only using the Leave Request feature on the
Home tab to record leave

4. Theirem ployee polic y's Schedule Rules is configured to
add leave requests to their tim esheet

Can undo subm itofm y This applies to tim  esheet objects only, and determ ines

tim esheet whether an em ployee can unsubm it (unlock) theirtim  esheet.
Note that once atim  esheet has been approved the em ployee
will not be able to unsubm it it, regardless of this perm ission.

Note that this perm ission also works in conjunction with the
"Can review m ytim esheet only” perm ission (see below). If
both are checked than the em ployee will be able to review
their tim esheet in aread-only m  anner, and will be able to
"undo" and ¢ hange their review.

Can copy m vy previous This perm ission determ ines whether em ployees can have

tim esheet hours tim esheet m emory carry forward hours from the previous
tim esheet (this is set from the H ome > Preferences page).
This perm ission also determ ines whether the em  ployee sees a
"Copy Previous Tim esheet" option on their tim esheet. If this
perm ission is off then the em  ployee can only carry forward or
copy rows from the previous tim esheet.

Note that if you turn this perm ission off, butan em ployee has
already set theirtim  esheet m emory to carry forward rows and
hours, you will need to also change their tim esheetm emory
setting from Employees page.

Can punch from tim e clock | Turning this perm ission on will allow an em  ployee to only
device only punch infout from  atim e cloc k device, ensuring their physical
presence. The em ployee will not be able to punch in/out from
a web browser. The em  ployee will still be able to add leave to
their tim esheet using a web browser, however.
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Can edit m y punches

Canreview m ytim esheet
only

This applies to tim  esheets only, and determ  ines whether an
employee can edit work tim e entries on theirtim  esheet. If
this perm ission is not enabled then:

X Employees will not be able to edit the start, finish or hours
fields of their work rows m anually.

X Employees will not be able to delete work rows from their
tim esheets.
X Employees will not be able to delete their tim esheet.

Employees will still be able to change the project or pay code,

enter notes, etc. of work rows. Also, this perm ission does not
affect leave rows - em  ployees will be able to add leave rows

to their tim  esheet.

This perm ission allows em ployees to see theirtim  esheets in a
read-only view, and gives them the ability to review the tim e
entered for them . They can then accept the tim esheet or
report a problem . This is useful forem  ployees working in

crews where a site m  anager enters tim e for them

Tim esheet reviews can only be done by the em ployee, and
must happen BEFORE the tim  esheet is subm itted (locked).
The review is stored in the tim esheet notes field. Managers
can see the reviews from  the Tim esheets and Approvals tabs
with clear icons indicating whether the em ployee accepted the
tim esheet or reported a problem

Note 1: The em ployee review icons are only shown for
unsubm itted (unlocked) tim  esheets. Once subm itted, the
review ic ons are no longer shown (as the tim esheet is
considered proc essed), but the review inform ation is still
available in the tim  esheet notes field.

Note 2: If you want to allow the em ployee the ability to

"undo" their review, check the "Can undo subm itofm y

tim esheet" perm ission (see above). They will be able to undo

and change their review until the tim esheet is subm itted
(locked) by their m  anager. However, they will not be allowed

to undo the subm it of the tim esheet, as the review perm  ission
only allows read-only access to the tim esheet.

Leave Request Special Permissions

There are som e spec ial leave request perm  issions:

Permission

Can create m y leave
requests

Description

Employees with this perm  ission enabled (m eaning they have
this perm ission enabled for the perm  ission level in their
employee profile) will be able to create new leave requests for

pay codes they are allowed to access (based on their pay code

‘Can view' perm ission). They will also be able to delete leave
requests they created as long as they have not been m arked
as approved. To delete an approved leave request it m ust first
be unapproved by an approver.
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Can create for approvees

Employees with this perm  ission enabled (m eaning they have
this perm ission enabled for the perm ission level in their

em ployee profile) will be able to create (and delete) leave

requests forem ployees. The listof em ployees they can do this
for depends on their 'Can approve' leave request perm ission,
as well as whether they are assigned as approvers to any
employees in theirem ployee profiles.

Note that this perm  ission requires the 'Can approve'
perm ission be enabled as a pre-requisite.
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Permission Lists

A perm ission lists is a set of users and groups given special perm issions to access an object.
This is useful in larger organizations where you want to distribute som e of the application
managem ent tasks to m ulitple em ployees. Another use isto lim it which objects, such as
projects, tasks or paycodes, that an em ployee can view and add to their tim esheets.

_0_
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LDAP/Active Directory Authentication

LDAP/Active Directory authentication allows you to authenticate em ployees againstan LD AP
(Lightweight D irectory Access Protocol) server. This includes Microsoft Active D irectory when
it is configured with LD AP support (see the notes below).

LDAP/Active Directory authentication has the following properties:

Property
LDAP Server

LDAP Server Port

Use SSL

Login

Password

Search B ase

Search Filter

Description
The host nam e or IP address of the LD AP server.

The port num ber of the LDAP server. The default port num ber is
389 (or 636 if using SSL).
Check this option if you want to connect to the LD AP server

using SSL (Secure Socket Layer). This option will increase your

sec urity by encrypting all com munications between the

tim esheet applic ation and the LD AP server. Your LD AP server
must be configured for SSL for this to work.

The login nam e of a technical or adm inistrative user, if thisLD AP
server requires authentic  ation. Depending upon your directory

server a sim ple login nam e might work, such as "D  irectory
Manager", or you m ight need to enter a distinguished nam e such
as

"CN= ADMINISTRATOR,CN= USERS,DC=PACIFICTIMESHEET,DC=
COM". Note that for som e Active D irectory installations you need

to enter this in upper-case.

Another variant for Active D irectory is of the form
adm in@pacific tim esheet.com . This is the SAM accountnam e
followed by the dom  ain of the Active D irectory server.

The login password.

The LDAP searc h base, which determ ines where a search for
employees will start. This is a distinguished nam e (D N), such as
"DC= pacifictim esheet,D C=com".

The LDAP searc h filter, which is used to find em ployees in the
directory. The value depends on the type of directory server and
how it is configured. For m  any open source LD AP servers the
following will work:

(&(objec tClass= inetOrgPerson)(uid= {0}))

For Microsoft Active D  irectory the following will generally work:

(&(objec tClass= user)(sAMAccountNam e={0}))

Logging Check this option to help troubleshoot authentication failures.
Errors are logged to the System Event Log, and can be view with
the Reports > System Event Log report. For self-hosted system S
you can also view detailed inform ation in the log files located in
the < PacificTim esheet> /tom cat/logs directory.
You can test these settings by clicking the " Test Configuration"  button. This will connect to
the specified LDAP server and perform a search, reporting any errors that arise.
When using LD AP/AD authentication you still need to have an em ployee accountin  Pacific
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Timesheet for each em ployee that will use the system .Ifanem ployee has an LD AP/AD login
but does not have a  Pacific Tim esheet login they will not be able to log in into Pacific
Timesheet . The LD AP/AD account is linked to the Pacific Tim esheet account via the

employee's login nam e. For instanc e, if using AD you m ight be using the sAMAccountNam e
attribute to link to Pacific Tim esheet (see the Search Filter property, above). So if the
sAMAccountNam e attribute is " jjones" then the Pacific Tim esheet login nam e needs to be
"jjones", too.

What if you want to use the em ployee's em ail address as the login, but your Active

Direc tory (AD) sAMAcc ountNam e attribute is notanem  ail address? Then you can refer to
another AD attribute, such as "m ail", by altering the Search Filter property described

above. For exam ple instead of using (&(objectClass= user)(sAMAccountN ame={0})) you
could instead use (&(objectClass= user)(m ail= {0})).

In the event of an LDAP failure, such as the directory server being unavailable, or no

matc hing user acc ount being found in the directory, Pacific Tim esheet will fail over to
standard authentication. The entered login nam e and password will be checked against the
Pacific Tim esheet database. This ensures an adm inistrator will still be able to log in using

the Pacific Tim esheet acc ount, and change the LD AP settings if need be. This also allows you
to have accounts in  Pacific Tim esheet that are not in the directory server, such as 'adm in'.

When using LD AP authentication your em  ployees will no longer see the "Change Password"
link on their hom e page (unless an LDAP failure occurred and the standard authentication
was used instead, as described above).

Microsoft Active Directory N otes

You will need to enable LD AP support in Active D irectory (AD ). Then add the object classes
and related attributes for the "inetOrgPerson” and " groupOfUnigueNam es" object classes to
the Active D irectory schem a by using the Active D  irectory Managem ent Console snap-in,
ADSIEdit. "groupOfUniqueNam  es" is defined in RFC 2256, "inetOrgPerson" in RFC 2798.

Pacific Tim esheet employee accounts are linked to AD accounts via the SAM account nam e
("sAMAccountNam e" attribute) by default. You can use a different attribute, e.g. " mail", by
entering a custom  Searc h Filter value, as described above. This is useful, for instance, if you

are using em ail addresses for the  Pacific Tim esheet logins.
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SAML 2.0 Authentication

SAML 2.0 allows you to have single-sign-on (SSO) using a SAML 2.0 com pliant identity
provider.

The first step to im  plem enting SSO with Pacific Tim  esheet is to create a SAML 2.0

application in your identity provider. You will need to configure where to go to in the Pacific

Timesheet applic ation. The will often be ¢ alled the Single Sign On UR L, the R ecipient UR L or
the Destination URL. Enter your Pacific Tim esheet UR Linits full form at, e.g.

https://xyz.pac ifictim esheet.com ftim esheethom e.do

Replac e the 'xyz' portion above with the subdom ain you use.

Troubleshooting Note: Make sure com pression is turned on for any SAML 2.0
configuration.  Pacific Tim esheet expects the SAML data to be com pressed.

Once you have created the Pacific Tim esheet applic ation icon you m ust then configure the
sec urity settings in Pacific Tim  esheet. First, find the values you need to enter into Pacific

Tim esheet by going to your identity provides Adm in dashboard and finding the SSO settings
for the applic ation created above. Enter the following inform ation into Pacific Tim esheet on
the System > Security page:

Property Description

Name This is the nam e used in the login button on the Pacific Tim esheet
login page.

Issuer URL The value from the identity provider, for exam ple:

https://app.onelogin.c ~ om/sam I/m etadata/439734
SAML 2.0 Endpoint The value from identity provider, for exam ple:

HTTP) https://app.onelogin.c ~ om/trust/sam |2/http-post/sso/439734
Certificate The identity provider's X.509 security certificate. You can specify
botha primary certificate, and optionally a secondary certificate.
When a login request is authenticated the prim ary certificate is used

first, and if that fails then the secondary certificate will be used. You
would typically provide a secondary certificate a few days or weeks
before the prim ary one expires to ensure there is no loss of access
to the applic ation when the prim  ary certificate expires. Once the
prim ary certificate is fully expired you can replace it with the
secondary certificate at your earliest convenience, then clear the
secondary certificate field.

Note that the X.509 certificate should be in PEM form at, m eaning it
should start with the header line ----- B EGIN CERTIFICATE----- and
end with the footer line ----- END CERTIFICATE-----

Logging Check this option to help troubleshoot authentication failures. Errors
are logged to the System Event Log, and can be view with the
Reports > System Event Log report. For self-hosted system S you can
also view detailed inform  ation in the log files located in the
<PacificTim esheet> /tom cat/logs directory.

When you use an identity provider to connect to Pacific Tim esheet, you will need a
corresponding em ployee account in Pacific Tim  esheet. The identity provider's account

inform ation (be it em ail address, login, etc.) will be used to find a corresponding Pacific
Timesheet account. The m  atch will be m ade against the Pacific Tim  esheet account's login
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nam e, em ployee ID or em ail address, in that order.

Note: Even if SSO is enabled you can allow som e em ployees to log in using Pacific

Tim esheet's standard authentication (user nam e and password). On the login page the
employee can ¢ hoose either to log in with the standard user nam e and password, or use
the configured identity provider's SSO option. This allows you to have Pacific Tim esheet
ac counts that do not use the configured identity provider, such as the 'adm in' account, or
client approver acc ounts, still able to log in with a user nam e and password.
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Okta Authentication

Okta authentication allows you to have single-sign-on (SSO) using the Okta SAML 2.0
identity provider.

The first step to setting up SSO with Okta is to create a new application icon in Okta nam ed
Pacific Tim esheet. Search the catalog for Pacific Tim esheet and use that to create the new
application. Make sure you enter your subdom ain, e.g. "xyz". Thiscom esfrom your Pacific
Timesheet applic ation URL, e.g. https://xyz.pacifictim esheet.com .

Troubleshooting Note: Make sure "Request Com pression"is setto" Compressed" in your
Okta SAML configuration.  Pacific Tim esheet expects the SAML data to be com pressed.

Once you have created the Pacific Tim esheet applic ation icon in Okta you m  ust then
configure the security settings in Pacific Tim esheet. First, find the values you need to enter
into Pacific Tim esheet by going to the Okta Adm in> Applications page. Locate and click the
Pacific Tim esheet application you created above, then go to the Sign On panel. Click the

View Setup Instructions and enter the following inform ation into Pacific Tim esheet on the
System > Security page:

Property Description

Name This is the nam e used in the login button on the Pacific Tim esheet
login page.

Identity Provider The value from  Okta, for exam ple:

SSO URL https://xyz.okta.c ~ om/app/xyz/exk3ycbltc3POG  cryOh7

Identity Provider The value from  Okta, for exam ple:

Issuer https://www.okta.com /exk3ycblt53POG  cryOh7

Certificate The Okta X.509 security certificate. You can specify both a primary
certificate, and optionally a secondary certificate. When a login
request is authenticated the prim ary certificate is used first, and if

that fails then the secondary certificate will be used. You would

typically provide a secondary certificate a few days or weeks before

the prim ary one expires to ensure there is no loss of access to the
application when the prim  ary certificate expires. Once the prim ary
certific ate is fully expired you can replace it with the secondary

certificate at your earliest convenience, then clear the secondary

certificate field.

Note that the X.509 certificate should be in PEM form at, m eaning it
should start with the header line ----- B EGIN CERTIFICATE----- and
end with the footer line ----- END CERTIFICATE-----

Logging Check this option to help troubleshoot authentication failures. Errors
are logged to the System Event Log, and can be view with the
Reports > System Event Log report. For self-hosted system S you can
also view detailed inform  ation in the log files located in the
<PacificTim esheet> /tom cat/logs directory.

When you use an identity provider to connect to Pacific Tim esheet, you will need a
corresponding em ployee account in Pacific Tim  esheet. The identity provider's account

inform ation (be it em ail address, login, etc.) will be used to find a corresponding Pacific
Timesheet account. The m  atch will be m ade against the Pacific Tim  esheet account's login
nam e, em ployee ID or em ail address, in that order.

p208



© 2000-2021, Pacific Timesheet

Note: Even if SSO is enabled you can allow som e em ployees to log in using Pacific
Timesheet's standard authentication (user nam e and password). On the login page the
employee can ¢ hoose either to log in with the standard user nam e and password, or use
the configured identity provider's SSO option. This allows you to have Pacific Tim esheet
accounts that do not use the configured identity provider, such as the '‘adm in' account, or
client approver acc  ounts, still able to log in with a user nam e and password.
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One Login Authentication

One Login authentication allows you to have single-sign-on (SSO) using the One Login SAML
2.0 identity provider.

The first step to setting up SSO with OneLogin is to create a new application icon in

OneLogin nam ed Pacific Tim esheet. Search the catalog for Pacific Tim esheet and use that to
create the new applic  ation. Make sure you enter your subdom ain, e.g." xyz".This com es
from your Pacific Tim esheet application URL, e.g. https://xyz.pacifictim esheet.com .

Once you have created the Pacific Tim esheet applic ation icon in OneLogin youm  ust then
configure the security settings in Pacific Tim esheet. First, find the values you need to enter
into Pacific Tim esheet by going to the OnelLogin > Apps page. Locate and click the Pacific
Tim esheet applic ation you created above, then go to the SSO panel. Enter the following

inform ation into Pac ific Tim esheet on the System > Security page:

Property Description

Name This is the nam e used in the login button on the Pacific Tim esheet
login page.

Issuer URL The value from OneLogin, for exam ple:
https://app.onelogin.c ~ om/sam I/m etadata/439734

SAML 2.0 Endpoint The value from OneLogin, for exam ple:

HTTP) https://xyz.onelogin.com ftrust/sam  12/http-post/sso/439734

Certificate The OneLogin X.509 security certificate. You can specify both a
primary certificate, and optionally a secondary certificate. When a
login request is authenticated the prim ary certificate is used first,

and if that fails then the secondary certificate will be used. You
would typically provide a secondary certificate a few days or weeks
before the prim  ary one expires to ensure there is no loss of access
to the applic ation when the prim  ary certificate expires. Once the
prim ary certificate is fully expired you can replace it with the
secondary certificate at your earliest convenience, then clear the
secondary certificate field.

Note that the X.509 certificate should be in PEM form at, m eaning it
should start with the header line ----- B EGIN CERTIFICATE----- and
end with the footer line ----- END CERTIFICATE-----

Logging Check this option to help troubleshoot authentication failures. Errors
are logged to the System Event Log, and can be view with the
Reports > System Event Log report. For self-hosted system syou
can also view detailed inform ation in the log files located in the
<PacificTim esheet> /tom cat/logs directory.

When you use an identity provider to connect to Pacific Tim esheet, you will need a
corresponding em ployee account in Pacific Tim  esheet. The identity provider's account

inform ation (be it em ail address, login, etc.) will be used to find a corresponding Pacific
Timesheet account. The m  atch will be m ade against the Pacific Tim  esheet account's login
nam e, em ployee ID or em ail address, in that order.
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Note: Even if SSO is enabled you can allow som e em ployees to log in using Pacific
Timesheet's standard authentication (user nam e and password). On the login page the
employee can ¢ hoose either to log in with the standard user nam e and password, or use
the configured identity provider's SSO option. This allows you to have Pacific Tim esheet
accounts that do not use the configured identity provider, such as the '‘adm in' account, or
client approver acc  ounts, still able to log in with a user nam e and password.
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Ping Identity Authentication

Ping Identity authentic  ation allows you to have single-sign-on (SSO) using the Ping Identity
SAML 2.0 identity provider.

The first step to setting up SSO with Ping Identity is to create a new application icon in Ping
Identity nam ed Pacific Tim esheet. Log in as an adm inistrator to Ping Identity, click the Add

Application button, and search the catalog for Pacific Tim esheet. Use that to create a new
application, leaving all values at their default except for ACS URL and SP entityld . For
these two properties m  ake sure to replace the  ${Customer's subdomain} expression with

your Pacific Tim esheet subdom ain. For exam ple, if your Pacific Tim esheet UR L is
https://xyz.pac ifictim esheet.com , then your subdom ain is 'xyz' and the values would be:

ACS URL  -> https://xyz.pacifictimesheet.com/timesheet/home.do

SP entityld -> https://xyz.pacifictimesheet.com/timesheet/home.do

Once you have created the Pacific Tim esheet applic ation icon in Ping Identity you m ust then

configure the security settings in Pacific Tim esheet. First, find the values you need to enter

into Pacific Tim esheet by going to the Ping Identity Adm in> Applications page. Locate and

click the Pacific Tim esheet application you created above to load the configuration

param eters. Enter the following values into Pacific Tim esheet:

Property Description

Name This is the nam e used in the login button on the Pacific Tim esheet
login page.

Initiate SSO UR L The value from  Ping Identity, for exam  ple:

https://sso.c  onnec t.pingidentity.com /sso/sp/initsso?saasid= b04a3a
23-0ccf-b8a5-b4d2f7{4f086

SSO Relay State The value from  Ping Identity, for exam  ple:
https://pingone.com  /1.0/b04a3a23-0ccf-b8a5-b4d2f7f4f086
Certificate The Ping Identity X.509 security certificate. You can specify both a
primary  certificate, and optionally a secondary certificate. When a
login request is authenticated the prim ary certificate is used first,

and if that fails then the secondary certificate will be used. You
would typically provide a secondary certificate a few days or weeks
before the prim  ary one expires to ensure there is no loss of access
to the applic ation when the prim  ary certificate expires. Once the
prim ary certificate is fully expired you can replace it with the
secondary certificate at your earliest convenience, then clear the
secondary certificate field.

Note that the X.509 certificate should be in PEM form at, m eaning it
should start with the header line ----- B EGIN CERTIFICATE----- and
end with the footer line ----- END CERTIFICATE-----

Logging Check this option to help troubleshoot authentication failures. Errors
are logged to the System Event Log, and can be view with the
Reports > System Event Log report. For self-hosted system S you
can also view detailed inform ation in the log files located in the
<PacificTim esheet> /tom cat/logs directory.

When you use an identity provider to connect to Pacific Tim esheet, you will need a
corresponding em ployee account in Pacific Tim  esheet. The identity provider's account

inform ation (be it em ail address, login, etc.) will be used to find a corresponding Pacific
Timesheet account. The m  atch will be m ade against the Pacific Tim  esheet account's login
nam e, em ployee ID or em ail address, in that order.
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Note: Even if SSO is enabled you can allow som e em ployees to log in using Pacific

Tim esheet's standard authentication (user nam e and password). On the login page the
employee can ¢ hoose either to log in with the standard user nam e and password, or use
the configured identity provider's SSO option. This allows you to have Pacific Tim esheet
ac counts that do not use the configured identity provider, such as the 'adm in' account, or
client approver acc  ounts, still able to log in with a user nam e and password.
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Notices

Notices are em ails that can be sentto em  ployees for various events that occur in the

application.

Note: You m ust configure the SMTP settings before being able to send em ail notices. The
System Settings topic has m ore inform ation.

The following em ail notices can be sent:

Notice
Employee Late

Timesheet D ue

Timesheet Late

Timesheet Rejected

Timesheet Subm itted

Timesheet Approval D ue

Tim esheet Approval Late

Request Approved

Request R ejected

Description

The Em ployee Late notice is sent to an em ployee's prim ary
approver if the em  ployee punches in after their scheduled start

tim e (see the Managing Em ployees topic for m ore inform ation
about the scheduled start tim e). For this notice to be sent

make sure the em ployee's "Scheduled Start" and " Approver"
properties are spec ified, and that their approver has a valid

email address in approver's em  ployee profile.

The Tim esheet D ue notice is sentto em  ployees who have not
subm itted their tim  esheet by a certain date. The date is

relative to the end of the tim esheet period, either before or
after it. By default, this notice is not sent to em ployees using
leave-only tim  esheets, but you can override this setting.

Like the Tim esheet D ue Notice, the Tim esheet Late notice is
sent to em ployees who have not subm itted their im esheet by
a certain date. The date is relative to the end of the tim esheet
period, either before or after it. B y default, this notice is not

sent to em ployees using leave-only tim  esheets, but you can
override this setting. You can optionally CC the em ployee's
approver(s) using the CC property.

The Tim esheet Rejected notice is sent to em ployees
immediately upon their tim  esheet being rejected.

The Tim esheet Subm itted notice is sent to the em ployee's
prim ary approver im mediately upon subm ission of their
tim esheet.

The Tim esheet Approval Due notice is sent to prim ary
approvers who have tim  esheets waiting their approval. This is
sent at a date relative to the end of the tim esheet period,
either before or after it. You can optionally CC the em ployee's
backup approver(s) using the CC property.

Like the Tim esheet Approval D ue notice, the Tim esheet
Approval Late notice is sent to prim ary approvers who have
tim esheets waiting their approval. This is sent at a date relative

to the end of the tim  esheet period, either before or after it. You
can optionally CC the em  ployee's backup approver(s) using the
CC property.

The Request Approved notice is sent to request owners
immediately upon their leave request being approved.

The Request R ejected notice is sent to request owners
immediately upon their leave request being rejected.
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Request Subm itted

Request Approval D ue

Request Approval Late

Crew Tim esheet R ejected

Asset Sheet Approved

Asset Sheet Rejected

Asset Sheet Subm itted

Asset Sheet Approval D

Asset Sheet Approval Late

ue

The Request Subm itted notice is sent to the em ployee's
prim ary approver im mediately upon subm ission of a leave
request.

The Request Approval Due notice is sent to prim ary approvers
who have leave requests waiting their approval. This is sent at

a date relative to either the date of subm ission or the start
date of the requested leave. You can optionally CC the

employee's bac kup approver(s) using the CC property.

Like the Request Approval D ue notice, the R equest Approval
Late notic eis sentto prim ary approvers who have leave
requests waiting their approval. This is sent at a date relative

to either the date of subm ission or the start date of the
requested leave.

You can optionally CC the em  ployee's backup approver(s) using
the CC property.

The Request Approval Due notice can optionally keep resending
the notic e if warranted. Checking this option will cause the
notic e to be resent each day (for up to 14 days) until any
requests that are late for approval have been approved or
rejected.

The Crew Tim esheet Rejected notice is sentto m anagers if the
crew tim esheet they subm itted is later rejected. This notice is
only available if the Crew Tim esheet option is enabled (from

the System > Tim esheet Options page).

The Asset Sheet Approved notice is sent to asset (e.g.
expense) sheet owners im  mediately upon their sheet being
approved.

The Asset Sheet R ejected notice is sent to asset (e.g. ex pense)
sheet owners im mediately upon their sheet being rejected.

The Asset Sheet Subm itted notice is sent to the em ployee's
prim ary approver im mediately upon subm ission of an asset
(e.g. expense) sheet.

The Asset Sheet Approval D ue notice is sentto prim  ary
approvers who have asset (e.g. expense) sheets waiting their
approval. This is sent at a date relative to the date of

subm ission of the sheet. You can optionally CC the em ployee's
backup approver(s) using the CC property.

Like the Asset Sheet Approval D ue notice, the Asset Sheet

Approval Late notice is sent to prim ary approvers who have
asset (e.g. expense) sheets waiting their approval. This is sent
at a date relative to the date of subm ission of the sheet.

You can optionally CC the em  ployee's backup approver(s) using
the CC property.

The Asset Sheet Approval D ue notice can optionally keep
resending the notic e if warranted. Checking this option will
cause the notice to be resent each day (for up to 14 days) until
any sheets that are late for approval have been approved or
rejected.

Editing Notices
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Adm inistrators can edit the subject and body of the notices. The subject is plain text, but
the body can be either plain text or HTML. If using HTML then the body m

<htm I> and < /ntm > tags. The body text can be up to 4000 characters. B

body can ¢ ontain the following substitution variables:

ust be enclosed by
oth the title and

Substitution Variables
Variable

${Crew.nam e}
${Crew.url}

${Request.approve.url}
${Request.date}
${Request.desc

${Request.rejecter}

${Request.rejectMessage

}
${Request.type}

${Request.user.fullNam

ription}

e}

${System .applic ationNam

e}

${System
}
${System
${System
e}

${System
${System .url}

${Tim eSheet.approve.url}

${Tim eSheet.period}

${Tim eSheet.rejecter}

.currentD ate}

.currentTim e}

.com panyNam e

.currentD ateTim

Description
The nam e of the crew or group.

The address of the Crew Tim  esheet
page. This value is based on the
Application URL system  property, which

can be m odified onthe System Settings

page.
Request owner's fullnam e.

Request date range, as entered by user.

Request description, as entered by the
employee.

The m anager who rejected the request.

Request rejec tion m essage, in request is
rejected.

Request type, for exam  ple " Vacation" .
Request owner's full nam e.

Application Nam e, as specified in the
Branding page.

Company Nam e, as specified in the
Branding page.

Current date

Current date and tim e

Currenttim e

Address of login page. This value is

based on the Application URL system
property, which can be m  odified on the
System Settings page.

Address of the tim  esheet approval page.
This value is based on the Application

URL system property, which can be
modified on the System Settings page.

Tim esheet period

The m anager who rejected the
tim esheet.

Notes
For Crew notices only.
For Crew notices only.

For Request notices
only.

For Request notices
only.

For Request notices
only.

For Request R ejected
notice only.

For Request R ejected
notice only.

For Request notices
only.

For Request notices
only.

For all notices.
For all notices.

For all notices.
For all notices.

For all notices.
For all notices.

For Tim esheet notices
only.

For Tim esheet notices
only.

For Tim esheet
Rejected and Crew
Tim esheet Rejected
notices only.
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${Tim eSheet.rejectMessa
ge}
${Tim eSheet.url}

${Tim eSheet.user.fullNam
e}
${User.fullNam e}

${User list}

${User.login}
${User.scheduledIn}
${User.actualln}

${Sheet.approve.url}

${Sheet.date}
${Sheet.description}
${Sheet.rejecter}
${Sheet.rejectMessage}
${Sheet.type}

${Sheet.user.fullNam e}

The tim esheet rejection reason.

Address of 'My Tim esheet' page. This
value is based on the Application URL

system property, which can be m

on the System Settings page.

Timesheet owner's fullnam e.

Employee full nam e, in FIRSTNAME

LASTNAME form at.

A list of em ployees. The list will depend
on the type of notice. For instance, in

the Tim esheet Approver D ue and
Tim esheet Approver Late notices this

value will resolve to the list

of

employees with tim  esheets that need

approving.
Employee login nam e

Employee's scheduled starttim  e.

Employee's actual start tim

e.

Address of the Asset Sheet approval
page. This value is based on the

Application URL system

property, which

odified

can be m odified onthe System Settings

page.

Asset sheet date/date range, as enter

by the em ployee.

Asset sheet description, as
the em ployee.

entered by

The m anager who rejected the asset

sheet.
Asset sheet rejection m

essage, if any.

Asset sheet type, e.g. "Expense”

Asset sheet owner's full nam e.

ed

For Tim esheet
Rejected notice only.

For Tim esheet notices
only.

For Tim esheet notices
only.

For all applicable
notices.

For all applicable
notices.

For all applicable
notices.

For Em ployee Late
notice only.

For Em ployee Late
notice only.

For Asset Sheet
notices only.

For Asset Sheet
notices only.

For Asset Sheet
notices only.

For Asset Sheet
Rejected notice only.

For Asset Sheet
Rejected notice only.

For Asset Sheet
notices only.

For Asset Sheet
notices only.
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Schema

A schema is a set of database tables, and is used by the application to store tim esheet data
and settings. If you are hosting the application yourself you can review your schem a
settings, as well as edit or create a new schem a. Norm ally you would use the schem  a

created by the installer and never change these settings. But if you would like to use an
external database like Microsoft SQL Server or Oracle, or if you installed the WAR version of
the application, you will need to create a new schem a before you can use the system

Note: For security reasons you m ay only access the Schem a page if you are on the
com puter running the tim  esheet service.

For a list of supported databases and versions refer to the System Requirem ents topic. The
installer provides the following database:

Bundled Database

MySQL 5.0.22 Default TCP/IP Port: 3316
Admiinistrative Login: See the "Bundled Software" section in
tim esheet-install.pdf

The Sc hem a page is located at the following address:
http://localhost/timesheet/system/db-show.do

If you changed the default HTTP port from 80 then you will need to specify the port num ber,
too, for exam ple:

http://localhost:8080/timesheet/system/db-show.do

This will load a page showing the current schem a configuration. You can edit this schem a
configuration by clicking the Edit button, or create a new schem a by clicking the Create
button. Note that for security reasons you need to be using a browser on the sam e machine

that the application is installed on.

Editing the sc  hem a c onfiguration will not alter the schem a, just the settings that the
application uses to connect to the schem a. Creating a new schem  a will not delete or alter
the old schem a, but will create a new schem a and update the settings so that the
application will use the new one.

Schema Properties

Database Type

The type of database m  anagem ent system (D BMS) to be used. The following types are
supported:

Server Address

The TCP/IP address or hostnam e of the database server. Use localhost if the database
server is running on the sam e com puter as the application.

Server Port

The TCP/IP port num ber used by the database server. The value will default to the num ber
appropriate for the database type, which is generally the value you want to use.
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Schema Name/Oracle Sl D

For Microsoft and MySQL the schem  anam e is the nam e of the database. For Oracle you
would use the SID (Server ID entifier).

Login Name

The login nam e for the database account to use when connecting to the database server.
Password

The password for the login.

When c reating a new schem a you have the following additional properties:

Admin Login

The login nam e for the adm inistrative account for the database server. Note that if creating

a new sc hem a or database using the bundled MySQL database, the default adm inistrative
loginis root with the password is  timesheet .

Admin Password

The password for the adm inistrative account. Note that if creating a new schem aor
database using the bundled MySQL database, the default adm inistrative loginis  root with
the password is timesheet .

New Schema N ame

For Microsoft and MySQL this is the nam e of the new database to create. For Oracle this is
the nam e of the new tablespace tocr  eate.

New Login

The login nam e for the new database account to use when connecting to the database
server.

For Orac le Database 12c or later the login nam e must begin with the three characters
'C##' or 'c##t' (without the quotes).

New Password

The password for the new login.

SQL Server 2005 Note: SQL Server 2005 has stricter login and password rules than SQL

Server 2000 by default. Make sure the password for the new database schem a doesn't
matc h the new schem anam e, as this will often cause an error. You can see details for the
error m essage in the log files, loc  ated in the tom cat/logs directory of the installation
directory.
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Custom Fields

You can ¢ ustom ize m any objects in the application by adding new data fields. Custom fields
allows you to store additional inform ation with an object, such as a text string, a date, a file

attac hment or any other value as needed for your business-specific requirem ents. You can
manage ¢ ustom fields for objec ts from the "Manage Custom Fields" link on the options m  enu
on the page that lists the objects. For instance, to m anage Em ployee custom fields you go

to the Em ployees page, click the options m enu (the sm all triangle to the top-right of the
employee list) and choose "Manage Custom Fields" . If you do not see this you m ay not have
managem ent perm issions for this type of object - check your Perm ission Level in your
employee profile to verify that you have the appropriate perm issions.

Once created, custom field values can be set through the web interface for each object, or

im ported/exported. You can create reports that include the custom fields as well.
Note: If you ¢ reate a report with a custom field, then later delete the custom field, the
report will generate an error when run. This is because the database colum n is now

missing. To ¢ orrec t this sim ply edit the report and rem ove the obsolete report colum nin
order for the report to run correctly again.

Custom fields have the following properties:
General Properties
Field N ame

The nam e of the custom field. This is the nam e that will appear on the properties form , as
well as inim port/export files. This field is required and can be up to 80 characters.

Note: When saving a new custom field for the firsttim e the system will create a database
colum n to hold values based on the nam e you enter. You can renam e the custom field at
any tim e after this, but the internal database colum n nam e will not change (in order to
prevent ¢ ustom SQL reports from  not working). Therefore, if you are required to create a
custom field with a spec ific nam e (for exam ple, for Absence Points Rules) you m ust enter
it exactly as spec fified the firsttim e (including the proper upper/lower case lettering).

Type

The type of custom field, which can be one of the following:

Type Description

Chec kbox A field representing a true/false choice.

Currency A num ber representing a currency am ount. The value
can be entered as an edit box or as a drop-down list.

Date A date value.

Date and Tim e A date and tim e value.

Email Address A text field for entering and displaying an em ail
address.

Employee An em ployee selection.

File Attachm ent Allows uploading and downloading of a file. Maxim um

size is lim ited to 250MB
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Image Allows uploading and displaying of an im age. Maxim um
size is lim ited to 250MB. Supported im age file form ats
are PNG, GIF and JPG .

List A text field allowing the selection of one or m ore
choices from a list of choices. Note that the List type is
only for lists of text item s (Num ber and Currency type
fields ¢ an also have lists but those are configured
directly from their properties page).

Num ber A num eric value, allowing an arbitrary num ber of
decim al plac es of precision. The value can be entered
as an edit box or as a drop-down list.

Text A text value, entered via an edit box.

Text Area A text value that allows line breaks.

Time Atim e of day value.

Web Link A text field for entering and displaying a web address.

You can only specify the type when adding a new custom field. If you need to change the

type of an existing custom field you need to delete the existing one and create a new one.
Position

The position determ  ines where on the form  the field will appear.

Start New Field Group

Checking this option will cause a horizontal line to appear im mediately before this field. This
is useful when grouping several related fields.

Description

A description of this field. This should be as brief as possible, but can be up to 255
characters.

Required

Checking this option will require a value for this field.

Default Value

Spec ifies the default value for the custom field.

Tim esheet custom fields that are text (e.g. Text, Text Area, List, etc.) also allow you to
default the value to an em ployee property by using the ${User.xyz} variable, where User
refers to the em  ployee object and xyz is the nam e of the em ployee property. For exam  ple
${User.lastNam e} would default the value to the em ployee's last nam e. If you had an
employee custom field nam ed "Pay Class" then you would use ${User.xPayClass}.
Checkbox Properties

Checkbox T ext

Text or label that appears to the right of the checkbox. This should be as terse as possible,
but can be up to 80 character S.

Currency Properties
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Currency
The currency sym bol.
Decimal Digits

The num ber of digits to display after the decim al point. This can be zero if displaying an
integer value.

Input Type
The type of input widget used, either an edit box or a drop-down list.
Minimum Value

Ifthe Input Type issetto EditBox ,then you can specify the m inim um value that can be
entered. Leave this blank if there is no m inim um value.

Maximum Value

Ifthe InputType issetto EditBox ,then you can specify the m axim um value that can be
entered. Leave this blank if there is no m axim um value.

List Choices

If the Input Type issetto Drop Down List ,then you can specify the num bers in the list.
Enter eac h num ber on a separate row by pressing the enter key, for exam ple:

1.00
2.00
3.00

The num ber form at is entered in the locale of the adm inistrator m aking the changes, but
when the list is presented to em ployees the num bers will be reform atted as appropriate for
their locale, as well as have the currency sym bol added. For exam ple, if the em ployee has
the Frenc h locale and the currency was set to EUR then they would see the list form atted as
follows:

€1,00
€2,00
€3,00

Image

Im age c ustom fields allow you to upload an im age, which will be presented as a sm aller
thum bnail that can be ¢ licked to view at its native or full resolution. Supported im age file
form ats are PNG , GIF and JPG .

Thumbnail Width
Thumbnail Height

The default thum  bnail size if not specified is 500x500 pixels. You can specify your own size

here, in pixels. Im  ages whose native size is sm  aller than this will not be scaled up, but

images larger than this will be sc aled down, so the thum  bnail size represents the m  axim um
size shown to the user. The original im age can always be viewed by clicking on the

thum bnail.
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List

List Style

The style of the list control, which can be either a drop-down m enu or a list box.

List Box Height

The height of the list box, in rows.

Multiple Selection

Checking this option allows m  ultiple selections. Note that m ultiple selections are stored in
sam e field just like single selec  tions, but with each selection being separated by a line break
character.

List Choices

Enter your list choices here, with each choice starting on a new line.

Number

Decimal Digits

The num ber of digits to display after the decim al point. This can be zero if displaying an
integer value.

Input Type
The type of input widget used, either an edit box or a drop-down list.
Minimum Value

Ifthe Input Type issetto EditBox ,then you can specify the m inim um value that can be
entered. Leave this blank if there is nom inim um value.

Maximum Value

Ifthe Input Type issetto EditBox ,then you can specify the m axim um value that can be
entered. Leave this blank if there is nom axim um value.

List Choices

If the Input Type issetto Drop Down List ,then you can specify the num bers in the list.

Enter eac h num ber on a separate row by pressing the enter key, for exam ple:

1.00

2.00

3.00

The num ber form at is entered in the locale of the adm inistrator m aking the changes, but

when the list is presented to em ployees the num bers will be reform atted as appropriate for
their locale. For exam  ple, if the em ployee has the French locale they would see the list
form atted as follows:

1,00
2,00
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3,00

Text
Maximum Characters

The m axim um num ber of ¢ harac ters that ¢ an be entered in this field. This can be up to 255
characters.

Text Area
Maximum Characters

The m axim um num ber of ¢ harac ters that can be entered in this field. This can be up to
4000 characters.

Rows

The height of the text area, in rows.
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Importing/Exporting

You can im port and export objects such as em ployees, groups and tasks in CSV (Com ma
Separated Value) form  at. Note that your ability to im port or export will depend upon your
perm ission level: adm inistrators ¢ anim port and export any object but other perm ission
levels m ay have the ability to im port or export disabled.

CSV Formatting N otes

In order to m ake data interchange as reliable as possible, the following form atting rules are
followed:

X By default, dates , times and numbers are form atted for the locale of the user doing
the im port/export. You can override the date and tim e form atting for each export from
the System > General > Data Integration page.

X Unicode (UTF8) c harac ter enc oding is used in order to fully support international
languages. Make sure you save your CSV files in UTF8 form at in order to not lose
accented characters, etc. Exported CSV data is always generated in UTF8 form at.

X Field values with  commas or carriage returns are 'esc aped' by enclosing the value in
double-quotes

X Fields with multiple values have each value separated by a carriage return (also

called a "hard" ¢ arriage return in Excel, entered using ALT+ ENTER). Alternatively, when
importing data you can optionally specify a semicolon ;" character instead, if you
prefer.

In addition:

X All fields are optional unless otherwise noted.
X The behavior of blank values depends on the field.
X A header record at the start of the file is required.

Match Field

When im porting som e types of objects you can specify a m atch field, which is used to avoid
creating duplicates. The m  atch field determ ine which property is used to m atch against
existing objec ts to avoid duplicates. For instance, when im porting em ployees you generally

you would use the Login Nam e, but the Em ployee ID and Em ail are also options.
Objects

The following objec ts can be im ported and exported in CSV form at - click the links for a
detailed desc ription of the CSV fields:

Assets

Asset Classes
Asset Entries

Bill Rates

Custom ers
Employees
Employee Balances
Groups

Pay Rates

Projects

X X X X X X X X X X
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X X X X

Project G roups
Tasks

Task G roups
Tim esheets
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Asset Fields

Field Description Format

Name 'Asset nam e. When adding a new asset this field is required. This Text (80 chars
value m ust be unique for all assets, regardless of the asset type. max)

ID Asset ID . This field is not required, but if present and the value is Text (80 chars
not blank then it m  ust be unique for all assets, regardless of the max)
asset type.

Descri | A description of this asset. Text (255 chars

ption max)

Status ' Asset status. Possible value are: Text
Value Description
Active The asset is active and available for use.

Inactive The asset is not available for use, but can still be
optionally reported on.

Type The assettype (ham eorID ). The asset type of the asset class Text
will be used if this is not specified. If no asset class specified then
this is required when adding a new asset and there are m ore than
one asset types defined.

Class The asset class (nam e or ID ). This is optional, but if not specified Text
and you are creating a new asset you m ust then specify the Type
field.

Units  The unitof m easurem ent (nam eorID ). Text

Unit The cost per unit of m  easure for this asset. The cost is the Num ber

Cost amount you paid for this asset.

Unit The price per unitof m  easure for this asset. The price is the Num ber

Price  'amount you charge for this asset.

Unit The m arkup or m argin percentage. Only applicable if the Unit Num ber

Marku | Price Flag is set to Markup or Margin.

p

Unit If you are not specifying a fixed Unit Price you can have the Text

Price |system compute it. Possible values are:

Flag  Value Description
Fixed Price | The Unit Price is as entered.

Markup The Unit Price is com puted as a percent m  arkup of
the Unit Cost.

Margin The Unit Price is com puted as a percentm  argin of
the Unit Cost.

Decim The num ber of dec imal digits to allow when entering quantities of Num ber

al this asset. If not specified then the default value of the Units will

Digits ' be used.
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Permis The list of em ployees and groups given special perm ission on this

sions

Notes

objec t. Multiple perm issions have each value separated by a
carriage return (also called a "hard" c arriage return in Excel,
entered using ALT+ ENTER). Each value is of the form

Object Nam e=Permission Level (Object Type)

Where Object Nam e is the nam e of the group or the login of the
employee, Perm ission Level is the perm  ission level to give the
employee or group on this object, and Object Type is the whether

this is an Em ployee or Group that is being given perm ission. Here
is an exam ple of a group and anem  ployee assigned to an object:

GroupA= Tim ekeeper (Group)
jmeyers= Manager (Em ployee)

Note that the perm ission level and object type are optional. If the

perm ission level is not specified then it will be set to the

employee's default perm ission level. If the object type is not

specified the system  will first check for a group with a m atching
nam e, then look for an em  ployee with a m atching login nam e.
Only if you have group nam  es and em ployee logins that m  ight be
the sam e do you need to specify the object type.

Notes about this asset.

Text

Text (2000
chars m ax)
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Asset Class Fields

Field
Name

Descri
ption

Status

Type

Description

Asset ¢ lass ham e. When adding a new asset this field is required.

This value m ust be unique for all asset classes, regardless of the
asset type.

Asset ¢ lass ID. This field is not required, but if present and the
value is not blank then it m ust be unique for all asset classes,
regardless of the asset type.

A description of this asset class.

Asset class status. Possible value are:

Value Description
Active The asset class is active and available for use.
Inactive The asset class is not available for use, but can still

be optionally reported on.

The asset type (nam e or ID ) for this asset class. If there are
multiple asset types defined then this field is required.

Format

Text (80 chars
max)

Text (80 chars
max)

Text (255 chars

max)
Text

Text
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Asset Entry Fields

The following fields ¢ an be im ported/exported.

Note: When importing , the header field nam e must m atch the value below exactly in
order to be recognized.

Note: When exporting , you ¢ an com bine fields using ¢ ustom export field expressions.
See the Expression Fields topic for m ore inform ation.

Field Description Format
Date The date this asset was used. Date
ID The asset entry ID . This field is not Text (80 chars m  ax)

required, but if present and the value is not
blank then it m  ust be unique for all asset
entries, regardless of the asset type. Note

that the system  will autom atically generate
this value when adding new entries if a

value is not provided. If a value is present
when im porting then any existing entry

with a m atching ID will be updated, rather
than a new entry being added.

Description A description for this asset entry. Text (255 chars m  ax)

Asset The asset (ham e or ID ) used for this entry. Text
If spec ified then the asset's class and units
will be assum ed for this entry.

Type The asset type (nam e or ID ) for this entry. Text
The asset type of the asset will be used if
this is not specified. If no asset specified
then this is required when adding a new
asset entry and there are m ore than one
asset types defined.

Class The asset class (nam e or ID ) for this entry. Text
This is optional and will be set to the value
for the Asset if not specified.

Units The unit of m easurem ent (nam eorID )for | Text
this entry. This is optional and will be set to
the value for the Asset if not specified.

Quantity The num ber or quantity of units used for Num ber
this entry.
Unit Cost The cost per unit of m  easure for this asset Num ber

entry. The cost isthe am  ount you paid for
this asset. This is optional and will be set to
the value for the Asset if not specified.

Total Cost The total cost for this asset entry. This is Num ber
optional and if not specified will be
com puted as Quantity x Unit Cost.

Unit Price The price per unitof m  easure for this asset.  Number
The price is the am  ount you charge for this
asset. This is optional and will be set to the
value for the Asset if not specified.
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Total Price

Employee

Reporting
Group

Custom er
Project
Group
Project
Task G roup

Task

Subm itted

Subm it D ate
Subm itted

By
Approved

Approval
Date
Approved B y

Export D ate

Exported By

Notes

The total price for this asset entry. This is
optional and if not specified will be
com puted as Quantity x Unit Price.

The em ployee (ham e or ID ) this asset entry
is to be associated with. If not specified
then this will default to the em ployee doing
the im port when creating new entries.

The reporting group (ham e or ID ) this asset
entry is to be associated with. If not

specified then this will default to the

reporting group of the em ployee doing the
import when ¢ reating new entries.

The custom er (nam e or ID ) this asset entry
is to be associated with.

The projec tgroup (nam e orID ) this asset
entry is to be associated with.

The projec t(nam e or ID ) this asset entry is
to be associated with.

The task group (ham e orID ) this asset
entry is to be associated with.

The task (nam e or ID ) this asset entry is to
be associated with.

A value of either Yes or N o depending upon
whether this asset entry has been
subm itted (locked).

If the entry is subm itted then this will be
the date and tim e of the subm it.

The em ployee (ham e or ID ) who subm itted
the entry.

A value of either Yes or N o depending upon
whether this asset entry has been
approved.

If the entry is approved then this will be
the date and tim e of the approval.

The em ployee (nam e or ID ) who approved
the entry.

If this entry has been m  arked as exported
then this will be the date and tim e of the
export. You can use this field to ‘'unm ark’
entries that have been inadvertently

marked as exported by specifying a value

of 1/1/1970.

The em ployee (ham e orID ) who m arked
the entry as exported.

Notes about this asset entry.

Num ber

Text

Text

Text

Text

Text

Text

Text

Text

Date

Text

Text

Date

Text

Date

Text

Text (2000 chars m  ax)
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Bill R ates Fields

Field
Object

Object ID

Subobject

Subobject ID

Bill Rate

Description

The nam e of prim ary object that rates

depend on, forexam ple "Em ployee". This is

optional if the Objec
The ID of the prim

t ID field is supplied.

ary object the rates

depend on, for exam ple "222-99-5555"

This is optional if the
supplied.

Object field is

The nam e of exceptioin object that rates
depend on, for exam ple "Group". This is
optional if the Subobject ID field is
supplied. The subobject or subobject ID
optional if you are setting the default rate

for the object.

The ID of the exception object the rates
depend on, for exam ple " Accounting
Group". This is optional if the Subobject
field is supplied. The subobject or subobject
ID is optional if you are setting the default

rate for the object.

The rate for this object/subobject. The rate

can be either a num

eric value, or the

of a rate as defined in the System

Rate Options page.

nam
> Bill

is

e

Format
Text (80 chars m

Text (80 chars m

Text (80 chars m

Text (80 chars m

Num ber/Text

ax)
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Customer Fields

Field
Name

ID
Descri

ption
Status

Permis
sions

Notes

Description Format

Custom er nam e. If this field is present in the CSV data then a Text (80 chars
value is required, and is always required when adding new max)
custom ers.

Custom er ID. This field is not required, but if present and the Text (80 chars
value is not blank then it m ust be unique for all custom  ers. max)

A description of this custom  er. Text (255 chars
max)

Custom er status. Possible value are: Text
Value Description
Active Employee can log into system

Inactive Employee cannot log into system , and does not show
up on reports, etc. by default.

The list of em ployees and groups given special perm ission on this | Text
objec t. Multiple perm  issions have each value separated by a

carriage return (also called a "hard" ¢ arriage return in Excel,

entered using ALT+ ENTER). Each value is of the form

Object Nam e=Permission Level (Object Type)

Where Object Nam e is the nam e of the group or the login of the
employee, Perm ission Level is the perm ission level to give the

em ployee or group on this object, and Object Type is the whether

this is an Em ployee or Group that is being given perm ission. Here
is an exam ple of a group and an em  ployee assigned to an object:

GroupA= Tim ekeeper (Group)
jmeyers= Manager (Em ployee)

Note that the perm ission level and object type are optional. If the

perm ission level is not specified then it will be set to the

employee's default perm  ission level. If the object type is not

specified the system  will first check for a group with a m atching
nam e, then look for an em  ployee with a m atching login nam e.
Only if you have group nam es and em ployee logins that m  ight be
the sam e do you need to specify the object type.

Notes about this custom  er. Text (2000
chars m ax)
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Employee Fields

Field
Login Name

Password

First Nam e

Last Nam e

Status

Permission
Level

Employee
Type
Policy
Job Title

Reporting
Group

First D ay
Last D ay

Scheduled
Work Days

Scheduled
Hours

Scheduled
Start

Description

Employee login nam e. If this field is present in the CSV data then
a value is required, and is always required when adding new
employees.

Employee password. This field is not exported but can be

imported. Updating an em  ployee's password through an im port
creates an expired password - the em ployee will be asked to
enter a new one the next tim e they log in.

First nam e.

Last nam e. If this field is present in the CSV data then a value is
required, and is always required when adding new em ployees.

Employee ID. This field is not required, but if present and the
value is not blank then it m ust be unique for allem  ployees.

Employee status. Possible value are:

Value Description

Active Employee can log into system

Inactive Employee cannot log into system , and does not show
up on reports, etc. by default.

Locked Employee cannot log into system , but shows up on

reports, etc. by default. An em ployee can becom e

locked due to too m any unsuccessful login attem  pts.

The default perm ission level, for exam ple Em ployee.

The type of em ployee.

The polic y for thisem ployee.
Job title.

The nam e of the prim ary or reporting group.

The first day of em  ploym ent.
The last day of em ploym ent.

The scheduled days of the week that are considered work. This is

form atted as a list of nam es of the days of the week separated by
spaces, for exam ple "Mon Tue Wed Thu Fri". The nam e of the day
can be the standard abbreviation or the full nam e, as appropriate
for the language of the locale of the user doing the im port.

The num ber of hours the em  ployee is scheduled to work each
week.

The tim e of day the em ployee is scheduled to start work or
"punch in”.

Format

Text (80
chars
max)

Text (40
chars
max)

Text (80
chars
max)

Text (80
chars
max)

Text (80
chars
max)

Text

Text
Text

Text

Text (80
chars
max)

Text

Date
Date
Text

Num ber

Time
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Scheduled
Finish
Email

Phone

Mobile

Fax

Timesheet
Tem plate

Tim esheet
Mem ory

Punched In

Locale

Time Zone

Bill Rate

Pay Rate

The tim e of day the em ployee is scheduled to finish work or
"punch out".

Email address.

Phone num ber.

Mobile phone num ber.

Fax num ber.

The tim esheet tem plate for thisem ployee.

This ¢ ontrols whether rows and hours are carried forward from
the previous tim esheet to new tim  esheets. Possible values are:

Value Description

None None (or a blank value) indicates no
rows or hours will be carried forward.

Rows Tim esheet rows will be carried forward

from previous tim esheet.

Tim esheet rows and hours will be
carried forward from  previous
tim esheet.

Rows and Hours

A "Yes"/"No" value indic  ating whether the em  ployee is punched in
or not. This is a read-only value and will be ignored if im ported.

Locale. The loc ale determ ines how dates and num  bers are
form atted. Loc ale are specified using ISO codes, and possible
values are defined in the Locale Codes appendix.

Time zone. Tim e zones are spec ified using Olson ID s, and possible
values are defined in the Time Zone Codes appendix.

The default bill rate. This can be a nam
num eric value.

ed rate, or a custom

The default pay rate. This can be a nam ed rate, or a custom

num eric value.

Time

Text (80
chars
max)
Text (40
chars
max)
Text (40
chars
max)
Text (40
chars
max)

Text

Text

Text

Text (5
chars
max)

Text (40
chars
max)

Text or
Num ber

Text or
Num ber
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Groups

The list of groups thisem  ployee isam ember of. If a user belongs
to m ultiple groups then each group is separated by a carriage

return. If form  atting an im port file using Excel you can enter
multiple lines in a cell using ALT+ ENTER (also called a "hard"
carriage return).

Depending upon your integration needs, you m ay want to narrow
the scope of which groups are set in the im port file. By default, if
the Groups colum n is present, the user is rem oved from ALL
groups and plac ed in the group(s) specified in the im port file. If
you want to only set their perm ission groups and not alter
reporting groups or ¢ rews they are in, you can append the " P
suffix to the ¢ olum n header: "Groups:P". The following suffixes

can be used:

Suffix Description

Groups:P Takes the user out of all perm ission
groups (groups that do not have the
Reporting G roup or Crew type checked)
and adds them to the groups specified
in the im port file. If no groups are
specified in the im  port file then they will
belong to no perm ission groups. This
will not rem ove the user from any
reporting or crew groups they m ay
currently be m embers of.

Groups:R Takes the user out of all reporting
groups (groups that do not have the
Crew type checked) and adds them to
the groups specified in the im port file.
If no groups are spec ffied in the im port
file then they will belong to no reporting
groups. This will notrem  ove the user
from any perm ission or ¢ rew groups
they m ay currently be m embers of.

Groups:C Takes the user out of all crew groups
(groups that do not have the R eporting
Group type checked) and adds them to
the groups specified in the im port file.
If no groups are spec ifiedinthe im port
file then they will belong to no crew
groups. This will notrem  ove the user
from any perm ission or reporting groups
they m ay currently be m  embers of.

Groups:NR Takes the user out of all groups that are
not reporting groups, and adds them to
the groups in the im  port file. In other
words, this suffix will ensure the list of
reporting groups a user is a m ember of
will not be changed.

Groups:NC Takes the user out of any groups that
are not crew groups, and adds them to
the groups in the im  port file. In other
words, this suffix will ensure the list of
crews a userisam ember of will not be
changed.

Text
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Notes Notes about thisem ployee. Text
(2000
chars
max)

Approver The nam e of the prim ary tim esheet approver for the em  ployee. Text

The nam e can be alogin nam e, em ployee ID , or fullnam e (either
"first last" or " last, first" is accepted).
Approver The nam e of the bac kuptim esheet approver for the em  ployee. Text
Backup The nam e can be in the form  of alogin nam e, em ployee ID , or
full nam e (either "first last" or " last, first" is accepted).
_O_
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Employee Balances Fields

Field
Employee

Employee ID
Balance
Balanc e ID

Date

Value

Change

Comment

Description

Employee login nam e. Either this field or
Employee ID m ust be specified when
importing.

Employee ID. Either this field or Em ployee
must be specified when im  porting.

Balanc e nam e. Either this field or Balance
ID m ust be spec ified when im porting.

Balanc e ID. Either this field or Balance
must be specified when im  porting.

When im porting this is the date the Value
or Change should take effect. When
exporting this is the current date.

The value of the balance, in hours. When
importing the balanc e will be set to this
value as of the specified D  ate. This field is
ignored when im  porting if Change is
specified. When exporting this is the

current balance.

The num ber of hours to add or deduct from

the balanc e for the specified D ate. This field
overrides any value in the Value field when
importing. This field is only applicable when
importing.

A com ment about this change. This field is
only applic able when im porting.
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Importing Expense Entry Data

You have the option toim  port em ployee com pany or personal credit card expense entry

data into the system . The first step is to prepare a data file that m atches the following
specific ation in a .csv form  at. Whenim porting expense entry data rows, you want to sort

each em ployee 's expense data by em ployee nam e, then date. D uring the im port, the system
will dynam ically create a new Expense Sheet ID for the em ployee 's expense entries being
imported.

Note: When importing , the header field nam e must m atch the value below exactly in
order to be recognized.

Note: When exporting , you ¢ an com bine fields using ¢ ustom export field expressions.
See the Expression Fields topic for m ore inform ation.

Field Description Format
Date The date this expense was incurred. Date
ID The expense entry ID . This field is not Text (80 chars m  ax)

required, but if present and the value is not

blank then it m ust be unique for all expense
entries, regardless of the expense type. N ote
that the system  will autom atically generate
this value when adding new entries if a value

is not provided. If a value is present when
importing then any existing entry with a

matc hing ID will be updated, rather than a

new entry being added.

Description A description for this expense entry. Text (255 chars m  ax)

Expense The expense (nam e or ID ) type used for this Text
entry. If specified then the expense's class
and units will be assum  ed for this entry.

Type The expense type (nam e or ID ) for this Text
entry. The expense type of the expense will
be used if this is not specified. If no expense
specified then this is required when adding a

new expense entry and there are m ore than
one expense types defined.
Class The expense class (nam e or ID ) for this Text

entry. This is optional and will be set to the
value for the Expense if not specified.

Units The unit of m easurem ent (nam e orID ) for Text
this entry. This is optional and will be set to
the value for the Expense if not specified.

Quantity The num ber or quantity of units used for this Num ber
entry.
Unit Am ount The cost per unit of m  easure for this Num ber

expense entry. The cost is the am ount you
paid for this expense. This is optional and

will be set to the value for the Expense if not
specified.

p239



© 2000-2021, Pacific Timesheet

Amount

Unit Bill Am ount

Bill Am ount

Employee

Reporting G roup

Custom er
Project G roup
Project

Task G roup
Task

Notes
Sheet.ID

Sheet.Start D ate

Sheet.End D ate
Sheet.Description
Sheet.Notes

The total cost for this expense entry. This is
optional and if not specified will be com
as Quantity x Unit Cost.

The price per unitof m  easure for this
expense. The price isthe am  ount you charge
for this expense. This is optional and will be

set to the value for the Expense if not

specified.

puted

The total price for this expense entry. This is
optional and if not specified will be com
as Quantity x Unit Price.

The em ployee (ham e or ID ) this expense
entry is to be associated with. If not
specified then this will default to the
employee doing the im  port when creating
new entries.

puted

The reporting group (nam e or ID ) this
expense entry is to be associated with. If not
specified then this will default to the

reporting group of the em ployee doing the
import when ¢ reating new entries.

The custom er (nam e or ID ) this expense
entry is to be associated with.

The projec tgroup (nam e or ID ) this expense
entry is to be associated with.

The projec t (nam e or ID ) this expense entry
is to be associated with.

The task group (ham e or ID ) this expense
entry is to be associated with.

The task (nam e or ID ) this expense entry is
to be associated with.

Notes about this expense entry.

The ID of the expense sheet. If present

when im porting then it will be used to locate
an existing sheet and attach this entry to it.

If not found, and the system is generating
the ID, then an error will be generated.

The start date of the expense sheet. If
present when im porting, and there is no
Sheet.ID value, then it will be used to locate
an existing sheet and attach this entry to it.
If not found then a new sheet will be
created.

The ending date of the expense sheet.
The sheet description.
Any extra notes entered for the sheet.
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Num ber

Num ber
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Text

Text
Text
Text
Text
Text

Text (2000 chars m  ax)
Text (80 chars m  ax)

Date

Date
Text (255 chars m  ax)
Text (2000 chars m  ax)
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Group Fields

Field Description

Name Group nam e. If this field is present in the CSV data then a value
is required, and is always required when adding new groups.

ID Group ID. This field is not required, but if present and the value is
not blank then it m  ust be unique for all groups.

Descri | A description of this group.
ption
Status ' Group status. Possible value are:
Value Description
Active Employee can log into system

Inactive Employee cannot log into system , and does not show
up on reports, etc. by default.

Type  The type of group this is, where P = perm ission group, R =
reporting group and C = crew. Ifagroupism  ore than one type
then each type will be separated by a carriage return (also called
a "hard" carriage return in Excel, entered using ALT+ ENTER).
When im porting into  Pacific Tim esheet you can separate values
with a "hard" carriage return, or you can use the sem i-colon

character ';'. Note that reporting group and crew can be renam ed

on the System > General > Term inology page, but the values in
the CSV file, P, R and C, do not change.

Emplo The list of em ployees that are m  embers of this group. Multiple
yees employees have eac h value separated by a carriage return (also
called a "hard" ¢ arriage return in Excel, entered using
ALT+ ENTER). The nam es can be in the form  of alogin nam e,
employee ID, or fullnam e (either "first last" or "last, first" is

accepted).
Permis| The list of em ployees and groups given special perm ission on this
sions  objec t. Multiple perm issions have each value separated by a

carriage return (also called a "hard" ¢ arriage return in Excel,

entered using ALT+ ENTER). Each value is of the form
Object Nam e=Permission Level (Object Type)
Where Object Nam e is the nam e of the group or the login of the

employee, Perm ission Level is the perm  ission level to give the
em ployee or group on this object, and Object Type is the whether

this is an Em ployee or Group that is being given perm ission. Here

is an exam ple of a group and an em  ployee assigned to an object:

GroupA= Tim ekeeper (Group)
jmeyers= Manager (Em ployee)

Note that the perm ission level and object type are optional. If the
perm ission level is not specified then it will be set to the

employee's default perm  ission level. If the object type is not
specified the system  will first check for a group with a m atching
nam e, then look for an em  ployee with a m atching login nam e.

Only if you have group nam es and em ployee logins that m  ight be

the sam e do you need to specify the object type.

Format

Text (80 chars
max)

Text (80 chars
max)

Text (255 chars
max)

Text

Text

Text

Text
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Notes | Notes about this group. Text (2000
chars m ax)
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Pay Rates Fields

Field
Object

Object ID

Subobject

Subobject ID

Pay Rate

Description

The nam e of prim ary object that rates
depend on, forexam ple "Em ployee". This is
optional if the Objec  t ID field is supplied.

The ID of the prim  ary object the rates
depend on, for exam ple "222-99-5555"
This is optional if the Object field is
supplied.

The nam e of exceptioin object that rates
depend on, for exam ple "Group". This is
optional if the Subobject ID field is
supplied. The subobject or subobject ID is
optional if you are setting the default rate

for the object.

The ID of the exception object the rates
depend on, for exam ple " Accounting
Group". This is optional if the Subobject
field is supplied. The subobject or subobject
ID is optional if you are setting the default
rate for the object.

The rate for this object/subobject. The rate
can be either a num eric value, or the nam
of a rate as defined in the System > Pay
Rate Options page.

e

Format
Text (80 chars m

Text (80 chars m

Text (80 chars m

Text (80 chars m

Num ber/Text

ax)
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Project Fields

Field Description

Name Project nam e. If this field is present in the CSV data then a value
is required, and is always required when adding new projects.

ID Project ID . This field is not required, but if present and the value
is not blank then it m  ust be unique for all projects.

Descript | A description of this project.

ion

Status | Project status. Possible value are:
Value Description
Active Employee can log into system
Inactive Employee cannot log into system , and does not show

up on reports, etc. by default.

Planned ' Planned project start date.

Start

Date

Planned Planned project finish or end date.

Finished

Date

Planned Planned num ber of hours to com  plete this project.

Work

Actual  Actual project start date.

Start

Date

Actual  Actual project finish or end date.

Finished

Date

Permissi The list of em ployees and groups given special perm ission on this

ons objec t. Multiple perm issions have each value separated by a

carriage return (also called a "hard" ¢ arriage return in Excel,
entered using ALT+ ENTER). Each value is of the form

Object Nam e=Permission Level (Object Type)

Where Object Nam e is the nam e of the group or the login of the
employee, Perm ission Level is the perm ission level to give the
employee or group on this object, and Object Type is the whether

this is an Em ployee or Group that is being given perm
is an exam ple of a group and anem  ployee assigned to an object:

GroupA= Tim ekeeper (Group)
jmeyers= Manager (Em ployee)

Note that the perm ission level and object type are optional. If the
perm ission level is not specified then it will be set to the

employee's default perm ission level. If the object type is not
specified the system  will first check for a group with a m atching
nam e, then look for an em  ployee with a m atching login nam e.
Only if you have group nam  es and em ployee logins that m
the sam e do you need to specify the object type.

ission. Here

ight be

Format

Text (80 chars
max)

Text (80 chars
max)

Text (255
chars m ax)

Text

Date

Date

Num ber

Date

Date

Text
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Notes Notes about this project. Text (2000
chars m ax)
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Project Dashboard Fields

You can im port and export the configuration of your project dashboards very easily using
the CSV form at specified here.

Note: When im porting you can specify whether to add/update records to a project

dashboard, or to set the list of records to m atch exactly what is in the im port file. To do
this you use anim port file directive  of the form

#project-dashboard:update

or

#project-dashboard:set

The directive m ust be the first line of the im port file and m ust be the only text on that
line. The im port file header should im  mediately follow it.

When im porting new dashboard item s the Actual Work field will be updated for each new

item . This can be tim e consum ing for large system s soyoum ay want to wait to do your
project dashboard im  ports during off-peak tim es if you have large im  port files (m ore than
100 records).

The following fields ¢ an be exported/im ported:

Field Description Format

Position The position or row num  ber of the Integer (from 1)
dashboard item , from 1. This is optional
for im porting - if you om it this colum n
then the position of each item will be
autom atically com puted based on the
order of the rec ordsinthe im port file.

Project The nam e of the project for this Text (80 charsm  ax)
dashboard item . Whenim porting
dashboard rec ords either this or the
Project.ID value is required.

Project.ID The ID of the project for this dashboard Text (80 chars m  ax)
item . When im porting dashboard records
either this or the Project (ham e) value is
required.

Task G roup The nam e of the task group for this Text (80 chars m  ax)
dashboard item . Either this or the Task
Group.ID ¢ an be specified. B oth Task
Group and Task are optional, but both
WBS levels cannot be blank (a
dashboard item cannot have a blank task
group and task).

Task G roup.ID The ID of the task group for this Text (80 chars m  ax)
dashboard item . Either this or the Task
Group (nam e) can be specified. B oth
Task G roup and Task are optional, but
both WBS levels cannot be blank (a
dashboard item cannot have a blank task
group and task).
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Task

Task.ID

Status

Planned Start
Date

Planned Finished
Date

Planned Work

Actual Start D ate

Actual Finished
Date

Actual Work

Percent
Complete

Notes

The nam e of the task for this dashboard
item . Either this or the Task.ID can be
specified. Both Task G roup and Task are
optional, but both WBS levels cannot be
blank (a dashboard item cannot have a
blank task group and task).

The ID of the task for this dashboard

item . Either this or the Task (nam e) can
be specified. B oth Task G roup and Task
are optional, but both WB S levels cannot
be blank (a dashboard item cannot have
a blank task group and task).

The status or progress of this dashboard
item , e.g. "Started", or "On Hold" . The
values for this can be configured by

editing any project dashboard and

clicking the "Options" link on that page.

Planned dashboard item  start date.

Planned dashboard item finish or end
date.

Planned num ber of hours/days to

com plete this dashboard item . You can
specify whether the units are hours or

days from the Projects > Project Options

page.
Actual dashboard item  start date.
Actual dashboard item  finish or end date.

The ac tual num ber of hours/days

recorded against this dashboard item

This value is exported, but ignored on

import as the system  autom atically
updates this value nightly (or when you
choose 'Refresh’ from  the tools m enuon
a project dashboard). You can specify
whether the units are hours or days from

the Projects >  Project Options page.

Note that when im  porting a new
dashboard item this value will be
updated im mediately.

If Planned Work is non-blank and

non-zero then this value is com puted as
100 * (Actual Work) / (Planned Work).

This value is exported, but ignored on
import as the system  autom atically

com putes this value.

Notes about this dashboard item
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Project Group Fields

Field
Name

ID
Descri

ption
Status

Permis
sions

Notes

Description Format

Project Group nam e. If this field is present in the CSV data then a Text (80 chars
value is required, and is always required when adding new project max)
groups.

Project Group ID. This field is not required, but if present and the Text (80 chars
value is not blank then it m ust be unique for all project groups. max)

A description of this project group. Text (255 chars
max)

Project Group status. Possible value are: Text
Value Description
Active Employee can log into system

Inactive Employee cannot log into system , and does not show
up on reports, etc. by default.

The list of em ployees and groups given special perm ission on this | Text
objec t. Multiple perm  issions have each value separated by a

carriage return (also called a "hard" ¢ arriage return in Excel,

entered using ALT+ ENTER). Each value is of the form

Object Nam e=Permission Level (Object Type)

Where Object Nam e is the nam e of the group or the login of the
employee, Perm ission Level is the perm ission level to give the

em ployee or group on this object, and Object Type is the whether

this is an Em ployee or Group that is being given perm ission. Here
is an exam ple of a group and an em  ployee assigned to an object:

GroupA= Tim ekeeper (Group)
jmeyers= Manager (Em ployee)

Note that the perm ission level and object type are optional. If the

perm ission level is not specified then it will be set to the

employee's default perm  ission level. If the object type is not

specified the system  will first check for a group with a m atching
nam e, then look for an em  ployee with a m atching login nam e.
Only if you have group nam es and em ployee logins that m  ight be
the sam e do you need to specify the object type.

Notes about this project group. Text (2000
chars m ax)
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Task Fields
Field Description Format
Name  Task nam e. If this field is present in the CSV data then a value is Text (80 chars
required, and is always required when adding new tasks. max)
ID Task ID. This field is not required, but if present and the value is Text (80 chars
not blank then it m  ust be unique for all tasks. max)
Descript | A description of this task. Text (255
ion chars m ax)
Status | Task status. Possible value are: Text
Value Description
Active Employee can log into system
Inactive Employee cannot log into system , and does not show
up on reports, etc. by default.
Planned Planned project start date. Date
Start
Date
Planned ' Planned project finish or end date. Date
Finished
Date
Planned Planned num ber of hours to com plete this project. Num ber
Estim at
ed
Work
Actual  Actual project start date. Date
Start
Date
Actual  Actual project finish or end date. Date
Finished
Date
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Permiss The list of em ployees and groups given special perm ission on this

ions

Notes

objec t. Multiple perm issions have each value separated by a
carriage return (also called a "hard" ¢ arriage return in Excel,
entered using ALT+ ENTER). Each value is of the form

Object Nam e=Permission Level (Object Type)

Where Object Nam e is the nam e of the group or the login of the
employee, Perm ission Level is the perm ission level to give the
employee or group on this object, and Object Type is the whether

this is an Em ployee or Group that is being given perm ission. Here
is an exam ple of a group and anem  ployee assigned to an object:

GroupA= Tim ekeeper (Group)
jmeyers= Manager (Em ployee)

Note that the perm ission level and object type are optional. If the
perm ission level is not specified then it will be set to the

employee's default perm ission level. If the object type is not

specified the system  will first check for a group with a m atching
nam e, then look for an em  ployee with a m atching login nam e.
Only if you have group nam  es and em ployee logins that m  ight be
the sam e do you need to specify the object type.

Notes about this task.

Text

Text (2000
chars m ax)
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Task Group Fields

Field Description

Name Task G roup nam e. If this field is present in the CSV data then a
value is required, and is always required when adding new task
groups.

ID Task G roup ID . This field is not required, but if present and the
value is not blank then it m ust be unique for all task groups.

Descri | A description of this task group.

ption
Status Task G roup status. Possible value are:
Value Description
Active Employee can log into system
Inactive Employee cannot log into system , and does not show
up on reports, etc. by default.
Permis| The list of em ployees and groups given special perm ission on this
sions objec t. Multiple perm issions have each value separated by a
carriage return (also called a "hard" ¢ arriage return in Excel,

entered using ALT+ ENTER). Each value is of the form
Object Nam e=Permission Level (Object Type)

Where Object Nam e is the nam e of the group or the login of the
employee, Perm ission Level is the perm ission level to give the

em ployee or group on this object, and Object Type is the whether

this is an Em ployee or Group that is being given perm ission. Here
is an exam ple of a group and an em  ployee assigned to an object:

GroupA= Tim ekeeper (Group)
jmeyers= Manager (Em ployee)

Note that the perm ission level and object type are optional. If the

perm ission level is not specified then it will be set to the

employee's default perm  ission level. If the object type is not

specified the system  will first check for a group with a m atching
nam e, then look for an em  ployee with a m atching login nam e.
Only if you have group nam es and em ployee logins that m  ight be
the sam e do you need to specify the object type.

Notes Notes about this task group.

Format

Text (80 chars
max)

Text (80 chars
max)

Text (255 chars
max)

Text

Text

Text (2000
chars m ax)

p252




© 2000-2021, Pacific Timesheet

Timesheet Fields

Tim esheet data can be both exported and im ported. The following fields are supported:

Note: When importing
order to be recognized.

, the header field nam e must m atch the value below exactly in

Note: When exporting , you ¢ an com bine fields using ¢ ustom export field expressions.

See the Expression Fields topic for m ore inform ation.

Field Description Format
Employee Employee login nam e. This field or Text
Employee.ID is required when im porting.
Employee.ID |Employee ID. This field or Em  ployee is Text
required when im  porting.
Employee.Ty |The type of em ployee, forexam ple Text
pe Non-exem pt or Exem pt.
Start Time entry start date and tim e. This field or ' Date-Tim e
Date is required.
Note that if the record is for a punch-out
you should specify the special character *'
(without the quotes). This will close any
current punch-in (or do nothing if not
punched in). A punch-out record will not
update any other entry properites, such as
Project, etc. - any values in the punch-out
record will be ignored.
Date Time entry start date. You would use this Date
field instead of Start if you do not care
about the tim e of day of the tim e entry.
This field or Start is required.
Finish Time entry finish date and tim e. This field Date-Tim e
or Hours is required if adding a new tim e
entry.
Note that if the record is for a punch-in you
should specify the special character "*'
(without the quotes). This will close any
previous punch-in, and start a new
punch-in.
Hours Tim e entry hours. This or Finish is required Num ber
if adding a new tim e entry.
Type Time entry type, either Work or Leave. Text
Work Work hours. Num ber
Leave Leave hours. Num ber
Pay Code Pay code nam eoriID . Text
Pay Code.ID Pay code ID . Text
Reporting Reporting group nam  e. Text
Group
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Reporting
Group.ID

Custom er
Custom er.ID

Project
Group

Project
Group.ID

Project
Project.ID
Task G roup

Task
Group.ID

Task
Task.ID

Bill Rate

Bill Am ount

Pay Rate
Pay Am ount

Notes

Regular
Time

Over Tim e
Double Tim e
Flex Tim e
Subm itted

Subm it D ate

Subm itted
By
Approved

Approval
Date

Approved B y

Rejected

Reject D ate
Rejected By

Reporting group ID.

Custom er nam e.
Custom er ID.
Project group nam e.

Project group ID

Project nam e.
Project ID .

Task group nam e.
Task group ID

Task nam e.
Task ID .
Bill rate for this tim e entry.

Bill am ount for this tim
Rate x Hours.

e entry, which is Bill

Pay rate for thistim e entry.

Pay am ount for this tim
Pay Rate x Hours.

e entry, which is

Time entry notes.
Regular tim e hours.

Over tim e hours.
Double tim e hours.
Flex-tim e hours.

Indicates whether this tim e entry has been
subm itted (locked). Possible values are Yes
or No.

The date this tim
Who subm itted this tim e entry.

e entry was subm itted.

Indicates whether this tim e entry has been
approved. Possible values are Yes or N 0.

The date this tim e entry was approved.

Who approved this tim e entry.

Indicates whether this tim e entry has been
rejec ted by an approver. Possible values
are Yes or No.

The date this tim e entry was rejected.
Who rejec ted thistim e entry.

Text

Text
Text
Text

Text

Text
Text
Text
Text

Text
Text
Num ber
Num ber

Num ber
Num ber

Text (2000 chars m  ax)
Num ber

Num ber
Num ber
Num ber
Text

Date
Text
Text
Date
Approver

Text

Date
Text

Importing Timesheets

Im porting tim esheets is som ething we usually like to help custom
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careful planning, including bac king up the database beforehand so you can revert it if for

som e reason the data is wrong. Typically, to get started, you would export a representative

set of tim esheets and save it as a CSV file (from the Tim esheets tab), then trim out the
unneeded ¢ olum ns. This can then be used as a tem plate. Here are som e im portant things to
know about the im  port data form  at:

1. You can use either the nam e of objects (e.g. the em  ployee login nam e, the group nam e,
etc.), orthe ID  of the object, e.g. the em ployee id or the group id.

2. Atam inimum, you'll want the Em ployee (login nam e), Start and Hours colum  ns. The
Start field needs the tim e of day if thereism  ore than one tim e entry for a single day. This
is because the tim esheet im port will try to update an existing tim e entry, so if you have two
records for the sam e em ployee with the sam e start, the second one will just update the first
one. This avoids the danger of accidentally re-im porting the sam e file twice and getting
duplicate tim e entries.

3. The date, tim e and num ber form ats are in the locale of the person doing the im port. Also,
the Start etc . fields are assum edto beinthetim e zone of the person doing the im port. So if
you are im porting data for people in tim e zones scattered around the globe you m ight have

to m ake som e adjustm ents.

4. For tim e off or leave, you'll want to specify the appropriate pay code nam e or pay code
ID.

5. Tom ark the tim esheet as locked or subm itted, add the Subm itted field or colum n, and
specify Yes for each tim  esheet entry.
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Data Archival

Tim e entries, asset entries and other data that are entered in large am ounts will generally
be kept by Pacific Tim esheet for up to 7 years before being m oved into archival storage. For
perform anc e reasons, however, large system s that have over severalm illion entriesm ay

archive data sooner, such as after 6 or 5 years. G enerally this will be transparent to you,
but you m ay see a m essage when running reports for date ranges several years back, such
as:

Data prior to 1/1/2009 has been archived...

In these cases you can still report on archived data by clicking the provided link to the
"Archive Settings" dialog and tem porarily altering the report to target the archived data
table. This allows you to run all of your reports on older archived data for auditing purposes,
etc.

Note that archived data older than 7 years m ay be purged (deleted) from the system

order to prevent using up your allotted disk storage. You can contact your account
representative about extending this if you need to preserve archive data beyond 7 years.
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Administrative T opics
Q: How do | allow managers to edit their worker's timesheets?

A: By defaultam anager cannot edit other em ployee tim esheets, even if they are an
approver for them . To allowam anager to edit otherem  ployee tim esheets do the following:

1. Make sure the m anager, let's call her "Sarah Manager" , has either the Manager
perm ission level, or a perm ission level that allows tim  esheet editing. You can check an
employee's perm ission level from the Em ployees tab. You can check whether a
perm ission level has the tim  esheet editing perm ission from the System > Security
page.

2. Gotothe Em ployees > Groups page and create a new group.

3. Assign all of the em ployees whose tim  esheets Sarah Manager needs to edit to this
group.

4. Edit the perm issions for this group and add Sarah Manager to the list as a Manager (or
any other appropriate perm ission level that allows tim  esheet editing).

When Sarah Manager logs into the application she should see a Tim esheets tab, and should
be able to list and edit tim esheets for all the em  ployees in the new group.
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X Locale Codes
X Time Zone Codes
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ISO locale (language_country) codes:

Value Description

sq_AL Albanian (Albania)

ar DZ Arabic (Algeria)

ar BH Arabic (Bahrain)

ar EG Arabic (Egypt)

ar_1Q Arabic (Iraq)

ar JO Arabic (Jordan)

ar KW Arabic (Kuwait)

ar LB Arabic (Lebanon)

ar LY Arabic (Libya)

ar MA Arabic (Morocco)

ar OM Arabic (Om an)

ar QA Arabic (Qatar)

ar SA Arabic (Saudi Arabia)
ar SD Arabic (Sudan)

ar SY Arabic (Syria)

ar TN Arabic (Tunisia)

ar AE Arabic (United Arab Em irates)
ar YE Arabic (Yem en)

be BY Belarusian (Belarus)
bg_BG Bulgarian (Bulgaria)
ca ES Catalan (Spain)

zh CN Chinese (China)

zh HK Chinese (Hong Kong)
zh TW Chinese (Taiwan)

hr HR Croatian (Croatia)

cs CZ Czech (Czech Republic)
da DK Danish (Denm ark)
nl_BE Dutch (Belgium )
nl_NL Dutch (Netherlands)
en_AU English (Australia)

en CA English (Canada)

en_ IN English (India)

en_IE English (Ireland)

en _NZ English (New Zealand)
en ZA English (South Africa)
en_GB English (United Kingdom )
en_US English (United States)
et EE Estonian (Estonia)

fi_ FI Finnish (Finland)

fr_ BE French (Belgium )

fr CA French (Canada)

fr FR French (France)

fr LU French (Luxem bourg)
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fr CH French (Switzerland)
de AT Germ an (Austria)

de DE German (Germ any)
de LU Germ an (Luxembourg)
de CH Germ an (Switzerland)
el GR Greek (Greece)

iw_IL Hebrew (Israel)

hi IN Hindi (India)

hu HU Hungarian (Hungary)
is_IS Ic elandic (Iceland)

it IT Italian (Italy)

it CH Italian (Switzerland)

ja JP Japanese (Japan)

ko KR Korean (South Korea)
v LV Latvian (Latvia)

It LT Lithuanian (Lithuania)
mk_MK Macedonian (Macedonia)
no NO Norwegian (Norway)
pl_PL Polish (Poland)

pt BR Portuguese (Brazil)

pt PT Portuguese (Portugal)
ro RO Romanian (Rom ania)
ru RU Russian (Russia)

sk _SK Slovak (Slovakia)

sl _SlI Slovenian (Slovenia)
es AR Spanish (Argentina)
es BO Spanish (Bolivia)

es CL Spanish (Chile)

es CO Spanish (Colom bia)
es CR Spanish (Costa R ica)
es DO Spanish (Dom inican Republic )
es EC Spanish (Ecuador)

es SV Spanish (El Salvador)
es GT Spanish (Guatem ala)
es HN Spanish (Honduras)
es MX Spanish (Mexico)

es NI Spanish (Nicaragua)
es PA Spanish (Panam a)
es PY Spanish (Paraguay)
es PE Spanish (Peru)

es PR Spanish (Puerto Rico)
es ES Spanish (Spain)

es UY Spanish (Uruguay)

es VE Spanish (Venezuela)
sv_SE Swedish (Sweden)

th TH Thai (Thailand)
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th TH Thai (Thailand, TH )
tr TR Turkish (Turkey)

uk_UA Ukrainian (Ukraine)
vi_VN Vietnam ese (Vietham )
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Standard (Olson ID ) tim e zones codes:

Value

MIT

Pacific/Apia

Pacific /Honolulu
America/Anchorage
America/Los_Angeles
America/Denver
America/Phoenix
America/Chicago
America/Costa_R ica
America/Mexico_City
America/Tegucigalpa
America/Winnipeg
America/Bogota
America/lndianapolis
America/Montreal
America/New_York
America/Caracas
America/Santiago
America/Thule
America/St_Johns
America/Buenos_Aires
America/Sao_Paulo
Atlantic/South_ G eorgia
Atlantic/Azores
Atlantic/Cape_Verde
Africa/Casablanca
Europe/Dublin
Africa/Lagos
Europe/Am sterdam
Europe/Belgrade
Europe/Brussels
Europe/Warsaw

Afric a/Cairo

Afric a/Harare
Asia/Jerusalem
Europe/Athens
Europe/Bucharest
Europe/Helsinki

Afric a/Nairobi
Asia/Baghdad
Asia/Kuwait
Europe/Moscow
Asia/Tehran

Description

(GMT-11:00) International D ate Line W.
(GMT-11:00) Midway Island, Sam oa
(GMT-10:00) Hawaii

(GMT-09:00) Alaska

(GMT-08:00) Pacific Tim e
(GMT-07:00) Mountain Tim e
(GMT-07:00) Arizona

(GMT-06:00) Central Tim e
(GMT-06:00) Central Am  erica
(GMT-06:00) Mexico City
(GMT-06:00) La Paz

(GMT-06:00) Saskatchewan
(GMT-05:00) B ogota

(GMT-05:00) Indiana (East)
(GMT-05:00) Atlantic Tim e (Canada)
(GMT-05:00) Eastern Tim e
(GMT-04:00) Caracas, La Paz
(GMT-04:00) Santiago

(GMT-04:00) G reenland
(GMT-03:30) Newfoundland
(GMT-03:00) Buenos Aires
(GMT-03:00) Brasilia

(GMT-02:00) Mid-Atlantic
(GMT-01:00) Azores

(GMT-01:00) Cape Verde Is.

(GMT+ 00:00) Casablanca, Monrovia
(GMT+ 00:00) Greenwich Mean Tim e
(GMT+ 01:00) West Central Africa
(GMT+ 01:00) Am sterdam, Rome
(GMT+ 01:00) Belgrade, Prague
(GMT+ 01:00) Brussels, Madrid
(GMT+ 01:00) Sarajevo, Warsaw
(GMT+ 02:00) Cairo

(GMT+ 02:00) Harare, Pretoria
(GMT+ 02:00) Jerusalem

(GMT+ 02:00) Athens, Istanbul
(GMT+ 02:00) Bucharest

(GMT+ 02:00) Helsinki

(GMT+ 03:00) Nairobi

(GMT+ 03:00) Baghdad

(GMT+ 03:00) Kuwait, Riyadh

(GMT+ 03:00) Moscow, St. Petersburg
(GMT+ 03:30) Tehran
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Asia/Baku

Asia/D ubai
Asia/Kabul
Asia/Karac hi
Asia/Yekaterinburg
Asia/Calcutta
Asia/Katm andu
Asia/Alm aty
Asia/Colom bo
Asia/D haka
Asia/Rangoon
Asia/Bangkok
Asia/Krasnoyarsk
Asia/Hong_Kong
Asia/lrkutsk
Asia/Kuala_Lum pur
Asia/Taipei
Australia/Perth
Asia/Seoul
Asia/Tokyo
Asia/Yakutsk
Australia/Adelaide
Asia/Vladivostok
Australia/Brisbane
Australia/Hobart
Australia/Sydney
Pacific /Guam
Asia/Magadan
Pacific/Auckland
Pacific/Fiji
Pacific/Tongatapu

(GMT+ 04:00) Baku, Thilisi

(GMT+ 04:00) Abu Dhabi

(GMT+ 04:30) Kabul

(GMT+ 05:00) Islam abad, Karachi
(GMT+ 05:00) Ekaterinburg

(GMT+ 05:30) Chennai, Kolkata
(GMT+ 05:45) Kathm andu
(GMT+ 06:00) Alm  aty

(GMT+ 06:00) Sri Jayawardenepura
(GMT+ 06:00) Astana, D haka
(GMT+ 06:30) Rangoon

(GMT+ 07:00) Bangkok, Hanoi
(GMT+ 07:00) Krasnoyarsk

(GMT+ 08:00) Beijing, Hong Kong
(GMT+ 08:00) Irkutsk

(GMT+ 08:00) Kuala Lum  pur, Singapore

(GMT+ 08:00) Taipei

(GMT+ 08:00) Perth

(GMT+ 09:00) Seoul

(GMT+ 09:00) Osaka, Tokyo
(GMT+ 09:00) Yakutsk

(GMT+ 09:30) Adelaide

(GMT+ 10:00) Vladivostok
(GMT+ 10:00) Brisbane

(GMT+ 10:00) Hobart

(GMT+ 10:00) Canberra, Sydney
(GMT+ 10:00) Guam

(GMT+ 11:00) Magadan, Solom  on Is.
(GMT+ 12:00) Auc kland
(GMT+ 12:00) Fiji, Kam chatka
(GMT+ 13:00) Nuku'alofa
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- T -

Time Entry Rules 169

R -

Rate Options 111

- S -

System Lists 158

- A -

Approval Levels 110

P -

Policies 168

-E -

Employee Balances CSV Format 238

-T-

Timesheet CSV Format 253

"B -

Bill Rates CSV Format 232

- T -

Time Clock Devices 144

-0 -

9/80 Over Time Rules 184

- A -

Advanced Topics 98
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W -

Wage Rules 189

-T-

Time Entry Corrections 28

P -

Project Options 45

W -

Work Shifts 109
Work Shift Rules 188

- S -

Setup Quick Start 8

-T -

Time Zone Codes 262
Timesheet Export Options 116

Introduction 5

- A -

Auto-Import Directory 136

_Q_

QuickBooks Desktop Export Options 128

-D -

Data Integration 115

- H -

Holidays 108
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- F -

Flex Time Rules 176

-0 -

Over Time Rules 182

- S -

Schedule Rules 175

- A -

Approving Crew Time 35

Employee Balances 80

Importing/Exporting 225

P -

Permission Lists 203
Permission Levels 199

-E -

Employee Groups 81

- C -

Custom Fields 220

-E -

Employee CSV Format 234
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- T -

Tasks 49

- M -

My Account 13

P -

Projects 43

- S -

Schema 218

"B -

Branding 114

- M -

Managing Employees 71

R -

Reports 84

“A -

Announcements 16

- S -

Security 197

L -

License 157

- C -

Change Password 12
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W -

Work Breakdown Structure 104

- A -

Approving Timesheets 30

- N -

Notices 214

- M -

My Timesheet 17
Managing Timesheets 26

- T -

Templates 161

P -

Pay Codes 159

- T -

Terminology 113

- M -

Managing Tasks 40

P -

Preferences 14

-E -

Export Options 133

P -

Project Group CSV Format 249
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- T -

Task Group CSV Format 252

P -

Project CSV Format 245

-T-

Task CSV Format 250

-G -

Group CSV Format 242

- T -

Task Groups 48

Project Groups 42
Time Periods 107

-E -

enable currency 151
Expense Entry CSV Format 239
Expression Field 121

- F -

Field 121

Export 150, 121

Expression 121
EOL 151

- C -
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currencies 151

P -

Project 46
picker width 151

- T -

Task 46

R -

Rerun accruals 154

-B -

Bulk update 154

- M -

Mass update 154

- S -

System Tools 154

- C -

Configuring Expense Fields 66

- M -

Multi-Currency 69

P -

Pay Rates CSV Format 244
picker fields 151

- T -

timeclock 144

- C -
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Cloud Drive 150

- M -

Microsoft OneDrive 150

-0 -

OneDrive 150

-D -

Dropbox 150
Data Connections 150

_Q_

QuickBooks Online Export Options 125

biometric 144

P -

Project Dashboard CSV Format 247
punch clock 144

- M -

My Expense Sheets 19

- S -

scan 141

- C -

codereader 141
codereadr 141

"B -

barcode 141
Barcode Scanner Support 141
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- A -

Actual 46

P -

Planned 46

- A -

access control 144
Asset Entries 52

- M -

Managing Expense Sheets 64

- A -

Approvals 29

- M -

My Assets 23

- A -

Absence Points Rules 192
Asset Entry CSV Format 230
Asset Class CSV Format 229
Asset CSV Format 227

P -

Project Dashboard 46

- A -

Asset Classes 60

-D -

Data Archival 256

- A -
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Assets 57
Asset Entry Fields 55
Asset Types 61

- U -

Units of Measure 63

- A -

Asset Tracking 163

- C -

Crew Timesheet 24

- L -

Leave Request Options 39

- S -

System Options 151

- A -

Advanced Settings 164

-E -

Employee Attendance Report 90

P -

Profit Report 96

R -

Report Properties 87

- A -

Attendance Widget 164

P -
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Presence Absence Time Entry 164
Percent Time Entry 164

-E -

Employee Options 83

A -

Approving Project Time 32

- M -

Managing Assets 51

Import 150

- F -

FTE Summary Report 93

- H -

Hours Summary Report (Columnar) 91

P -

Ping Identity Authentication 212

-0 -

Onelogin Authentication 210
Okta Authentication 208

- S -

SAML 2.0 Authentication 206

- L -

LDAP/Active Directory Authentication 204

- S -
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Submit and Review Messages 167
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